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1. MX-E Description 

The Zultys MX-E system is a high performance enterprise grade unified 

communications server that addresses the requirements of medium to large 

enterprise customers. The MX-E system features: 

• Three(3) hot swappable hard disk drives 

• Dual redundant hot swappable power supplies 

• RAID 1 hard disk drive configuration 

• Three(3) cooling fans 

• Three(3) interface slots for expansion modules 

• Two(2) – 10/1000 Ethernet interfaces 

• Two(2) – USB interfaces 

• One(1) – Auxiliary (console) interface 

• 2x16 Liquid Crystal Display(LCD) with four(4) control buttons 

The Zultys MX-E is offered in three(3) configurations from the factory: 

1) MX-E 

This system is capable of supporting up to 300 users and up to 300 SIP trunks 

at G.711. 

2) MX-E+ 

This system is capable of supporting up to 1000 users and up to 1000 SIP 

trunks at G.711. 

3) MX-E ++ 

This system is capable of supporting up to 2000 users and up to 2000 SIP 

trunks at G.711. 
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1.1 MX-E System Capacities 
 

 
MX-E MX-E+ MX-E++ 

Users (subscribers) 300 1000 2000 

Simultaneous sessions 300 1000 2000 

Simultaneous registrations 1200 4000 4000 

Paging groups 100 256 300 

Operator groups 100 256 400 

ACD or hunt groups 100 256 400 

Automated attendants 100 150 200 

Simultaneous accesses to AA or VM 100 256 400 

Voice mail storage (hours) 1000 1000 1000 

Call recording storage (hours) 150 300 600 

Maximum SIP trunks 300 1000 2000 

E1/T1/PRI module 3 3 3 

Octal FXO module (4/8 ports) 3 3 3 

Octal FXS module (4/8 ports) 3 3 3 

Call Recording Sessions 300 1000 2000 

Conference Participants 100 256 256 

Conference Rooms 33 85 85 

G.729 sessions 300 1000 2000 
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Basic MXIE 300 1000 2000 

Advanced MXIE 300 1000 2000 

Fax termination 64 64 100 

Max number of simultaneous calls per 

all Outbound campaigns 

100 256 256 

MSEC Users 300 1000 2000 

Max number of logged in Zultys Mobile 

Communicator users 

300 1000 2000 

CSTA client licenses 300 1000 2000 

Desktop Integration 300 1000 2000 

CRM User access 300 1000 2000 

1.2 Power specifications/Dimensions 

AC Input voltage, universal 100-240 VAC 

Frequency 47-63 Hz 

AC Input current (max) 4.5 A 

Power (max) 180 watts 

Typical Power (idle) 90 watts 

Width 17.3” 

Depth 18.1” 

Height 3.46” 

Weight 35 pounds 
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2. MX-E Hardware 

1.3 Front Panel of the MX-E 

 

ENTER

P1 P2 P3

H1

H2

H3

H4

USB
1
2

21 AUX LCD

ESC

Power

Stat

1 2&3 4 5-6-7-891011 12 13  

1 – Hard Disk Drives(H1/H2/H3) – Main, RAID-1, and a spare hard disk drive 

are provided. The Hard disk drive provides storage for voice mail, auto 

attendants, and system  software. The MX-E is not operational 

without a hard disk drive. Hard disk drives are hot swappable! 

Note: H4 is a solid state system drive that is not intended to be removed 

and is locked from the factory. The MX-E system utilizes this hard disk 

drive for system file operations. Do not remove this drive from service 

unless instructed by technical support! 

Note: In the event that both the main and RAID drives become 

inoperable, you must contact Technical Support for an RMA on the hard 

disk drives. Installing a hard disk drive from another MX-E system will 

NOT bring the system to full functional status. 

2 – Power LED 

3 – Status(Stat) LED 
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4 – LCD Display 

5-6-7-8 – LCD control keys – See section 1.5 for a description of the 

LCD control keys and how they interact with the LCD. 

9 – Auxiliary Connector(AUX) – Serial Port connection (special cable 

included) 

10 – USB Connectors(USB) – Can be used to connect to APC UPS devices. 

APC devices with PowerChute software will signal a low battery condition 

to the MX-E. 

11 – Ethernet LAN port(1) – A 10/1000 Base-T Ethernet circuit which 

also serves as the console port. 

12 – Ethernet WAN port(2) – A 10/1000 Base-T circuit. 

13 – Interface slots(P1/P2/P3) – Three slots for installing optional 

interface modules. Available modules  include: 

– FXO: 4 or 8 circuit analog exchange-side circuits. 

– FXS: 4 or 8 circuit analog subscriber-side circuits. 

– PCM: one o r  two  c i r cu i t  d ig i t a l  T1/E1/PR I  exchange-side 

circuits. 
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1.4 Rear Panel of the MX-E 

The rear panel, shown below, contains the power supplies, power switch, 

alarm silence button, and system information. 

 

 

1

POWER

PS 1

PS 2

23
45  

 

1 – Dual Redundant Hot Swappable Power Supplies (PS 1/PS 2). Has the 

117 Vac input connector, LED status 

NOTE! Both power cables must be plugged into AC power sources. Failure 

to do so will create an audible alarm condition. In the event of a power 

supply failure, the audible alarm will sound until the faulty power supply 

is replaced or the Power Supply Alarm Silence button is pressed. 

2 – Power Supply Alarm Silence button 

3 – Power Button – This powers the system on. It is not 

recommended to power the MX-E system down using the 

switch. Utilize the LCD control or MX Administrator software to 

initiate a graceful shutdown. 
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4 – Serial Number – Identifies the main chassis. Refer to this number to 

identify the system when obtaining service or returning the system 

for repair  or replacement 

5 – MAC Address – Identifies the MAC address of the MX-E unit. 

1.5 Liquid Crystal Display (LCD) 

This chapter describes MX-E LCD functions. The MX-E has a 2 line x 16 

character Liquid Crystal Display (LCD) on the front panel. The LCD is used 

to display various system information at boot time and normal runtime. In 

addition, there are four (4) buttons below the LCD that are used to navigate 

through LCD menus during runtime. Two (2) of these buttons can be used 

to place the system in console mode during boot. 

 LCD during boot process: 

 S Y S T E M  B O O T I N N G 

                

 

 

 L O A D I N G  A P P     

                

 

 L O A D I N G  C O N F I G  

                

 

When the boot process is complete, the system will go to a normal Idle display 

 S Y S T E M  R E A D Y    

 X X X . X X X . X X X . X X X 

Where: XXX indicates the IP address of the system 
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 LCD during normal system operation: 
 

Idle display 

 S Y S T E M  R E A D Y    

 X X X . X X X . X X X . X X X 

Where: XXX indicates the IP address of the system 
 

Pressing the DOWN arrow button will scroll through all the IP addresses in the 

system as well as the serial number, software version, and CS (customer 

support server) connection status: 

 X X X . X X X  . X X X . X X X 

 X X X . X X X  . X X X . X X X 

 

 S E R I A L  X X X X X    

 S W:  X X. X. XXX         

 

 

 C S  S T A T U S       

                

 

Pressing the ENTER button at the system ready prompt will present a menu of 

sub items. Use the DOWN arrow to scroll through the sub-menu of options: 

 

 O N C O N S O L E   M O D E 

 C O N N E C T  T O  C S   

 

 

 

 S Y S T E M  R E S T A R T  

 S Y S T E M  S H U T D O W N 

 

Pressing the ENTER button at the Console Mode On prompt will present a 

confirmation prompt. Press ENTER to place the system into console mode. 
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 C O N F I R M  C O N S O L E 

                

Pressing the ENTER button at the Connect to CS prompt will present a 

confirmation prompt. Press ENTER to place the system into customer service 

mode. 

 C O N F I R M  C S      

                

 

Pressing the ENTER button at the System Restart prompt will present a 

confirmation prompt. Press ENTER to restart the system. 

 C O N F I R M  R E S T A R T 

                

Pressing the ENTER button at the System Shutdown prompt will present a 

confirmation prompt. Press ENTER to shut the system down gracefully. 

C O N F I R M  S H U T D O W N 

                

 

The ESC button will return you to a previous menu or to the home screen 

depending on where you are in menu navigation. 

 

1.6 LED Functions 

 

Power – This LED will light Green when the system is powered on. It 

remains on during normal operation and extinguishes when the system 

is powered down. 

Status - This LED will flash intermittently during normal operation 

indicating various processing activity. 
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Drive – This LED (located on each hard disk drive) will flash 

intermittently indicating hard disk drive (HDD) activity. 

2. MX-E Circuits 

MX-E interface modules ARE NOT interchangeable with MX30 or MX250 

interface modules. MX-E interface modules ARE compatible with MX-SE 

interface modules. 

Note! Certain revisions of MX-SE modules will not function in MX-E systems. 

To determine if an existing MX-SE module is compatible, locate the DSP circuit 

board on the module. There will be a revision code of either “00” or “10” 

00 = Not compatible 

10 = Compatible 
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2.1 10/1000 Base-T 

The MX-E has two 10/1000 Base-T Ethernet circuits labeled 1 and 2. Power 

over Ethernet is not provided on either circuit. These interfaces are in “Routing 

Mode” and cannot be changed to bridging mode. 

• Ethernet LAN Port (1) connects to your local area network and provides 

data connectivity for the enterprise. This port serves as the console 

circuit, as described in Console Mode. Changing the IP address is done in 

Provision\System Settings\IP Addresses 

• Ethernet WAN Port (2) can be used to implement ALG/SBC through a 

second IP address. 

RJ45 ports connect Ethernet circuits to the MX-E and can auto-detect and adapt 

to the CAT5 cable configuration (straight or crossover). Changing the IP address 

is done through View\Interfaces. Select and right click on Ethernet 2, select 

Interface Information, select Configure form the IP Information tab, right click 

on the IP address and select Edit. 

RJ45 Connector Pin Placement 

(10/1000 Ethernet Circuit) 

 

2.2 Analog FXO  

The MX-E supports a four port FXO module or an eight port FXO 

module through the interface slot. REN is 0.4. 

The Ringer Equivalence Number (REN) indicates the maximum number of devices allowed to be 

connected to a telephone interface. The termination of an interface may consist of any 
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combination of devices subject only to the requirement that the sum of the RENs of all the 

devices not exceed five. / L’indice d’équivalence de la sonnerie (IES) sert à indiquer le nombre 

maximal de terminaux qui peuvent être raccordés à une interface téléphonique. La terminaison 

d’une interface peut consister en une combinaison quelconque de dispositifs, à la seule 

condition que la somme d’indices d’équivalence de la sonnerie de tous les dispositifs n’excède 

pas cinq.” 

• The FXO4 module, shown below, provides four analog exchange-

side circuits.  

 

• The FXO8 module, shown below, provides eight analog exchange-

side circuits.  

 

Modules provide two-wire exchange side circuits that connect to central 

office lines through RJ45 connectors and are configured for one  of several  

analog  protocols through the  MX Administrator Interface. 

LED indications are provided that indicate the status of each circuit. 

Circuit State LED Indication 

Idle Extinguished 
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Ringing/In Use Solid green 

 

Below table and image  show  the placement and  function of RJ45 connector 

pins for the F X O 4  and  FXO8  circuit modules. 

 

 

 

 

 

 

 

 

 

 

Note: No analog calibration is 

required on FXO ports of the MX-E 

system! 

 

 

 

 

 

 

 

 

Pin Function 

1 TIP 2 

2 RING 2 

3 TIP 3 

4 RING 1 

5 TIP 1 

6 RING 3 

7 TIP 4 

8 RING 4 
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2.3 Analog FXS 

The MX-E supports either a four port or eight port FXS module 

through the interface slot. 

• Below table and image  show  the placement and  function of RJ45 

connector pins for the F X S 4   circuit module. 

•  

 

 

 

 

 

 

 

 

 

 

 

 

 

Pin Function 

1 TIP 2 

2 RING 2 

3 TIP 3 

4 RING 1 

5 TIP 1 

6 RING 3 

7 TIP 4 

8 RING 4 
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• The FXS8 module, shown below, provides eight analog interface 

circuits. 

 
 

• Below table and image  show  the placement and  function of RJ45 

connector pins for the F X S 8  circuit module. 

•  

•  

•  

•  

•  

•  

•  

•  

•  

•  

•  

 

 

2.4 PCM Module 

The MX-E supports one PCM module per interface slot. The module has one 

or two full duplex circuits that can be configured as either T1(1.544Mps) 

Pin Function 

1 TIP 2 

2 RING 2 

3 TIP 3 

4 RING 1 

5 TIP 1 

6 RING 3 

7 TIP 4 

8 RING 4 
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/E1(2.048Mbps) /PRI (23B+D, 1.544Mbps). The circuit uses one of several 

supported PSTN protocols, i.e. ISDN, CAS, MFCR2. The circuit type and protocol 

are configured in MX-E Administration. 

Pin assignments of the PCM module: 

3. Powering Up the MX-E 

To power up the MX-E, use the power adapter provided with the MX-E to 

connect the DC input to a power source that provides power. Press the 

Power button on the back of the unit. 

 

 

 

 

 

 

MX-E 

MX-E 



 

 MX-E Installation Manual (PN:0000507) Revision 11 February 11, 2019 
© 2019 Zultys, Inc. No reproduction or distribution without permission 

Page 29 of 350 

Technical Publications 

4. Shutting Down the MX-E 

To shut down the MX-E: 

 

1. Initiate a System Shutdown operation using one of the following  

methods: 

− Select Maintenance → Shutdown from the User Interface,  choose 

a shutdown option from the displayed list, then  press the OK 

button. 

− Use the LCD buttons to navigate to the System Shutdown menu 

item: 

Press the ENTER button at the System Ready prompt 

> S Y S T E M  R E A D Y    

                

 

Use the DOWN arrow button to scroll to the System Shutdown prompt: 

> S Y S T E M  S H U T D O W N 

                

 

Press the ENTER button to select system shutdown: 

> C O N F I R M S H U T D O W N 

                

Press the ENTER button to confirm the system shutdown. 

2. Wait until the Powe r  and Status LEDs off. 

3. Remove power from the DC input. 

Power to the MX-E is not removed until the power cord is physically 

unplugged from the chassis. 
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Shutting down the MX-E in this manner terminates Linux and all 

applications properly.  

A Hard Shutdown terminates MX-E functions without gracefully shutting 

down applications or properly terminating Linux.  Removing the DC input 

power or pressing the Power button while   the system  is normally operating 

executes a hard shutdown. 

 

Performing a Hard Shutdown is strongly discouraged. Operations are 

instantly terminated, data will be lost, and the Flash Memory and HDD 

contents may be corrupted. 

5. Console Mode 

Console mode provides access to the MX-E in a predefined state for configuring 

the system IP address or recovering the Administrator password. The MX-E 

defines two console modes: 

• Boot Time Console Mode is entered as you start up the MX-E. You can 

configure the main IP address and recover the Master Administrator 

password from this mode. 

• Run Time Console mode is entered during normal MX-E operation. 

Technical support personnel can monitor system behavior when the 

system is in this mode. 

Ensure that the Ethernet cables are disconnected from the MX-E before 

entering console mode.  

When the MX-E is in console mode, you can connect a computer to the LAN 

Ethernet Port. The IP address that accesses the MX-E depends on the console 

mode of operation. 

5.2 Boot Time Console Mode 

The following procedure places the MX-E into Boot Time Console Mode: 

1. Disconnect the Ethernet ports from your system. 
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Failure to do so may disturb other devices on the LAN. 

2. Ensure power to the MX-E is shut down. 

3. Press and hold the ENTER  bu t ton  unde r  the  LCD  d isp l ay .  

4. While pressing the button, press and release the power button on 

the rear of the unit. 

5. Release the EN TER  bu t ton  when the LCD  d i sp l a ys :  

 C O N S O L E  M O D E ?   

                

 

6. Press the EN TER  b u t ton  to place the system into console mode.  

7. Configure your PC ’s network interface with  an  IP address of 

192.168.1.103 and  a subnet mask of 255.255.255.0. Connect your 

PC directly to the LAN Ethernet Port. 

8. To access the MX-E, open  the MX-E Admin User Interface  at IP address 

192.168.1.100 using one of the following  case sensitive  Login-

Password combinations: 

– Login name:  MX-E user previously configured with administrator 

rights. Password: text string configured as password for the 

user. 

– Login name:  Administrator. Password: zultys 

This option permits access when the Administrator password is unknown and 

users with administrator rights are unavailable. You can change the 

Administrator password in this mode, if you know the current Administrator 

Password. 

5.2.1 To exit console mode and resume normal operations 

To exit the console mode you must properly shut down and power cycle the 

MX-E, by using the reboot command. 

1. Disconnect the PC from the console port. 

2. Reconfigure PC to obtain its TCP/IP address automatically. 

3. Reconnect the PC and the MX-E to the network. 
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5.2.2 Run Time Console Mode 

If you are unable to access your system through MX-E Administrator, you can 

allow Zultys Technical Support to access your system by entering Run Time 

Console Mode. You should enter Run Time Console Mode only as instructed by 

a member of Zultys Technical Support. 

Invoking Console mode during normal operation puts  the MX-E into 

console mode  without changing its IP addresses. 

To put the MX-E into console mode during normal operation: 

Pressing the ENTER button at the System Ready prompt will present a menu of 

sub items. Use the DOWN arrow to scroll through the sub-menu of options until 

Console Mode On is highlighted. Press ENTER: 

 

O N  C O N S O L E  M O D E  

 C O N N E C T  T O  C S   

 

Press the ENTER button at the confirmation prompt to enter console mode 

 C  O N F I R M  C O N S O L E 

                 

To exit console mode, press and hold the D own  a r r o w  button for two 

seconds. The MX-E exits console mode, as indicated by the norma l  i d l e  

LCD . 

6. Preparation  

The MX-E is designed to be permanently installed in a network room or office. 

You must carefully install the MX-E system to ensure its proper operation.  

This equipment is to be installed and maintained by service personnel 

only as defined by AS/NZS 3260 Clause 1.2.14.3 Service Personnel. 

Installation by unqualified individuals may result in bodily injury and 

damage to the MX-E and surrounding equipment. 



 

 MX-E Installation Manual (PN:0000507) Revision 11 February 11, 2019 
© 2019 Zultys, Inc. No reproduction or distribution without permission 

Page 33 of 350 

Technical Publications 

6.2 Installation Safety Notes 

 These are the safety considerations for using the Zultys MX-E hardware. Read 

these notices before installing or using your phone system. 

Important This notice contains special information that should not be ignored. 

Warning This notice indicates that if a specific or practice is not correctly 

followed, permanent damage to the MX-E and personal injury may result.  

Danger This notice warns you of imminent hazard to yourself and others if 

proper procedures are not followed. 

Important Ultimate disposal of this product should be handled according to all 

national laws and regulations.  

Danger Do not work on the system or connect or disconnect cables during 

periods of lightning activity.  

Warning The separate protective earthing terminal provided on this product 

shall be permanently connected to earth.  

Danger Disconnect telecommunication network connectors before removing 

cover. 

Warning To reduce the risk of fire, use only 26 AWG or larger (e.g., 24 AWG) UL 

listed or CSA Certified Telecommunication Line Cord for all telecommunication 

circuits. 

Danger Disconnect DC input connector before servicing.  

Warning This unit is designed to work with telephone power system. 

Safety Instructions - Rack Mount: 

A) Elevated Operating Ambient - If installed in a closed or multi-unit rack 

assembly, the operating ambient temperature of the rack environment may be 

greater than room ambient. Therefore, consideration should be given to 

installing the equipment in an environment compatible with the maximum 

ambient temperature (Tma) specified by the manufacturer. 
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B) Reduced Air Flow - Installation of the equipment in a rack should be such 

that the amount of air flow required for safe operation of the equipment is not 

compromised. 

C) Mechanical Loading - Mounting of the equipment in the rack should be such 

that a hazardous condition is not achieved due to uneven mechanical loading. 

D) Circuit Overloading - Consideration should be given to the connection of the 

equipment to the supply circuit and the effect that overloading of the circuits 

might have on overcurrent protection and supply wiring. Appropriate 

consideration of equipment nameplate ratings should be used when addressing 

this concern. 

E) Reliable Earthing - Reliable earthing of rack-mounted equipment should be 

maintained. Particular attention should be given to supply connections other 

than direct connections to the branch circuit (e.g. use of power strips)." 

Replaceable batteries: 

CAUTION: Risk of Explosion if Battery is replaced by an Incorrect Type. Dispose 

of Used Batteries According to the Instructions. 

Telephone line cord: 

CAUTION: To reduce the risk of fire, use only No. 26 AWG or larger (e.g., 24 

AWG) UL Listed or CSA Certified Telecommunication Line Cord 

Supplementary Earthing Conductor: 

When FXS Card is installed in the MX-E, Supplementary Earthing conductor shall 

be installed prior to connection to AC Mains. 

 

6.3 Selecting a Site 

The following criteria must be considered when selecting a site for your MX-E 

system. 
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The MX-E must be installed in a secure location with access restricted to 

qualified personnel. Placing the MX-E in a location accessible by 

unqualified individuals may result in bodily injury and damage to the 

MX-E and surrounding equipment.  

• Temperature: Install the MX-E where the temperature remains between 

0°C and 40°C. 

Operating the MX-E in temperatures below 0°C or above 40°C voids your 

warranty and may result in bodily injury and damage to the MX-E or 

surrounding equipment. 

• Ventilation: The MX-E requires space on both sides for ample air flow. 

Ensure the MX-E has space on both sides for ventilation. 

 

Do not cover the interface slot and openings on the equipment. These 

are provided for ventilation and protection against overheating. 

• Cable Lengths: Cable placement to associated equipment is an important 

site criterion. MX-E Circuit Cables shows the minimum and maximum 

length of any cables you connect to the MX-E.  

• Other Site Requirements: Select a site where liquids or objects will not fall 

onto the equipment and that foreign objects will not be drawn into the 

ventilation holes. 

6.4 Power Requirements 

The total power input for the MX-E is W. 

Disconnect 2 power supply cords before servicing 

6.5 Electrostatic Discharge (ESD) Precautions 

Almost all electronic components can be damaged by ESD during handling. 

Component damage can occur at ESD voltages as low as 50 V. A person walking 

across a nylon carpet can easily generate voltages in excess of 5,000 V.  

Observe the following guidelines to help prevent ESD damage when installing or 

servicing the MX-E system or any other electronic device.  
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• Assemble or disassemble equipment only in a static-free work area.  

• Use conductive work surfaces, such as an antistatic mat, to dissipate 

static charge.  

• Wear a conductive wrist strap and lab coat to dissipate static charge 

accumulation.  

• Minimize handling of assemblies and components.  

• Keep replacement parts in their original anti-static packaging.  

• Remove plastic, foam, vinyl, paper, and other static-generating materials 

from the work area.  

• Use tools that do not create ESD.  

• Do not handle connector pins or touch onboard components.  

 

You can easily damage the MX-E by failing to follow these instructions. 

You may delay installation or cause equipment to prematurely fail. Such 

failure may lead to a disruption of the service provided by the equipment 

and void your warranty. 

6.6 Serial Number 

Verify the serial numbers of each item and compare them  with the serial 

numbers on the packing lists. The serial number is a five digit 

alphanumeric code printed on a white  barcode label on the rear panel. 

See section 1.2 to locate the serial number on the back of the MX-E. 

7. Mounting the MX-E  

Zultys recommends installing the MX-E in the same secured wiring closet as the 

networking equipment to which it connects. Typical devices connecting to the 

MX-E include the LAN switch and the provisioning computer. 

The MX-E can be rack mounted, placed on a network shelf in the IT rack, or on 

top of a table or desk. Ensure the table or desk is properly mounted to the floor 

or has properly fitted stabilizers so it cannot move and will not tip over. Zultys 

recommends installing the system in the IT rack using the supplied rack 

brackets/screws. 



 

 MX-E Installation Manual (PN:0000507) Revision 11 February 11, 2019 
© 2019 Zultys, Inc. No reproduction or distribution without permission 

Page 37 of 350 

Technical Publications 

NOTE! Leave space at the rear of the system for cables and for 

personnel installing the system. 

8. Connecting to the MX-E 

8.2 Initial System Configuration 

The MX-E IP address is view or configured through the User Interface. To view 

the IP address, select Provision → System Settings, then access the IP Addresses 

panel. If the IP Address (Main) data field is empty, the system uses 

192.168.1.100 as the IP Address. The MX-E uses the same address for the Main 

and RTP IP address. 

Before connecting the MX-E to your network, the Main and Internal IP addresses 

should be written on the IP Addresses panel on the front of the MX-E. 

8.3 Startup Log 

The web browser interface provides a log that lists the steps performed during 

the startup sequence. Open the web browser interface by starting your web 

browser and entering the main IP address (192.168.1.100 for an un-configured 

system) in the address field. To open the Start Up Log, click on Start Up Log on 

the Web Browser Interface. 

8.4 Initial System Configuration Procedure 

This procedure sets the IP addresses on a system where the main IP address is 

not specified on the IP Addresses panel. 

1. Disconnect the MX-E Ethernet ports from all devices and networks. 

2. Ensure power is removed from the MX-E. 

3. Boot up the system, following the procedure in Booting Up the MX-E. 

Alternatively, enter console mode by following the procedure described in 

Section 5.2. 

1. Configure your computer with an IP address of 192.168.1.105 and a 

subnet mask of 255.255.255.0. 
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2. Connect your PC to the Ethernet LAN port 1. 

3. If the MX-E Administrator is not installed on the computer, open your 

HTML browser, enter the IP address 192.168.1.100 , then click on 

Download Administration UI and open the file to install the software. If 

the Zultys MX-E Administrator Login panel appears, skip to step 5. 

4. Double click the MX-E Admin icon to display the Zultys MX-E 

Administrator Login panel. 

5. Enter the following values in the Login panel (logins and passwords are 

case sensitive): 

6. Login: Administrator  

7. Password: zultys 

8. URL: 192.168.1.100 

9. Run the Setup Wizard located under Provision → Wizard 

8.4.1 Obtaining MX-E Administrator 

The MX-E is configured from the MX-E Administrator application.  

MX-E Administrator allows the system administrator to configure all functions 

of MX-E including: 

• Provision the system so that it can be connected to voice services. 

• Configure the data communications functions so that MX-E fits into, or is 

the central part of, the LAN. 

• Specify the devices and users that can access MX-E and its features. 

• Define how the auto attendant (AA) and voice mail operate. 

• Monitor the status of the functions of MX-E and the devices connected to 

it. 

To download and install the MX-E Administrator application for MX-E, open a 

browser, type the main IP address of MX-E and press Enter. 
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Click on the Administration UI link to begin downloading MX-E Administrator 

application.  

 

Open the installation file and complete the installation process.  

 

Once the installation is finished, the login window appears. 

To login into MX-E Administrator, use the default login credentials.  

• Login entries may be entered directly or selected from a drop-down 

menu that lists recent entry attempts. A valid login must match the user 

name as configured in the MX-E user list. 

• Passwords must be typed exactly as configured for the specified user. 

Passwords are case sensitive. 

• URL specifies the IP address of the system that you wish to access. This 

entry may be a numerical address or a configured name for the system. 
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The entry may be entered directly or selected from a drop-down menu 

that lists recent entry attempts. 

Note: Login and Password are case sensitive 

• Login: Administrator  

• Password: zultys 

• Type the IP of 192.168.1.100 in the URL line. 

 

Click OK to open MX-E Administrator. 

Once the wizard finishes, and you click the reboot button, the User Interface 

will lose connection with the MX-E as it shuts down. 

1. Disconnect the PC from the Ethernet LAN port. 

2. Configure PC to obtain its TCP/IP address automatically. 

3. Connect the PC and the MX-E to the network. 

4. Exit the MX-E Administrator, as it will continue to connect to the 

192.168.1.100 address 

5. Login to the MX-E Admin User Interface software, entering the configured 

IP address as the URL in the Login panel, to complete the system 

provisioning and configuration. 

9. Connecting the MX-E to the Network  

9.2 Cables Required for Installation 

The number and types of cables required for your system depends on the 

enabled system options and your network configuration. See MX-E Circuit 

Cables which lists the cables that may be required.  
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MX-E Circuit Cables  
Cable and 

Connector  

Max 

Qty  

Used to connect to Minimum 

Distance 

Maximum 

Distance 

RJ45 cables 2 Analog circuits to PSTN (FXO) 0 1 km (3000 

ft) 

RJ45, 568A 

wiring, Cat 5  

2  Ethernet to an IP-enabled device, 

firewall, or provisioning console* 

0 100 m (300 

ft) 

 

* Ethernet cable wiring must comply with EIA/TIA 568A for the CAT5 

10/1000Base-T Ethernet. Crossover cables comply with EIA/TIA 568A in all 

aspects except signals on pins 1 and 3 at one end appear on pins 2 and 6 at 

the other end. 

 

To reduce the risk of fire, use only 0.4 mm (26 AWG) or larger wire for all 

telecommunications circuits. 

 

9.3 Connecting Procedure  

Refer to Front Panel of the MX-E  to locate and identify all MX-E ports. 

Connect the MX-E to the LAN through the Ethernet LAN port.  

1. Connect all subscriber stations:  

Connect IP phones or devices enabled with softphones to the LAN through a 

switch.  

2. Connect voice lines to the PSTN 

3. Connect to the IP WAN: If you connect to the WAN using external 

equipment you can connect the external equipment to the MX-E using 

the WAN Ethernet port. 

4. Ensure that power is not provided to the system. 

5. Connect the ac input to a power source, as specified by Power 

Requirements., using the ac power supply with the system. 
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Always use the provided power cords to power the MX-E; contact your 

Zultys representative if this is unsuitable. The provided power cord has a 

separate ground (earth) connector and must be inserted in a power 

socket that provides a protective ground (earth) contact. Do not use an 

extension cord that does not carry the protective grounding conductor. Keep 

the power cord properly connected at all times, even if the MX-E is not powered 

by the ac mains.  

 

The power supply cord is used as the main disconnect device. Ensure the 

power socket is located or installed near the equipment and is easily 

accessible. Do not place objects on the power cord. Run the power cord so 

people cannot step on or trip on the power cord. Overloading wall outlets may 

result in electric shock. 

10. Configuring the MX-E for Routing Mode:   

10.2 Configuring the MX-E for Routing Mode 

Internet

ITSP

Firewall

Public IP on 

Eth 2: 

20.20.20.20

Private IP 

on Eth 1: 

192.168.1.1

Local LAN

Gateway/

Edge Router

 

MX-E: For the MX-E, the Ethernet 2 (WAN interface) is always configured in 

Routing mode and thus there are no settings to change the mode of operation 

from Bridging to Routing. 
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10.3    Configuring Ethernet Port 2 for an external IP Address 

1. From the MX-E Administrator select View → Interfaces. 

2. From the View pull-down menu, Select Interfaces. 

3. From the Interface menu, double-click on Ethernet 2.  This will display 

the Interface Information screen for Ethernet Port 2. 

4. Click on the IP Information Tab, and click on Configure 

5. Right-click in the Primary field and click on Add. 

6. Configure the you public IP (in this example we will use 20.20.20.20:  

o IP Address:  20.20.20.20 

o Subnet Mask: 255.255.255.0 

7. Click on OK to return to the previous menu 

8. Click on Apply to save your changes. 

 

 

 

10.4 Set up routing tables 

Access the MX-E routing table from the MX-E Administrator,  View → Routes 

menu. If you previously assigned the default gateway when in console mode 

you will not be able to modify the first table entry with a metric of 5. You will 
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need to boot back into console mode and remove the default gateway. As a 

work around you can create an additional entry with a lower metric. 

 

Create a route that sets all IP addresses to go out to the internet (0.0.0.0 

subnet 0.0.0.0) and set the next hop (the outside router) to be 20.20.20.21. 

Test to verify the DNS and IP works correctly for the MX-E by using the ping 

function. This insures that the MX-E itself can reach the internet, and that the 

DNS lookups work correctly. If the MX-E cannot get out to the internet, nothing 

else will be able to. 

10.4.1 Test Routing Options 

The Ping function can be launched from the routes screen, by clicking on the 

“Ping” button. 
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If this works, check it by name, to verify that the DNS portion is working as well. 

Remove the check mark for By IP, and change the address to Zultys.com, and 

click Start. 
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11. SBC 

The purpose of the Session Border Controller feature introduced in MX-E 

firmware v5.0 is to facilitate the successful passage of SIP signaling and RTP 

media streams through the Network Address Translation (NAT) function 

commonly implemented in broadband gateways and corporate firewalls.  

The key purpose of NAT is to allow multiple network devices (Hosts) on a 

Private Network to connect to the Internet via a single public IP address. This 

process inherently provides a level of protection for Hosts located on the 

private network as all unsolicited packets sent from external Hosts are 

prevented from accessing the internal network Hosts.  

General information about Network Address Translation may be viewed at: 

http://en.wikipedia.org/wiki/Network_address_translation  

Routers and Broadband Gateways that implement NAT re-write the IP address 

and port information contained within IP packets and keep track of network 

conversations ensuring that traffic is able to flow in each direction for many 

applications such as web surfing or sending email. 

An undesired impact of NAT is that it detrimentally impacts protocols that 

contain embedded network address details within their application data. The 

industry standard Session Initiation Protocol (SIP) used by advanced VoIP IP-PBX 

systems such as the Zultys MX-E system is one such protocol.  

The Session Border Controller function included as standard in MX-E firmware 

v5.0 onwards supports Near-End NAT Traversal to allow the MX-E system to be 

deployed behind the corporate firewall while still allowing external SIP devices 

to connect and Far-End NAT Traversal to facilitate connection of remote phones 

such as those deployed at remote offices, employee homes and roaming sales 

people connecting from Wi-Fi hotspots, which are deployed behind broadband 

gateways and firewalls without the need for complex Virtual Private Networks 

(VPN). 

 

http://en.wikipedia.org/wiki/Network_address_translation
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11.2 Configuration settings for the MX-E when behind a firewall 

 

11.2.1 Edge Firewall/Router modifications 

The edge router must be configured to port forward all necessary packets for 

the services you plan on using (TFTP, SIP and RTP to name a few) from the 

external interface to the internal IP address of MX-E system. The images below 

show the Port Forwards relevant to SIP and RTP 

 

SBC_SIP: ‘Port From’ is the external port at which SIP signaling will be received 

from remote devices, generally this will be Port 5060 but may be another port if 

 SIP 
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desired. ‘Port To’ is the port at which MX-E is configured to receive SIP 

signaling, generally this will always be 5060. 

SBC_RTP: The external port range at which RTP packets will be received from 

remote devices. Many firewalls only support forwarding a port range to the 

same port range on the internal network, as per the above screenshot. In this 

example the external port range of 21000-21299 is forwarded to the MX-E 

system at IP 192.168.0.254:21000-21039.  

11.2.2 Remove previous External IPs if necessary 

Set the MX-E into bridging mode remove any existing routing mode setting and 

public address if previously configured. Unplug WAN interface cable if 

previously used. MX-E removes any public IP, disable and unplug WAN interface 

if previously used. 

11.2.3 Configure SBC 

In the MX-E Administrator select Provision → SBC. 

 

• Session Border Controller RTP port range – This setting determines the 

RTP port range used by MX-E on the internal side of network.  

• Set check in the Port Mapping check box for the relevant Network. 

Generally this will be the 0.0.0.0/0 network, depending upon your 
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network architecture other networks may be defined and configured for 

Port Mapping. 

• Set the Public IP to that of the WAN side of Firewall, point C on the 

diagram shown in Section 11.2. This is the IP address that all external 

devices will communicate with 

• Set external SIP Port to that you configure port forwarding for (usually 

port 5060) 

• Set the ‘External RTP Port Range Starting’ to correspond with the ‘From 

Port Range’ configured for forwarding on the firewall. This is the port 

range external devices will send RTP packets to 
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Place a check mark in each of the networks you wish to provide Application 

Layer Gateway (ALG) for the RTP (Voice packets) via SBC to and from the WAN 

(Outside world). 

 

11.3 Routing Mode (MX-E with Public IP directly connected to the 

internet) 

Routing mode is still an available option. Routing mode is when the MX-E is 

placed in the DMZ with a public IP on one side and a private IP on the other 

side. The MX-E performs all NAT and routing of packets to the internet. For 

further information on Routing Mode please refer to Routing_Mode.pdf 

document number 00000066 from technical support. 
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12. Installing the MX-E Administrator User Interface 

1. Launch a web browser (Internet Explorer). 

2. Enter 192.168.1.100 in the address field to connect to the MX-E (when in 

console mode) 
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3. Click on Download MX-E Administration UI link and run the installer. 

4. Follow the prompts of the Installation Wizard 

5. The Installation Shield will automatically install the MX-E Administrator 

and create a shortcut on your desktop. 

13. Verifying System Software Version 

The MX-E’s operating system is shipped from the factory with the current build 

on it.  However, due to time spent in the distribution channel it may be 

necessary to update your MX-E to most current version. 

13.2 Obtaining Current software version on your MX-E 

1. From the Help pull-down menu, select about 

2. The current build of software will be displayed as shown below 

 

NOTE! The MX-E system REQUIRES software version 10.0 or greater to 

operate. Earlier software versions are not compatible with MX-E 

system. 
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13.3 Obtaining Current software release information 

The current version of released software is always available on the Zultys 

Knowledge Base http://kbs.zultys.com/ (KBS). 

1. Log into the KBS and click on Firmware 

2. A list of currently available firmware is listed for the MX-E. 

3. Compare the version of software that is currently on your MX-E to the 

version that is available for download.   

o If they are the same, you don’t have to do anything. 

o If they are different, you should download the current version of 

code and perform a clean install on your MX-E. 

14. Performing a Clean Install 

A clean install is used to re-initialize a box and to install a specific version of 

software, while not taking it completely back to the factory defaults. 

Information that is not reset includes IP Address and NTP server address. 
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NOTE! Prior to performing a clean install, go to the KBS site and download the 

“MX-E Manufacturing Image” in the Product Software/Firmware area. 

Download the .zip file and extract the .tar file to the same folder where the 

firmware RPM files are stored. 

1. Launch the MX-E Administrator user interface 

2. From the Maintenance pull-down menu, select Clean Install. 

3. You will be prompted to locate the version of software that you want to 

install. 

 

 

4. Click on the Browse button to bring up the browse window. 
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5. Navigate to the files you unzipped in the previous step. 

 
 

6. Choose Next to continue the upgrade process using the specified 

software. 

This will start the process; all files will be uploaded from your PC to the 

MX-E that are required for the clean install 

7. This results in the MX-E User Properties window with progress bar. 
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8. This results in the MX-E User Properties window with progress bar. 

 

9. When all steps are completed successfully the system you will be 

prompted to restart the system. 

 

Up to this point, the MX-E continues to operate in normal mode, and calls are 

still going through. Once you press the system restarts, the system resets and 
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any incoming or outgoing calls are blocked. This is effectively the point of no 

return. 

The first upload step uploads the software to the MX-E. 

 

The MX-E will unpack all files: 

 

 
Once all files are unpacked the MX-E will start to install the default system. The 

system will be off line during the install: 
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The system can take anywhere from 2 minutes to 3 minutes to restart, 

depending on the size of the database 

Like before, you will be prompted to update your MXIE and MX-E Administrator. 

Note:  Do not try to update your MXIE and your MX-E Administrator at the same 

time. 

14.2 Restoring a Saved Configuration 

1. Click on “Maintenance” and select “Restore” 

2. Check the box next to “Configuration”  
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Note:  You can restore the Configuration or you can restore everything else.  To 

completely restore your configuration, you must repeat this process twice.  

After each restore, the system will restart. 

3. For “Location” Browse to the location where you backed up the 

configuration 

4. Then Click “Restore” 

5. A pop-up screen will appear.  You must click on yes to continue. 

 

6. Once the restore is complete, you will lose connection with the MX-E for 

about two minutes as the system restarts. 
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7. Once completed, you will need to repeat the process to restore the rest of 

the system parameters 

15. Updating the software on the MX-E 

Periodically, it is necessary to update the software on a system.  Zultys offers 

two methods of performing this task.  The first is to update the software to a 

specific level and the second is to perform a “clean” installation of a specific 

version of software.  Updating software allows you to go from version of 

software to a newer version gracefully.  Meaning that if you update the software 

on your system the configuration database for a specific system is updated as a 

part of the update sequence.  The other method, the clean installation, allows 

you to go from one version of software to the next, but also cleans out much of 

the configuration database in the process. The other advantage of the “clean” 

installation is that it will allow you to install any version of software on the box. 

15.2 Updating the system software version: 

1. From the “Maintenance” menu select “Update Firmware” 

2. The Update window appears. 

 

3. Click on the “Browse” button  
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4. Click on the Browse button to bring up the browse window. 

 

5. Navigate to the directory where you stored the latest software image 

6. Open the image by clicking on the “pack” file and clicking Open 
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7. The software version file browser window updates. 

 

Software images are stored as multiple Linux RPM files to maintain 

portability and simplify upgrades. The Linux Operating System running 

on the MX-E includes an rpm utility that manages, installs, upgrades and 

removes RPM software packages. The RPM files that make up an upgrade 

package are listed in the .pack file. 

8. Choose Next to continue the upgrade process using the specified 

software 
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9. This results in the MX-E User Properties window with progress bar. 

 

The first upload step uploads the software to the MX-E. 
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The second upload step unpacks and installs the software into the proper 

directories. 

 
The third step downloads the new Administrator GUI onto your PC from the 

MX-E 

The running step will be shown in Bold Print 

As each step completes, the Bold Text will go back to normal and a check mark 

will appear at the beginning of the line to indicate completion. 

When all steps are completed successfully the system will restart 

This takes you to the System restart progress window. 
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Up to this point, the MX-E continues to operate in normal mode, and calls are 

still going through. Once you press the system restarts, the system resets and 

any incoming or outgoing calls are blocked. This is effectively the point of no 

return (other than rolling back to the previous software release). 

The system can take anywhere from 2 minutes to 3 minutes to restart, 

depending on the size of the database 
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After system restart is complete, the database will be upgraded. 

 

Click Next when the button goes active to complete the MX-E upgrade process 

15.3 Upgrading the MX-E Administrator User Interface 

As the MX-E Administrator and MXIE are tied to the specific version of software 

on the box, the next step is to update this software. 

1. After Clicking Finish, the application will automatically prompt you to 

upgrade your Administrative User Interface 

2. The MX-E Administrator upgrade window appears. 
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1. Click Yes to run InstallShield and the MX-E Administrator upgrade program. 

 

3. When complete, the MX-E Administrator login appears. 
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4. Login as normal to Administer the MX-E 

 

If you start the MXIE, you will also be prompted to upgrade it to the latest MX-E 

compatible version. The MXIE also uses InstallShield and follows the same 

upgrade procedure as the MX-E Administrator. 

15.4 Performing a System Rollback: 

The MX-E keeps two images of software on the system.  This can be thought of 

as the active version and the previous version.  Rolling back to the previous 

version of software is largely the same as a graceful update, but it is the only 

way that you can go to a previous version of software while keeping the 

configuration of the system. 

Rolling back to the previous version: 

1. From the Maintenance pull-down menu, select Rollback to Old Software 

2. Click Next. 

3. Select Yes 

 

You will see a progress screen to let you know that the rollback has begun. 
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Once the rollback has completed, you will be prompted to click Finish. 

  

Like before, you will be prompted to update any MX-E Administrator or MXIE 

that you have running. 
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16. Backup and Restore: 

Backup and restore allows the system administrator to create an archive copy a 

systems configuration, the voicemail and the faxes associated with a specific 

system.  There are two methods of backing a system up: either a manual 

backup or a scheduled backup. After a system is backed up, it represents a 

specific correlation between the system software and the database that is 

configured on that software.  For this reason, any attempt to restore a 

configuration to a system running a different operating system will fail. 

16.2 FTP Accounts 

The MX-E will use FTP/FTPs/SFTP for all automatic backups, and the same 

FTP/FTPs/SFTP accounts can be used for manual backups. Only manual 

backups can be backed up to a local server drive via the MX-E Administrator. 

When using SFTP or FTPs remember to upload any required SSL certificates 

under Certificate Management to the MX-E. 

Name: Account name used to 

reference this account 

Protocol:  

• FTP 

• FTPs 

• SFTP 

Host: IP or URL for the FTP Server 

Port: Port Used 

Path: Path on FTP Server 

User: Username 

Password: Password 

Passive Mode: Enable Passive Mode 
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16.2.1 FTP 

Standard FTP is supported by the MX-E, and does not require any certificates to 

be loaded to the MX-E. 

When configuring the MX-E to use FTP, use port 21. 

16.2.2 SFTP 

SFTP (“SSH FTP”) is based on SSH (Secure Shell) version 2. It uses the same 

communication channels and encryption mechanisms as SSH. SFTP is fully 

supported by the MX-E starting with Version 8 of the MX-E Firmware. Valid 

certificates must be manually loaded to the MX-E. 

16.2.3 FTPs 

FTPS (“FTP over SSL”) is based on the legacy FTP protocol, with an additional 

SSL/TLS encryption layer. There are several implementations of FTPS, including 

those with “implicit SSL” where a distinct service listens for encrypted 

connections, and “explicit SSL” where the connection runs over the same service 

and is switched to an encrypted connection by a protocol option. In addition, 

there are several potential combinations of what parts of an FTPS connection 

are actually being encrypted, such as “only encrypted login” or “encrypted login 

and data transfer”. FTPs is fully supported by the MX-E starting with Version 8 

of the MX-E Firmware. Valid certificates must be manually loaded to the MX-E. 

When configuring the MX-E to use FTPs, use port 21. 

16.3 Backup 

The MX-E offers several different back up options, each of which can be 

configured to create a backup procedure to safe guard your system. 

o Manual 

o Automatic 

▪ Daily 

▪ Weekly 

▪ Monthly 
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Backups on the MX-E are version specific that is if you back up a MX-E you 

must restore it back to the same version of MX-E. If you try to restore to a 

different version a warning will let you know you cannot restore to this 

MX-E. 

16.3.1 Manual Backup 

Manual back is used to manually back up your system. This must be done 

manually each time and will be stored on a drive or FTP Server you have 

access to from the pc running the MX-E Administrator. This drive can be a 

local drive to the pc or a network drive. 

To manually back up your system go to Maintenance →Backup in the MX-E 

Administrator. 

On the Backup Navigation option, select the item(s) you wish to manually 

backup by placing a checkmark in the box next to the item(s) you wish to 

backup. You may expand the selection options by clicking on the arrows to the 

right of some of the selections that may be expanded. 

 

Once you have identified all the selections you wish to manually backup, click 

the backup now button at the bottom of the screen, or if you have manually 

backed up the system or a have FTP server already defined you may click the 
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down arrow to select one of the previously defined locations, or define a new 

location. 

 

Once a selection has been defined, the screen will update to indicate the 

backup process 

 

Once the backup is finished the log will update with “Completed, upload to the 

client” message, and the status will return to idle. 

16.3.2 Automatic Backup 

The MX-E also offers the ability to automatically backup to an FTP server by 

scheduling a backup task. To schedule a backup task, select Maintenance → 

Backup in the MX-E Administrator. 
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From the Scheduler navigation option on the left you can  

• Create a New Scheduled Task 

• Edit an Existing Scheduled Task 

• Delete an Existing Scheduled Task 

By clicking on the appropriate icon 

New Scheduled Task 

Clicking on the New Scheduled Task icon   opens a window in 

which you select the appropriate items to backup, and the schedule you wish to 

back them up on, as well as the location to back up to. 
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Backup Options 

• Once 

o Day of the year 

o Hour of the Day 

• Daily 

o Hour of the Day 

• Weekly 

o Day of the week 

o Hour of the Day 

• Monthly 

o Day of the Month 

o Hour of the Day 

Description: Description of the Task 

FTP Account: Select defined FTP 

Account 

Items to backup: Select the items you 

wish to backup in this scheduled task 

 

 

Once you have scheduled a backup it will appear on the scheduler, it is 

important to remember to press the “Save”  icon after making any 

changes to the schedule. 
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16.4 Restore Backup 

 

 

16.4.1 Identifying the backup version 

To identify the version a backup is from by opening the backup folder and 

review the ver file which can be opened by any text editing application, review 

the fw_version which will indicate the MX-E Version the backup is from. 

This version file will also provide valuable information on the date and time the 

backup was created, as well other information about the MX-E, and process 

used to create the backup. 

[compatibility] 

ver=2 

fw_version=7.9.3700 

fw_internal_version=7.9.3700 

platform=MX-E 

 

[info] 

creation_time=Mon Mar 25 12:45:56 2013 

type=Manual 

MX-E_IP=192.168.1.1 

SN=11xxx 

 

[items] 

8.3466084948209567190=NPR_Hunt 

4=CDR 

9.-1585194337608583521=5041 

8.3466084947344308350=Answering_Service 
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16.4.2 Performing the restore process 

In the MX-E Administrator click on Maintenance → Restore. 

 

Then select the appropriate backup source and file. 

 

Select the appropriate backup set. 
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Select the appropriate items to restore. 

 

Click ok to the warning that the backup may trigger a reboot of the MX-E 

 

The screen will update with progress indicators, and log entries identifying the 

process of the restore process. 
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17. Replacing the Hard Disk Drive 

The MX-E system utilizes three(3) field serviceable Hard Disk Drives for storage 

of voice messages, CDR data, call recordings. Should the need arise to replace 

the drive, the following instructions are provided. 

To replace the hard disk drive in the MX-E: 

 

• Open the hard disk drive cover by sliding the lock to eject the 

existing hard disk drive. This is done by moving the lock button on 

the hard disk drive door to the right. 

 

Drive Door 

 

 

 

Eject Button 

 

 

Eject Button moved to the right, opening the drive door 

 

• Remove the failed hard disk drive from the unit. 

 

• Install the new hard disk drive in the unit. (note: push the drive in 

using your finger as far as it will go and then use the hard disk 

drive door to seat the drive. The door should fully close and latch 

when the drive is secured. 
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LCD Display States of Hard Disk Drive: 

The LCD will display up to three(3) states to indicate Hard Disk Drive 

Status on power up: 

 

1) No drive or failed hard disk drive: 

The LCD will indicate HDD not found in the event of an improperly 

installed or failed hard disk drive installed in the MX-E. 

 
 

 

 

 

 

 

 

 

 

2) Blank hard disk drive inserted: 

The LCD will indicate New HD found in the event of a blank hard disk 

drive installed in the MX-E. 
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3) Drive that has MX-E software installed on it: 

The LCD will indicate Old HD found in the event of a hard disk drive 

with MX-E software installed in the MX-E. 

 
 

 

Note: If you remove a working MX-E Hard Disk Drive and simply re-install 

it, without attempting installation of another Hard Disk Drive, the system 

will boot normally. The system will then be ready to process calls. 

Format Hard Disk Drive: 
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After powering up, while at 1 of the three states described in the previous 

section, perform the following to proceed: 

 

1) Press the ENTER button at any state. 

 

2) Press the ENTER button at the Format new HD prompt. 

 

3) Press the ENTER button at the Confirm Format prompt. 

 

4) The system will reboot and then the screen will be blank during the 

reformat process. During this time, the DRIVE LED will light solid. 
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5) Once the system has formatted the Hard Disk Drive, you will see the 

Application Loading and Configuration Loading displays. 

 

 

 

 

 

 

The system will display System Ready and the IP Address indicating the system 

is online and ready to process calls. 
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Notes: 

1) If you remove an MX-E hard disk drive and install another MX-E hard 

disk drive, installing the original MX-E hard disk drive will result in the 

drive being reformatted! 

2) Zultys only supports Hard Disk Drives supplied by Zultys. Third party 

Hard Disk Drives are not supported by Zultys. 

 

Replacing two HDDs in MX-E with the two pre-programmed HDDs sent from 

Zultys 

1. Turn MX-E off.  

2. Remove HDDs H1 and H2 from unit.  

3. Un-plug HDD in H3 but keep it in the tray  
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4. Only insert replacement HDD labeled H1 into H1 slot. 

Make sure replacement HDD matches the MX-E serial number and 

position H1.  

5. Turn on MX-E.  

6. After a minute the LCD should display:  

 

 
  

7. Press the down key to set cursor on “Continue boot” and press ENTER key. 

 

You will see: 
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8. Press ENTER key. The system will boot up.  

9. Once MX-E boots up, shutdown the unit.  

10. Insert replacement HDD labeled H2 into H2 slot.  

Make sure replacement HDD matches the MX-E serial number and 

position H2.  

11. Reinsert HDD H3.  

12. Turn unit on.  

13. Repeat steps 6-9.  

14. Once system is in Ready state. Log in with MX Admin.  

Note the IP will be 192.168.1.100.  

15. In MX Admin go to View->Raid Manager. You will see:  
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16. Right click on Slot 2 and press “Add disk to the RAID as ACTIVE”. 

 

17. The drive will start reformatting: 
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18. After a couple of minutes, the drive will start mirroring: 

 

 

19. Mirroring processes may take up to an hour.  

If adding disk as active fails repeat steps 16 – 18.  

20. Once mirroring is finished you will see:  
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21. Right click on Slot 3 and press “Add disk to the RAID as SPARE”.  

 

22. The H3 HDD will reformat:  
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23. After a couple of minutes reformatting will complete. 

If adding disk as spare fails, repeat steps 21-22. 

 

24. Once complete RAID Manager will show:  
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18. Restricted Boot Mode 

The MX-E is capable of booting up and processing calls in the event of not 

finding a Hard Disk Drive on boot. This feature is called restricted mode boot. 

This feature allows the system to continue to process calls until the defective 

HDD can be replaced. 

There are limitations in system functionality when running in restricted mode. 

These limitations are: 

• No voice mail messages can be left or sent by users/call groups 

• No on demand or automatic call recordings will be recorded/saved 

• No CDR records are stored. This will affect MXreport and Archive Server 

operations. 

• Cannot re-record/record AA, call group announcements, or MoH files. 

The system will provide the following functionality in restricted mode: 

• Incoming/outgoing calls can be received/placed 

• Existing AA/Call Group Announcements/MoH files will play 

The boot process for restricted mode on the LCD will show as follows: 
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The MX-E Administrator will display a message indicating the system is in 

restricted mode (“System is in restricted mode. Contact Zultys or your local 

sales representative immediately”). The message will flash at the bottom of the 

screen repeatedly as follows: 

 

 

19. MX-E RAID 

The RAID (redundant array of independent disks) feature provides hard disk 

drive redundancy in the MX-E system. The MX-E system has three(3) hard disk 

drive slots. Typically, H1 and H2 are set to be in a RAID configuration and H3 is 

designated as a spare drive in the event of an H1/H2 failure. 

In the event of a hard disk drive failure, a redundant hard disk drive will take 

over for the failed drive to allow the system to boot and operate. In addition, 

the MX-E can have a spare drive installed and “at the ready” in the event of a 
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failed hard disk. In this case, the spare drive becomes part of the RAID 

configuration taking the place of the failed disk drive. 

 

In the MX-E system, hard disk drive 1(H1) and hard disk drive 2(H2) are 

configured as RAID members. Disk activity is mirrored between these drives. 

Hard disk drive 3(H3) is initially configured to be used as a spare drive. If there 

is a drive failure of H1 or H2, H3 will switch and become a RAID member. Disk 

activity is now mirrored between the active drive and H3 at this point. 

This will continue until the user assigns a new RAID member (H1/H2) after the 

faulty drive is corrected/replaced. 

MX-E Administrator is utilized to view and configure the RAID function. The 

area is in Maintenance\View\RAID Manager: 
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RAID Manager Designation MX-E Front Panel Designation 

Slot 1 H1 

Slot 2 H2 

Slot 3 H3 

 

 

 

• RAID: [ Operational ], [ Operational, mirroring ], [ Degraded ] 

• Spare: [ Present ], [ Absent ] 

• Slot: Displays the slot number and the status of the drive in the slot 

• Status Empty (should be grayed out) RAID Active, RAID Spare, RAID Faulty, Foreign 

• Mirroring: Percentage, If RAID is mirroring show progress 

• Events Displays the syslog events associated with the RAID operation 

Right click a particular drive slot to view/change drive options: 

 

 

 

Options that are available: 

Add disk to the RAID as a spare drive 
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Remove the drive from the RAID configuration 

Format the drive 

Note that all information on the drive will be erased when the 

format procedure is done! 

Check the drive. This performs a disk check of the drive. 
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Failure Scenario 

This example will show the results in the Raid Manager when a hard disk drive 

fails. In this example H2 was purposely failed. 

When the failure occurs, a syslog message is generated: 
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The RAID Manager will display the following information: 

 
 

Note that H2 is now INACTIVE due to the failure. H3 is now the slave drive in 

the RAID configuration. 

Also, the syslog failure event is shown in the Events area of the RAID Manager. 

 

The system will now start to mirror content from H1 to H3. The mirroring status 

will be reflected in the progress bar. 
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A replacement hard disk drive is now added to H2. The system detects the drive 

and dispositions it as FOREIGN. 

 
 

Right click the replacement disk drive and select “Add disk to the RAID as 

SPARE” 
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The drive will be dispositioned as a spare drive. 

 
The RAID Manager will display all activity on the RAID configuration. Here you 

can see the message that a hard disk drive was added in slot 2 as well as the 

mirroring process updates. 
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20. Using the Setup Wizard for System Configuration 

The setup wizard will guide you through the next few steps. To access the 

setup wizard select Provision → Wizard: 

20.2 Provisioning System Settings 

1. Click on “Provision” and select “Wizard”  

2. For “Company Name” The Company Name is verified when configuring 

MX-E network. 

3. Enter “Default domain” , this should be the Main IP of the MX-E, or an 

FQDN that resolves to the MX-E 

4. Select a country 

5. Enter a state  

6. Enter a city or Town  

7. Language “English US” If a language Pack was previously installed, you 

may select it from the pull-down menu.  

8. For “Default codec” select μ-law (μ-law is the standard codec in North 

America) 

9. For “Call progress tones” select 1 | USA 

10. For “Country code” enter 1 

11. Enter “Main phone number” 

– The Main Phone number is the number presented as the Caller ID 

Number unless the user has a DID Number or User Caller ID assigned 

and they are configured to present their DID number in their user 

profile. 
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20.3 System Settings – Contact Info 

This information is only used when connected to the support server. It will be 

used to contact you if there is a problem with the system. It is recommended 

that the contact information be of the Channel Partner AND reflect the company 

name where the system is installed. 
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20.4 Configuring the MX-E’s IP Address: 

1. Select IP Addresses 

2. Enter the IP Address obtained from the Administrator to be associated 

with the MX-E. 

– Main IP Address: Used for all connections to the MX-E 

– RTP IP Address: used for RTP communication only 

– Subnet Mask: Subnet mask for the local network 

 
 

Note:  All IP Addresses must be outside the scope of any DHCP Server. 
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20.5 System Settings – Servers 

1. Select Servers 

2. Fill in the DNS server address  

3. Set the “DHCP” to internal or external. 

Prior to Release 11.0.2, the MX-E did not support an internal DHCP 

server. Release 11.0.2 and higher versions provide internal DHCP 

server support. 

The DHCP menu choice appears only when DHCP is set to internal, 

that is the MX-E is providing DHCP to the network. If there is an 

existing DHCP server, this MUST be set to External. 



 

 MX-E Installation Manual (PN:0000507) Revision 11 February 11, 2019 
© 2019 Zultys, Inc. No reproduction or distribution without permission 

Page 106 of 350 

Technical Publications 

 
Note: There are two options for configuring the system’s DHCP settings:  

Manually and Automatically. 

Manually Configuring DHCP Settings: 

• Set the first IP address to be served  

• Set the last IP address to be served  

• Set option 3, Router (Default Gateway) to the edge router 

• Set option 6, DNS server to a valid DNS server available from the 

network administrator 

• Set option 42, NTP server to a valid NTP server available from the 

network administrator 

Automatic Configuration of DHCP Settings: 

• Click on the “Default” Button located below the DHCP Options field. 
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4. Set “TFTP” to Internal 

–  

5. External Billing:  Allows the MX-E system to send billing to an external 

station message-detail recording (SMDR) host.  To enable, place a 

check in the Send SMDR over IP filed, then enter the AI Address and 

TCP port . 

 

20.6 Configuring Proxies: 

Both the MX-E and the MX-E Administrator must access the Internet to convert 

Text to Speech, or to communicate with external servers such as ITSPs.  The 

MX-E uses real-time text to speech conversion in the Advanced Auto Attendant 

and the MX-E Administrator uses Text to speech conversion to generate scripts 

for Auto Attendants. 

Select the Proxies Tab of the System Properties screen.  

– Configuring the MX-Es connection to the Internet: 

▪ If the MX-E has direct access to the Internet, select Direct 

Connection. 

▪ If the MX-E must use a proxy server to access the Internet 

configure the desired Proxy server.  

Note: if the Proxy server requires authentication, put a check in the 

Authentication required box and then enter the login information by clicking 

on Credentials. 

– Configuring the MX-E Administrator’s connection to the Internet: 

▪ Similar to the MX-E, your choices are to use the same settings 

as the MX-E, Allow direct connection or to enter a different 

proxy server. 
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20.7 Configuring real-time TTS Server Settings:   

You can configure the real-time text-to-speech (TTS) server to use either a 

local TTS or to use the standard TTS server located at Zultys. 

To configure the MX-E to use the TTS server at Zultys please refer to the figure 

below: 

– Enter the User Name: guest 

– Enter and re-enter the Password: guest 

– Right-click and add a new language option: 

▪ select the desired language:  

▪ Select the desired Voice:  

▪ Enter the URL: http://67.115.97.13/tts.asp 
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20.8 LDAP Integration 

With LDAP authentication, users can login using the same password whether by 

local area network, intranet, e-mail, etc. 

To use LDAP authentication, LDAP service first must be enabled on each MX-E 

PBX.  

An LDAP authentication privilege then is assigned to each user. Through the 

MX-E Administrator, an administrator can configure a user’s profile to 

authenticate either by using a local password, which is stored and verified on 

the MX-E, or from an LDAP server. An LDAP authentication privilege can be 

removed at any time from the user’s profile, as well. 

Users with LDAP authentication use their domain passwords to login to the 

MXIE unified communications interface. 

Administrators with LDAP authentication use their domain passwords to login 

to the MX-E Administrator. 

No LDAP cache is used by the MX-E and there is no automatic fail-over to local 

passwords. If an LDAP server is unreachable, authentication cannot be provided 
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to users or administrators and their login attempt will be rejected. A best 

practice is to use two or more LDAP servers to achieve redundancy and 

reliability in case of an LDAP server failure.  

 

 

1. Click on the checkbox to Enable Authentication. 

2. Key in the data fields. 

• Search Base: This is the LDAP path to where all the users reside in the 

LDAP directory 

• Domain: This is the LDAP domain 

• Distinguished Name: Name/Account used to log into the LDAP 

directory to search for user credentials 

• Password: Password associated with the distinguished name 
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3. In the LDAP Servers block, click on the green + button ( ), to add an 

LDAP server. 

4. Enter data for Host, Port, Security and Timeout.  

• Host: IP of FQDN of LDAP Server 

• Port: Port used to communicate with the LDAP server 

• Security: Security options 

o Regular: unencrypted communications 

o SSL/TLS: SSL/TLS Protocol used in encryption 

o Start TLS: StartTLS Protocol used in encryption 

• Timeout: time out in seconds 

 

 

5. For redundancy, additional servers should be added. If one server is 

unreachable, the MX-E system automatically will attempt to use a 

secondary server. Click on the  button again to add additional servers. 

6. Click on the Apply button when done. 

20.8.1 Removing a connection/server 

To remove a server highlight server entry and click on the red minus sign (

 ), there is no warning, it is simply removed. 
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20.8.2 Testing a connection/server 

Clicking on the blue check mark (  ), will allow you to test the connection 

to the LDAP server, if it is a successful connection the following message will 

be displayed. 

 

If the test fails to connect to the LDAP server the following message will be 

displayed, and it will indicate the reasons for failing. 

 

 

20.8.3 Reordering the servers 

You can change the order of the connections/servers by highlighting the 

appropriate server and clicking the up and down arrows ( ). 

20.8.4  LDAP System Service Status 

The status of the connection between the MX-E and the LDAP server is 

indicated by a green circular icon next to the LDAP server entry in the LDAP 

server table. If the connection is lost between the MX-E and the LDAP server the 

circular icon will change to a grey color to indicate it is not able to 

communicate with the LDAP Server. 
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20.9 Configuring Misc. Tab Settings: 

The Misc. Tab allows you to configure various settings:  First if you need to play 

a call recording tone and how often, second the number of retries the Fax 

server will attempt, third the callerID handling of calls forwarded by the MX-E, 

and lastly, system shutdown on a power loss. 

1. From the System Settings screen click on the Misc. Tab.  

2. Configuring Personal Call Recording tones: 

– If you are required to play a call recording tone, put a check in the Play 

Beeps at start box. 

– Configure how often you want to play the beeps 

3. Configuring Fax Server Settings: 

– Configure the desired number of retries 

– Configure the desired interval  

– Default company name 

– Default company fax number 

4. Configuring the phone number passed by the MX-E when forwarding 

calls 

– Use main number or Preserve original caller ID. 

5. Configure if the system shuts down on AC power loss. 

– This is used on the MX-E with the APC PowerChute shutdown kit. The 

MX-E will shut down when it receives a low battery signal from the 

APC UPS unit. 

Note: The carrier must support this functionality 

When finished, click on Apply and the system will restart. 
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20.10 Setting the System Clock 

With an MX-E the procedure is to set the date and time manually and reboot the 

MX-E. After the MX-E has booted up, the Network Time Protocol (NTP) server(s) 

should be specified. The MX-E functions both as an NTP Client synchronized to 

an external NTP Server and also as an NTP Server providing time information to 

connected telephones. It is critical in MXnetwork that all nodes have the same 

time. 

Note: NTP will not be able to synchronize if the time difference between the 

MX-E internal clock and the time returned from the server is too great. That is 

why the time is set manually before specifying the NTP servers.  NTP Time 

Servers can be found using any search engine and looking for NTP Server. This 

website is also a valuable reference: 

http://support.ntp.org/bin/view/Servers/WebHome 

20.10.1 Syncing MX-E with Local PC Clock 

1. Go to Provision → System Clock. 

2. Click on the Sync with PC Time button. 

 

http://support.ntp.org/bin/view/Servers/WebHome
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20.10.2 Adding NTP Servers: 

NTP is a protocol designed to synchronize the clocks of computers over a 

network.  Time is inherently important to the function of routers and networks. 

It provides the only frame of reference between all devices on the network. This 

makes synchronized time extremely important. Without synchronized time, 

accurately correlating information between devices becomes difficult, if not 

impossible. When it comes to security, if you cannot successfully compare logs 

between each of your routers and all your network servers, you will find it very 

hard to develop a reliable picture of an incident. Finally, even if you are able to 

put the pieces together, unsynchronized times, especially between log files, 

may give an attacker with a good attorney enough wiggle room to escape 

prosecution.  

Once the MX-E has been synchronized to local time, it is possible to add a NTP 

Server. 

1. From the NTP Server area, select add. 

2. Add the following NTP Servers. 

– us.pool.ntp.org 

3. Click Next. 
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20.11 Provisioning the PCM Usage 

One PCM Card (DTE) can be configured to support either T1 or E1 Line 

Protocols.  The port can then be configured independently to support the 

appropriate Framing and Line Coding Protocols.  Further, the port can be 

configured to support Voice (Full) or Voice (Fractional) service.  

20.12 Provisioning Usage: 

Click Next, if your MX-E is provisioned with a PCM card, you will be given the 

option to configure it. If no PCM card is installed, this step will be skipped. 

1. Click on the check box for port 1 to enable 

2. Click on “Line” and select a line type 

3. Click on “Frame” and select a frame type 

4. Select service type 
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20.13 Provisioning the PCM Voice Usage 

Under the “Groups” heading.  

 

1. Double click on the default group and change name from default 

2. Click on the “Facility” field and select facility type 

3. Click on the “Inbound TS” field and enter of time slots to reserve for 

incoming calls only 

4. Click on Outbound FAX channels and enter of time slots to reserve for 

faxes 

5. Configuring Individual Interfaces 

– In row 1 (port 1) set the “Signaling” type 

– In row 1 (port 1) change the “Protocol” type 

– In row 1 (port 1) change the “Side”  
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Note: “Side” configures the port for a specific protocol language.  In the Case of 

ISDN, the Network side uses the “NT” protocol while the User side uses the “TE” 

protocol. 

– In row 1 (port 1) enter the “group” with number 

 

20.14 Provisioning the Analog FXO circuits 

Click Next, if your MX-E is provisioned with a FXO card, you will be given the 

option to configure it. If no FXO card is installed, this step will be skipped. 

20.14.1 Configuring Groups: 

1. Under the “Group” area change the Default Group name to PSTN 

2. Right click to add a new Group  

3. Set the number of DID digits to be equal to the number of digits the 

internal extension numbers are for all groups 

Note: No analog calibration is required on FXO ports of the MX-E 

system! 

Note:  Ports configured as “Fax Only” are internally connected to the MX-E Fax 

Server allowing specific FXO circuits to be routed to ACD group fax boxes. The 

association is configured in the “ACD & Operators” screen. 
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Note:  If a Group is configured as Inbound, it will not be available as a resource 

in the Dial Plan 

20.14.2 Configuring Ports: 

1. Enable all ports that will be used 

2. Select the signaling Protocol 

– Loop Start 

– Loop Start with no dial tone 

– Loop Start with Caller ID 

– Ground Start 

– Ground Start with Caller ID 

– Loop Start with DID 

– Loop Start Battery Reversal 

3. Select the appropriate group the trunks will belong to 

4. In the Destination DID enter in the extension/voice service number the 

trunk will ring to 

 

5. You will be prompted that you will need to assign the FAX Groups. 
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6. Click on OK to continue and the system will reboot. 

20.15 Provisioning the Analog FXS circuits 

RESERVED 

20.16 Reboot 

After the wizard complete you will need to reboot the system 

 
 

1. Click Restart. (The MX-E will re-boot) 

2. The MX-E will re-boot in normal mode and can now be reconnected to 

the corporate network 

At this time, connect both your PC and the MX-E to a switch. 

 

21. Location / Emergency Calling 

The most important part of the installation is configuration of the locations 

table in the MX-E. The locations table is responsible for handing all emergency 

calling (911 Calls). If the locations table is not setup or setup incorrectly 

emergency calling (911 calls) may fail. It is the responsibility of the installer to 
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verify that emergency calling is properly setup and tested before leaving the 

site. 

When the Provisioning Wizard is finished it will alert the installer that after the 

reboot they should provision the locations table and emergency calling. 

 

21.2 Emergency Calling 

When an Emergency Call is placed (911 call) the Caller ID configured under 

Provision → Locations, that number is sent as CID. Should the call be 

disconnected or the Emergency operator calls that number back the call is 

automatically routed by the MX-E to the phone or extension of the last user 

who called 911 from the specific location will ring. 
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This Caller ID number MUST be a dedicated number for this purpose, and 

cannot be the main number of the company. 

If there is no Caller ID and an Emergency Call is placed the MX-E will send the 

users DID (the DID placed in the users DID field) as Caller ID, even if there is 

Caller ID configured to the particular user. Calling back will be routed to the 

particular user, since his/her DID is called. 

 

If there is no DID, no Provision → Locations Caller ID, the Caller ID will be the 

main company number (as provisioned under Provision → System Settings – 
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Company Main Number field). Calling back to the main number will use the 

default routing for calls with unrecognized DID. 

 

 

911 dial plans for all locations MUST be configured.  Having 911 entries in the 

normal dial plan does not mark the call as Emergency call. The call will have no 

priority over the other calls; there will be no pop-up for Operations with 

information about this call. 

21.3 Emergency Call Notification and Actions 

When an Emergency Call is placed the following happens automatically by the 

MX-E 

21.3.1 Syslog Event is created in the MX-E’s event log 

 

 



 

 MX-E Installation Manual (PN:0000507) Revision 11 February 11, 2019 
© 2019 Zultys, Inc. No reproduction or distribution without permission 

Page 124 of 350 

Technical Publications 

The description of the event will include the Devices Location, the user assigned 

to the device and the device ID. 

21.3.2 Agents of Operator groups receive IM notification 

All agents of an Operator group will receive the following IM indicating an 

emergency call was placed. No configuration is required; Operator Groups (and 

only operator groups) automatically receive this IM. 

 

 

21.3.3 Calls Automatically Recorded 

Emergency calls are automatically recorded by the MX-E, and does not require a 

recording license. If the user has access to Emergency Call Recordings in their 

user profile, they will be listed in RED type 

 

21.3.4 Trunks Automatically Freed 

If all trunks are in use when an Emergency Call is placed, the MX-E will 

automatically free a trunk in the trunk group defined by the Emergency Call 

Routing table to place the Emergency Call. 
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21.4 Emergency Numbers 

Emergency numbers are used to contact emergency service providers. Although 

these providers are typically external to the enterprise, some companies may 

have an internal department to service these calls. Emergency dialing rules, as 

configured on the Locations panel, allow users to dial a number without waiting 

for a second dial tone. If the rule specifies an external number, the MX-E will 

drop other calls if necessary to set up the emergency call. 

The MX-E allows you to define more than one rule for governing emergency 

numbers. There are two reasons for having multiple rules. 

• Multiple rules allow you to specify internal and external emergency 

services. For example, one number can call an internal paramedic team 

while another rule calls an external police or fire department.  

• Multiple rules support users located in physical locations separate from 

the MX-E deployment site.  

Users connected to the MX-E at a remote location from the MX-E may require 

emergency numbers that are different from those that service the MX-E 

location. For example, suppose you have the MX-E in Sunnyvale, California with 

a user working from a Chicago branch office; the remote user is connected over 

a VPN to the MX-E. 

When a user in Sunnyvale dials 911, the MX-E routes the call to the PSTN and 

dials 911. When a user in Chicago dials 911, the MX-E dials a long distance 

number to call the emergency services that serves the Chicago location. 

The method that the MX-E employs to determine the location of a user that 

makes an emergency voice call depends upon the device used to make the call. 

MXIE provide login options that allow a user to specify the physical location of 

the device. This selection must accurately reflect the user’s physical position so 

that emergency services can be dispatched appropriately. 

You can also perform emergency chats with phone numbers that are routed to 

an internal destination. 
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21.4.1 Emergency Call Location from a ZIP Phone 

Zultys IP phones allow the normal location for each phone is specified in the 

MX-E Administrator device profile panels (Configure → Devices) and that 

normal location. 

21.4.2 Emergency Call Location from MXIE 

When logging into MXIE, the user is asked to specify his or her location. When 

the user dials an emergency number, as configured in the Locations Emergency 

Routing table, the MX-E transmits the number listed for the number as defined 

for the user’s location. 

21.4.3 Conflicting Emergency Call Locations from MXIE and the Phone 

If a user tries to bind MXIE to a Zultys IP Phone that has a different location 

selection, the binding will fail. MXIE will report "In order to bind, the MXIE and 

the phone must have the same location selection." 

21.4.4 Emergency Call Location from Other Devices: 

When using other devices, the MX-E will use the following criteria (listed in 

highest to lowest order of importance) to determine the user’s location: 

1. MXIE location and binding 

2. Subnet or IP address range 

3. Default location for MX-E 

21.5 Location Table 

The Locations panel, as shown in below, identifies the name and time zone 

location of all enterprise sites serviced by the MX-E, defines Emergency Service 

contacts for each location, and specifies the range of valid IP addresses for each 

location. Location names configured in this panel are referenced by other User 

Interface windows. See System Locations for guidelines on setting up your 

location settings. To access the Locations window, select Provision → Locations 

from the main menu. You can specify a maximum of 128 locations on an MX-E 

system. 

This table lists the name, time zone location, connection type, and available 

bandwidth for each enterprise site served by the MX-E. The first line in the 
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table identifies the primary enterprise location. The table displays this entry in 

bold typeface. 

 

 

21.5.1 Locations Table Field Definitions 

• Location Name: This parameter specifies the name of the enterprise site. 

Each location/site in the enterprise that has a unique IP address should 

have a new location created for it, unless it is within the same building. 

• Time Zone: This parameter specifies the time zone where the enterprise 

site is located. This time zone field is used to identify the time zone for 

all ZIP2xN phones. 

• Caller ID: This parameter configures the ANI (Automatic Number 

Identification), a system utilized by telephone companies to identify the 

DN (Directory Number) of a calling subscriber that is presented to the 

carrier when an Emergency Call is placed by the location. 

21.5.2 Managing Location Entries 

To add an entry to the Locations table, right click the mouse while pointing the 

cursor in the table and select New. After adding a new location, all SIP devices 

on the system should be rebooted. 

To edit the location name of a current entry, double click in the cell of the name 

that you wish to change. 
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To change the Time Zone setting of a current entry, click in the cell of the Time 

Zone setting, then press the edit button on the right side of the cell to access 

the Time Zones panel. 

To delete an entry from the Locations table, select the entry to be deleted, right 

click the mouse, and select Delete. 

21.5.3 Emergency Routing Table 

The Emergency Routing table specifies dialing rules for contacting emergency 

service providers for each location. Using multiple dialing rules allow you to 

specify unique emergency numbers for each emergency service provider at 

every enterprise site.  

21.5.4 Managing Dial Rules 

Each row within the table lists one emergency dial rule. Rules are created or 

deleted by right-clicking the mouse while the cursor is pointing in this table. To 

view the emergency numbers available for an MX-E location, highlight that site 

within the locations table. 

21.5.5 Field Definitions 

Each Emergency dialing rule comprises the three parameter settings listed in 

the table. 

• Number Dialed specifies the digit set that, when dialed by a user at the 

specified location, activates the dialing rule.  

• Route specifies the MX-E facility that will transmit the emergency phone 

number configured by the row.  

• Number Transmitted specifies the phone number sent by the MX-E to 

contact the emergency service provider. The system sends these digits 

whenever a user located at the specified location dials the digits listed in 

the Number Dialed column. 

To add an emergency contact, right click the mouse while pointing in the 

Emergency Routing table and select New Phone.  

To add an alternate route for an existing emergency number, right click the 

mouse and select New Route. 
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To remove an emergency contact or route from the table, highlight the entity to 

be removed, right click the mouse while pointing in the Emergency Routing 

table, and select Delete Phone (to remove a number) or Delete Route (to remove 

an alternate route) 

21.6 IP Ranges for Location 

The IP Ranges for Location table lists the valid IP Addresses defined for each 

MX-E location. To view the valid addresses for a site, highlight that location in 

the Locations table. 

The IP Addresses are listed in a set of ranges. Each range is defined either by 

two IP Addresses or by an IP Address and a Subnet Mask. The IP Range table 

displays both types of definitions. 

To add, edit, or delete an IP address range for a Location, right click the mouse 

while pointing in the IP Ranges for Location and select the appropriate option. 

Pressing New or Edit opens the Edit IP Range panel. 

Important: Locations panel changes do not take effect until you press the Apply 

button. If you press the Cancel button before pressing Apply, all pending 

changes to the panel are disregarded. Pressing the Apply button saves all 

pending changes. 

22. Music on Hold 

Music on Hold is configured in the form of a playlist from MX-E Administrator. 

To access the configuration window click on Configure and select Audio. 

The Music on Hold window appears. This window is divided into two parts. The 

left side of the window displays the Music on Hold Playlists, and the right side 

displays the MX-E Music Storage.   
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22.2 Managing Files in the MX-E Music storage 

The MX-E Music Storage displays all audio files that have been uploaded to the 

MX-E for use as Music on Hold.  

• To add more audio files click on the Add File(s) button.  

NOTE: Audio files must be in μ-law format (CCITT u-law, 8 bit, 8 kHz, 

mono), and must not exceed 15MB. The maximum amount of storage 

space on the MX-E designated for the audio files is 50MB on MX-E. For 

suggestions on how to convert audio files to the required format see 

Appendix A. 

• To sort the files in the MX-E Music Storage by name, size or length, click 

on the column heading.  

• To delete audio files that are not currently used in any playlist from the 

MX-E Music Storage press the Delete button. 

• To listen to an audio file, select the file and click the Play button. 
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• To download an audio file from the MX-E Music Storage, right-click on an 

audio file and click on Download File(s). 

• Click the Apply button to save any changes. 

22.3 Configuring System Playlist 

The Music on Hold Playlists box contains the System playlist. This is the default 

playlist for the MX-E system. It plays continuously and calls can enter it at any 

point in the playlist.  

Select the Play Files checkbox and customize the System playlist with the files 

uploaded to MX-E Music Storage: 

1. Drag and drop files from the MX-E Music Storage to add them to a 

playlist or select a file and press the Add “<” button. The same audio file 

can be used multiple times. 

2. If necessary, select an audio file and press the Remove “>” button, to 

remove it from the playlist. 

3. Drag and drop a file within the playlist to change its position. The files 

are played in the order in which they are displayed. 

4. Click the Apply button to save any changes. 

 

22.4 Configuring New Playlists 

Multiple playlists can be created. These playlists will always start at the 

beginning when a call is first placed on hold. If a call is placed on hold for a 

second time, the music on hold will resume from the position it was at before 

the call was picked up and so on for each new hold. 

1. Create a new playlist by clicking the New Playlist button and typing in a 

name for the playlist. 

WARNING: The playlist name cannot be changed once it has been created. 

2. Drag and drop files from the MX-E Music Storage to add them to a 

playlist or select the file and press the Add “<” button. The same audio 

file can be used multiple times. 
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3. If necessary, select an audio file and press the Remove “>” button, to 

remove it from the playlist. 

4. Drag and drop a file within the playlist to change its position. The files 

are played in the order in which they are displayed. 

5. Click the Apply button to save any changes. 

22.5 Assigning Playlists 

The music on hold playlist used when a call is placed on hold is determined by 

the playlist assigned to the call. The playlist assignment is configured in the 

user profile of the answering user, the settings of the call group 

(Operator/ACD/Hunt/ICC Group) to where the call is routed or via the transfer 

action of an automated attendant. 

22.5.1 Assigning a Playlist to a User Profile 

Select Configure → Users.  

In the User window select a user and click on the Profile button.  
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In the General tab select a playlist from the Music on Hold drop-down list. The 

available options are: 

• Do Not Change – If the call is directed to this user through a transfer, it 

will continue to listen to the same music on hold as its previous 

destination. If this is the call’s initial destination, it will use the System 

playlist. 

• System – Use the System playlist for calls routed to this user.  
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• Playlist name – Calls routed to this user will use the selected playlist. 

Click OK to save changes. 

22.5.2 Assigning a Playlist to a Call Group 

Select Configure → Operator and Call Groups. 

 

In the General tab select a playlist from the Music on Hold drop-down list. The 

available options are:  

• Do Not Change – If the call is directed to this call group through a 

transfer, it will continue to listen to the same music on hold as its 

previous destination. If this is the call’s initial destination, it will use the 

System playlist. 

• System – Use the System playlist for calls routed to this call group. 

• Playlist name – Calls routed to this call group will use the selected 

playlist.  

Click OK to save changes. 

22.5.3 Assigning a Playlist to a Call Group Number Association 

Select Configure → Operator and Call Groups. 
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In the Number Associations tab, select a playlist in the Music on Hold column. 

The available options are: 

• Do Not Change – If the call is directed to this call group number through 

a transfer, it will continue to listen to the same music on hold as its 

previous destination. If this is the call’s initial destination, it will use the 

System playlist. 

• System – Use the System playlist for calls routed to this call group 

number association number. 

• Playlist name – Calls routed to this call group number association will use 

the selected playlist.  

Click OK to save changes. 

22.5.4 Assigning a Playlist through an Auto Attendant 

The transfer action of the auto attendant provides a mechanism to change the 

Music on Hold playlist assigned to a call at the time of transfer. Auto attendant 

scripts are created and edited by going to Auto Attendants → Scripts.  
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In the Action Editor window select the Transfer action and define the greeting 

and transfer parameters.  
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In the Call Attached Fields section, select the required playlist from the Music 

on Hold drop–down list. The available options are: 

• Do Not Change – If the call is directed to this auto attendant through a 

transfer, it will continue to listen to the same Music on Hold as its 

previous destination following this transfer. If this is the call’s initial 

destination, it will use the System playlist following this transfer.   

• System – Use the System playlist following this transfer.  

• Playlist name – Calls will use the selected playlist following this transfer.  

Click OK to save changes. 
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22.6 Playlist Assignment Rules 

Playlist assignment is governed by the following rules: 

• When a call first arrives it is always assigned the System playlist. 

• If the MX-E system cannot find the playlist by name, it uses the System 

playlist.  

• On transfer to a user or a call group destination where Do Not Change is 

set as a playlist for Music on Hold, the call will continue to listen to the 

playlist it has been assigned at its earlier destination.  

• On transfer to a user or a call group destination where any other playlist 

besides Do Not Change is set, the call will change to the music on hold 

playlist defined for the new destination. 

• For System playlist configured to use WAV files, the playlist is played 

continuously and calls can enter it at any point in the playlist. If the 

System playlist reaches the end of the last file in its list and no calls are 

currently on hold, the next call that uses the System playlist will hear the 

first file from the beginning. 

• Playlists other than System playlist, start playing from the beginning. If a 

call is placed on hold for a second time, the music on hold will resume 

from the position it was at before the call was retrieved from hold the 

first time and so on for each new hold. 

• Parking a call does not change the playlist assignment. The playlist 

assigned to the call before it was parked is maintained at least until the 

call is retrieved from park.  

• Upon performing the following operations: pickup, direct pickup and 

pickup from hold, if the new user or call group destination has an 

assigned playlist other than Do Not Change, the new playlist is assigned 

to the call. 

22.7 Limitations 

The Music on Hold Assignment function is bound by the following limitations: 
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• The system doesn’t allow for automatic sharing of playlists between MX-E 

systems in an MXnetwork configuration.  

• The total number of playlists that can be configured for an MX-E system 

is 64. 

• The number of calls that can simultaneous access the System playlist is 

unlimited. 

• The number of calls that can simultaneous access playlists other than the 

System playlist is limited to 10 calls on MX-E. 

• If this limit is reached, calls above the limit will use the System playlist. 

 

23. Adding Devices - ZIP5 

23.2 Create Profile for ZIP5 phone 

To create a new ZIP5 series phone profile: 

1. In MX-E Administrator, select Configure, then Devices.  

2. Click the Profile button in the Managed Devices window 

3. Right-click Zultys Phones and select New to create a new device 

profile in Device Profiles window 
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4. Select ZIP5 series phone in the Add Device Profile popup window. 

 

 

 

5. Type in a profile name; in this screenshot 55i was used. 

23.3 Profile Tabs 

The device profile for each phone is divided into several tabs. Each tab 

configures different aspects of the profile itself. 
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23.3.1 General Tab 

The General tab contains Phone Administration, used to set passwords 

for configuration of both the web and the phone interfaces, Busy Lamp 

Field and Miscellaneous setting.  

 

 

• Local User Password: The user password for the web interface and 

the local interface of the ZIP5 Phone. By default, this password is 

not set. 

• Local Administrator Password: The Administrator password for the 

web interface and the local interface of the ZIP5 phone. By default it 

is 22222. 

• Directed Call Pickup: Enables Directed Call Pickup of the stations 

monitored by the BLF buttons. 

• Play a Ring Splash: If enabled, the phone plays a Call Waiting tone 

when off-hook or a Splash Ring when on-hook for each BLF 

programmed on the phone. 
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• BLF Subscription Period: The period a Busy Lamp Field registration 

will last before renewing. 

• Missed Calls Indicator: If enabled, the missed call display message 

is turned on. (Note: to clear this message you must have a callers 

list button defined or have the hard key on the phone) 

• Backlight: Backlight settings for the models of ZIP5 that supports 

the backlight feature. 

• Display “To” information for incoming calls: If enabled, the “To” 

header is shown on the phone’s display for incoming calls (helpful 

if the phone is a member of multiple call groups or multiple users 

are assigned to the phone). 

• Auto-Answer Intercom calls: Enables the ability for the phone to 

receive intercom calls. An intercom call is defined as a call to a 

phone that is automatically answered on the speakerphone (or 

headset). 

• Mute Intercom calls: If enabled, mute will engage when an intercom 

call is received. The user must press Mute to disable the muting 

manually in order to respond back to the caller. 
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23.3.2 Region tab 

The Regional tab contains settings for the phone’s location. 

 

 

On this tab you will set the regional information such as 

• Language: Language displayed on the phone’s display. 

• Dial Tone: The type of dial tone used by the phone. 

• Time Zone: The time zone this phone is in. 

• Time Format: The format in which time is displayed by the phone. 

• Date Format: The format in which date is displayed by the phone. 
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23.3.3 Sip Tab 

 

 

The SIP Tab contains settings for the type of ZIP5 phone used and the 

registration addresses. 

23.3.3.1 Phone Types 

This option is automatically filled based on the ZIP5 phone type and 

cannot be changed. 

23.3.3.2 Line numbers 

The ZIP5 can handle multiple line numbers, or multiple registrations, the 

number will depend on the model of ZIP5 phone. A single registration will 

allow calls to be received or made from each of the physical hard line 

keys on the device. In most cases only one registration is required. 

Voice Mail Ext. is grayed out and automatically filled by the MX-E. 

23.3.3.3 Registration Details 

The Registrar, SIP Proxy, and Outbound Proxy all must be set to MX-E 

Address.  
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WARNING: Failure to do this will not allow you to make outgoing calls.  

Address and port number are grayed out, and are not changeable when 

using the MX-E Address. 

 

23.3.4 IP & Provisioning Tab 

The IP and Provisioning tab contains settings for defining the IP address, 

DNS Servers, NTP Server, and Provisioning method. 

 

 

23.3.4.1 LAN 

Select whether the IP information is obtained from DHCP or statically 

assigned to the phone 

23.3.4.2  Servers 

Define the DNS Server and the NTP Servers. 

23.3.4.3 Provisioning 

Select the provisioning method from the following: 
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• TFTP 

• FTP 

• HTTP 

• HTTPS 

It is recommended that you use TFTP and select MX-E as the server. This 

enables the MX-E to build the configuration files, correctly name them 

and save them on the MX-E’s TFTP Server. The MX-E only supports HTTP 

and TFTP. 

If you choose to change this, type in the IP address and port number, or 

select DHCP to allow this information to come from the DHCP Server. 

Depending on the Provisioning option, Path, User Name, and Password 

options become active. 

23.3.5 Audio & RTP 

The Audio and RTP Tab contains setting on how the audio and RTP will be 

handled by the phone. 
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23.3.5.1 DTMF for RTP 

Use the default of RFC 2833. Sending DTMF inband is not supported by 

the MX-E, and should not be chosen. 

23.3.5.2 Codecs 

Choose the default codec for this device from the drop-down list. 

Possible Codecs are: 

• G711µ – Law 

• G711a – Law 

• G729A 

Set the priority to High, and select Silence Suppression. 

23.3.5.3 Ring Tones 

Select a ring tone from the list of ring tones available for this phone 

model. 

23.3.5.4 Distinctive Ringing 

Select ring tones for Internal Calls and External Calls from the list of ring 

tones available for this phone model. 

The Advance button allows you to customize the ring tone by adjusting 

the frequency, and cadence. 

23.3.5.5 Miscellaneous 

• Early Media: Select to enable Early Media for the phone. 

• Allow paging to interrupt active calls: This option, when enabled, 

will put active calls on hold when a page is made to the phone to 

allow the page to be heard. 

• Handsfree Mode: Select from the list of settings to control the 

mode of the speaker button which can be used for headset 

operation. 

• Silence Suppression: Enables silence suppression. 
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23.3.6 VLAN Tab 

The VLAN tab contains settings for configuring VLAN support for this 

phone. The settings in this tab differ depending on the ZIP5 phone 

model.  

 

 

23.3.6.1 VLAN Support 

Enables VLAN support for this device. 

23.3.6.2 LAN Port 

Choose which VLAN the phone will be on, and set the Class of Service 

(CoS) for this VLAN. This section only affects the LAN Port of the phone, 

not the PC Port. 

23.3.6.3 PC Port 

Choose the VLAN that the PC Port will run on, and it’s CoS. 
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23.3.7 Keys Tab 

The Keys tab contains setting for custom soft keys for the phone. The 

number of keys, and position (Bottom Keys or Upper Keys) allowed on the 

phone will differ depending on ZIP5 Phone Model.  

Keys can also be programmed for individual phones by clicking the Key 

Provisioning button in the device configuration screen, see section 

23.3.10. 

 

23.3.7.1 Key  

The number of the physical key on the phone. 

23.3.7.2 Lock 

Block the end user from modifying this key from the phone’s interface or 

the web interface by selecting this checkbox. 

23.3.7.3 Type 

Select the type of key. Available options are: 

• None: This softkey or programmable key is disabled 
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• Speed dial: This softkey or programmable key is configured for 

speed dial use. 

• Do Not Disturb: This softkey or programmable key is configured for 

"do not disturb" use. 

• BLF: This softkey or programmable key is configured for Busy Lamp 

Field (BLF) use. A user can dial out on a BLF configured softkey: 

o Max of 50 BLF per phone 

o Max of 500 to 600 per system 

o Max of 64 stations monitoring the same phone 

• Park Monitored: This softkey or programmable key is configured to 

monitor a Park ID. If a call is parked to an ID the button monitoring 

it will light up. 

• This key type is included in the BFL count for the systemLogin (Call 

Group): This softkey or programmable key is configured as a Login 

button to call groups (ACD/ICC/Operator). When the user presses 

this button they will be asked to enter in their Voicemail Password, 

and then be logged into the group. The key will light up to indicate 

they are logged in. Pressing it again will log them out of the call 

group. The value is <user extension number>.<group extension 

number> 

o This key type is included in the BFL count for the system 

• Mailbox MWI: This softkey or programmable key is configured to 

indicate if there is a message waiting for the monitored mail box. 

Pressing the key will take the user to the login for that mail box. 

o This key type is included in the BFL count for the system 

• Park (auto): This softkey or programmable key is configured as a 

park key to park an incoming call. The MX-E will automatically 

select a park ID and display it on the phone and in MXIE. 
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• Park (manual): This softkey or programmable key is configured as a 

park key to park an incoming call. The user will have to manually 

select a park ID and it will be displayed on the phone and in MXIE. 

• Pickup: This softkey or programmable key is configured as a pickup 

key to pick up a parked call. 

• Directory: This softkey or programmable key is configured to 

access the directory listing stored on the phone. This directory 

must be updated manually on the phone or via a configuration file. 

• XML Directory: This softkey or programmable key is configured to 

access the directory listing stored on the phone. This directory is 

automatically populated and managed by the MX-E and requires no 

up keep. 

• Callers List: This softkey or programmable key is configured to 

access the list of missed and received calls. 

• Services: This softkey or programmable key is configured to pull up 

a directory of the following options: 

o Web Aps 

o Directory 

o Caller List 

o Voicemail 

• Voicemail: This softkey or programmable key is configured to 

access the MX-E voice mail. 

• Page/Intercom: This softkey or programmable key is configured to 

access the page server followed but the page group ID to make a 

page or can be followed by an extension number to intercom. 

• Empty: This softkey or programmable key is configured to force a 

blank entry on the IP phone display for a specific softkey. 

• Save: This softkey or programmable key is configured to save 

entries for speed dial tables. Must be in position 5 for a 53e phone. 



 

 MX-E Installation Manual (PN:0000507) Revision 11 February 11, 2019 
© 2019 Zultys, Inc. No reproduction or distribution without permission 

Page 152 of 350 

Technical Publications 

• Delete: This softkey or programmable key is configured to delete 

entries for speed dial tables. Must be in position 6 for a 53e phone. 

• Conference: This softkey or programmable key is configured for a 

local phone conference. The ZIP5 phone support 2 callers and 

yourself for a total of 3 party conferences. 

• MX-E Conference: This softkey or programmable key is configured 

to start or join an MXconference. 

• Transfer: This softkey or programmable key is configured to create 

a transfer for phones that do not have a hard key for transfer (for 

example 51i phone). 

23.3.7.4 Label 

This is what the user will see on the display of the phone for a programed 

key, if supported. 

23.3.7.5 Value 

The value for this key depends on the type of key selected. For example: 

• If BLF is selected, this value is the extension number. 

• If Park is selected, the value is callpark. 

23.3.7.6 Line 

This value is used to determine which registration this key acts on. 

Normally this will always be 1. 

23.3.7.7 Key Availability to User 

Select when each key is available to users by selecting the check boxes 

on the bottom of this tab. 

o Idle: Key is available when the phone is idle. 

o Incoming:  Key is available when the phone is ringing on an 

incoming call. 

o Busy: Key is available when the phone is busy (off-hook). 

o Connected: Key is available when a call is currently connected. 

o Outgoing: Key is available when a call is being placed. 
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23.3.7.8 Programming Soft Keys for Add On Modules 

Enable the number of expansion modules to use in the SIP tab, and program the 

keys for them in the Keys tab. 

 

 Select the extension module from the extension module type selection. 
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23.3.8 Advanced Tab 

This tab contains the actual configuration file. From here you can make 

your own custom changes to the configuration file. Note that making 

changes in the other tabs may remove any custom entries. 
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23.3.9 Park and Paging 

Calls can be parked and later picked up from the ZIP5 phones. If park (manual) 

is used, user must provide the Park ID at the time of call park operation, the 

Park ID should be within the call park range configured on the MX-E (under 

Phone Services in Configure). There should be a Park button defined on the 

phone (auto, manual, or monitored) and a Pickup button. 

 

Users with ZIP5 phones assigned / bound to them can receive paging 

announcements. Due to the nature of SIP based paging, the number of ZIP5 

devices associated with a paging group should be limited to 32 devices. This 

can be further limited by the number of available sessions. 
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23.3.10  Device Configuration 

From the device configuration screen you can edit the keys per device by 

clicking the Key Provisioning button. Clear the Use check box to allow 

overwriting the profile button options. 

  

23.3.11 Languages 

The ZIP5 phones can support multiple languages. To enable these languages on 

the phone please download the correct language pack and copy them to the 

MX-E TFTP server. In the Advanced tab of the profile for the phone, modify the 

following lines to enable a menu for the user to pick the language from, and set 

the default language. This is automatically set in the Language field in the 

Regional tab.  

language : 0 (where the number indicates the language defined 

below, default is 0 for English) 

language 1: lang_de.txt 

language 2: lang_es.txt 

language 3: lang_es_MX-E.txt 
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language 4: lang_fr.txt 

language 5: lang_fr_ca.txt 

language 6: lang_it.txt 

language 7: lang_pt.txt 

language 8: lang_pr_br.txt 

language 9: lang_ru.txt 

 

Languages 1 through 4 are the menu options for languages. Language x is the 

default language (where 0 is the default English option). Not all languages are 

available for all phones. 

 

24. Adding Devices – ZIP3 

This document covers the steps required to provision, deploy and 

manage the Zultys ZIP 33i IP phones with a Zultys MX-E system. ZIP 33i 

phones are supported in MX-E Release 7.2.1 and later, prior to this 

release there is no support for ZIP 33i phones.  

In general the steps required to successfully deploy a ZIP 33i phone are: 

• Upload the current ZIP 33i firmware ROM file to the TFTP server of 

the MX-E system. The current firmware release is available from the 

Zultys Knowledge Base System (http://kbs.zultys.com). Refer to 

section 24.1.14.  

• Create a ZIP 33i device profile with the relevant settings including 

selection of the firmware version to be used by the ZIP 33i phones. 

Refer to section 24.1.  

• Add the ZIP 33i devices to the MX-E system and assign the 

appropriate device profile. Refer to section 24.1.11. 

• Add new users to the MX-E system if required then assign the 

newly provisioned devices to their respective users. 

• To use automatic provisioning ensure the DHCP server is correctly 

configured to provide Option 66. Refer to Section 24.1.6.3.  

http://kbs.zultys.com/
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24.1 Creating a Device Profile 

A Device Profile defines a common set of configuration options that will be 

applied to all phones that are allocated a particular Device Profile. This 

greatly simplifies the management of deployed phones as changes only need 

to be performed in one place.  

Prior to creating a new Device Profile the system administrator should 

ensure that the current ZIP 33i firmware ROM file has been uploaded to the 

TFTP server of the MX-E system. Refer to section 24.1.14 for further 

information.  

To create a new ZIP 33i device profile:  

1. In MX-E Administrator, select Configure → Devices.  

2. Click the Profile button in the Managed Devices window. 

3. In the Device Profiles window Right-click Zultys Phones and select 

New to create a new device profile. 

 

 

4. In the Add Device Profile window set the Phone Type to ZIP 33i. 
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5. Type a Profile Name, in the screenshot above Sample_33i  is used. 

24.1.1 Overview of Profile Tabs 

The device profile for each phone is divided into several tabs. Each tab 

configures different aspects of the profile. 

 

24.1.2 General Tab 

The General tab contains settings related to firmware version and 

updating, password settings and various miscellaneous settings.  
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• Download protocol: Defines the protocol used by the phone to 

download new firmware.  

o None – Phone will not check for new firmware on power up 

o TFTP – Phone will use TFTP (Trivial File Transfer Protocol) to 

download firmware image on power up if different to the 

currently installed version. This is the default setting. 

o HTTP – Phone will use HTTP (Hyper Text Transfer Protocol) to 

download firmware image on power up if different to the 

currently installed version. HTTP may perform more reliably 

over poor quality links. 

• Server: Defines the address of server where firmware image is 

stored 



 

 MX-E Installation Manual (PN:0000507) Revision 11 February 11, 2019 
© 2019 Zultys, Inc. No reproduction or distribution without permission 

Page 161 of 350 

Technical Publications 

o MX-E – Select when the internal TFTP/HTTP server of the MX-

E system is to be used, this will be the case for most 

deployments. For HTTP TCP port 8080 is used  

▪ Address – Lists the MX-E systems IP addresses 

including LAN, WAN and SBC Port Mapping addresses if 

configured. For external phones connecting to a WAN 

or SBC address you may need to configure port 

forwarding on external routers. 

▪ Filename – Lists the compatible firmware images 

stored on the MX-E TFTP server. Select the desired 

filename from the dropdown. If the files stored on the 

TFTP have recently been changed by another system 

administrator press the Refresh button to update the 

list. If the field background is red the corresponding 

file is not present on the TFTP server and thus the 

phone will be unable to access the file. Files are 

uploaded to the TFTP server via the TFTP Settings 

window accessible from the Configure → Devices 

screen. Refer to section 24.1.14 for further information 

about the firmware upgrade process. 

o Custom – Select when an external TFTP/HTTP server is to be 

used. In the corresponding address field type the full path 

and filename. For HTTP both the address and port may be 

defined.  

TFTP example – 192.168.1.100/60.61.132.8.rom 

HTTP example – 

192.168.1.100:8080/tftpphone/60.61.132.8.rom 

 

• Phone Administration: Set passwords used to access various 

restricted sections of phone interface and web interface. 
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o Local User Password – Password to access User level 

restricted sections. Default is ‘user’. If the field is left blank 

then no password is required. 

o Local Administrator Password – Password to access 

Administrator level restricted sections. Default is ‘admin’. If 

the field is left blank then no password is required. 

• Busy Lamp Field  

o BLF Subscription Period: The period in seconds a Busy Lamp 

Field subscription will last before phone re-subscribes. 

Default is ‘3600’. 

• Miscellaneous:  

o Missed Call Indicator – When enabled the phone will display 

the number of missed calls on the idle screen and also store 

caller details for the missed calls in the Call Log. When 

disabled no missed call indication will be displayed and the 

phone will not store any information about the missed call in 

the Call Log.  

o Auto-answer Intercom calls – When set to Yes the phone will 

automatically answer received Intercom calls. When set to No 

the phone will ring when an Intercom call is received. Default 

is Yes. 

o Mute Intercom calls – This setting is fixed at No. The 

microphone will always be enabled when an intercom call is 

answered. 

o Send Syslog event when device is not registered with the MX-

E – When set to Yes, in the event that the phone fails to 

register / re-register, a message will appear in the Syslog of 

the MX-E alerting the system administrator to a potential 

issue with the phone or network.  Default is No. 
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24.1.3 Regional tab 

The Regional tab contains settings related to phone location including 

language, dial tone, time zone and time format.  

 

The settings on this screen will automatically populate based on the 

default location setting of the MX-E. If required change the settings to 

suit the phones location. 

• Language: Language for telephone user interface (TUI) of the 

phone. 

• Dial Tone: Determines the dial tone and call progress tones 

generated by the phone. 

• Time Zone: The time zone the phone is located in. Time zones will 

also generally impact DST dates. 

• Time Format: Time display format, 12 or 24 hour. 

24.1.4 SIP Tab 

The SIP Tab contains settings related to the registration addresses. 
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24.1.5 Lines 

The ZIP 33i supports two independent SIP Registrations. In most cases 

only one registration is required. ‘Line’ registrations should not be 

confused with the number of Line Keys or Call Appearances configured 

via the ‘Keys’ tab. Multiple calls may be handled via a single registration.  

• Enable – Select checkbox to enable Line 

• Registrar Source – Defines the source of Registrar (SIP Server) 

address. Line 1 Registrar Source is always MX-E Address. The 

actual Registrar address is defined in the Registration Details 

section.  

• Registration Expires – Defines the registration period in second. 

Default is 3600. 

• Voice Mail – Defines the voice mail service number / URI related to 

the Line. Default is ‘voice.mail’ and fixed when Registrar Source is 

MX-E Address. 

The ‘Registration details’ section defines the server address information 

related to the Line currently selected in the top section of the screen.  

• Registrar: Settings related to SIP Registrar address 
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o Address Source – Defines the source for Address setting. Line 

1 is always MX-E Address. 

o Address – Defines the Registrar address. When Address 

Source is MX-E Address the dropdown will list all LAN, WAN 

and SBC addresses configured on the MX-E system. For 

phones deployed within the corporate network the LAN 

address of MX-E system should be selected. If using a WAN 

or SBC address the network must be configured appropriately 

to allow external phones to connect. 

o Port – Defines the port used for SIP signaling.   

• Outbound Proxy: Settings related to Outbound Proxy address 

o Address Source – Defines the source for Address setting.  

o Address – Defines the Outbound Proxy address. For 

applications where the phone is registering to an MX-E this 

address should be the same as the Registrar address. 

o Port – Defines the port used for SIP signaling.   
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24.1.6 IP & Provisioning Tab 

The IP and Provisioning tab contains settings for defining the IP address, 

DNS Servers, NTP Server, and Provisioning method. 

 

 

24.1.6.1 LAN 

Select whether the IP address information is obtain automatically via 

DHCP or statically defined in the phone. If static addressing is used this 

screen defines the subnet mask and default gateway parameters, the IP 

address of the phone is defined in the Edit Device screen. Use of DHCP 

addressing is recommended.  

24.1.6.2  Servers 

Define the NTP Server and DNS Server addresses.  
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• NTP Server – Address of NTP time server that phone will 

synchronize its clock with. By default the field is populated with the 

main IP address of the MX-E system. To have the phone obtain the 

NTP server address via DHCP Option 42 leave this field blank and 

ensure the DHCP server has Option 42 correctly configured to point 

to a suitable NTP server. The MX-E system functions as an NTP 

server. 

• Primary DNS / Secondary DNS – Address of DNS servers. If DHCP 

option is selected the DNS addresses will be obtained from DHCP 

server. 

24.1.6.3 Provisioning 

Define the protocol that phones use to download their configuration files. 

When using an external DHCP server, Option 66 must be configured to 

provide the IP address of the MX-E system for automatic provisioning of a 

new phone to function. If Option 66 is not enabled on the DHCP server 

the provisioning server address must be manually configured on the 

phone via the web interface or phone menu. 

Overview of provisioning server options:  

• Protocol: Select desired protocol to be used for configuration file 

download 

o DHCP (option 66) – Phone will obtain the TFTP server address 

via DHCP option 66 and then download its configuration file 

using TFTP. The DHCP server must have option 66 

configured with the IP address of the MX-E system. This is 

the default setting.  

o TFTP – When selected the phone will download its 

configuration file using TFTP from the address specified in 

the Server section. For most applications the Server will be 

set to MX-E. For this option to work, the phone must initially 

be able to locate and connect to the MX-E TFTP server based 

on DHCP option 66, alternatively the address shown in the 
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‘URL preview’ may be manually entered via the phone’s menu 

or web interface. 

o FTP - When selected the phone will download its 

configuration file using FTP from the address specified in the 

Server section. An external FTP server is required and 

external TFTP server option must be configured on the MX-E. 

The User Name field must be populated with the User Name 

and Password of the FTP account in the format 

username:password. For this option to work, the phone must 

initially be able to locate and connect to the MX-E TFTP 

server based on DHCP option 66, otherwise the Auto 

Provisioning URL setting on the phone must be manually 

populated with the text shown in the URL preview field. 

o HTTP – When selected the phone will download its 

configuration file using HTTP from the address specified in 

the Server section. For most applications the Server will be 

set to MX-E. For this option to work, the phone must initially 

be able to locate and connect to the MX-E TFTP server based 

on DHCP option 66, alternatively the address shown in the 

‘URL preview’ may be manually entered via the telephone’s 

menu.  

o HTTPS - When selected the phone will download its 

configuration file using HTTPS from the address specified in 

the Server section. An external HTTPS server is required and 

external TFTP server option must be configured on the MX-E. 

For this option to work, the phone must initially be able to 

locate and connect to the MX-E TFTP server based on DHCP 

option 66, alternatively the address shown in the ‘URL 

preview’ may be manually entered via the telephone’s menu. 
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24.1.7 Audio & RTP  

The Audio and RTP Tab contains setting related to DTMF, codecs, layer 3 

QoS tagging, ring tones and miscellaneous settings.  

 

 

24.1.7.1 DTMF for RTP 

Use the default of RFC 2833. Sending DTMF inband is not supported by 

the MX-E and should not be selected. 

 

 



 

 MX-E Installation Manual (PN:0000507) Revision 11 February 11, 2019 
© 2019 Zultys, Inc. No reproduction or distribution without permission 

Page 170 of 350 

Technical Publications 

24.1.7.2 Codecs 

The Codecs section defines which codecs are enabled and their priority 

order.  

 

The codec at the top of the list has the highest priority. Codecs which 

have the Disable box checked are disabled.  

Available codecs and the default ordering: 

• G.711 µ-Law 

• G.711 A-Law 

• G.729a 

• G.722  (Disabled by default) 

To change priorities select the codec and then press the Increase Priority 

or Decrease Priority buttons as required. To disable a codec check the 

Disable box. 

The default codec settings are suitable for most deployment scenarios. 

Which codec is ultimately used for a call depends on a combination of the 

device profile, MX-E codec profile for the location(s) and the ITSP/SIP 

Trunk codec profile settings if applicable.  

For international regions where ITSP’s and SIP Trunk providers prefer to 

use G.711 A-Law, if the codec profile on MX-E has G.711 A-Law as the 

highest priority it may be desirable to also make G.711 A-Law the highest 

priority on the phone. 

G.722 is a wideband codec which may be negotiated only between IP 

phones connected to the same MX-E system. The codec profile on the 
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MX-E system must be set to ‘Don’t Care’ to allow G.722 to be negotiated. 

It is recommended to leave this codec disabled.  

24.1.7.3 Quality of Service: ToS/Diffserv 

The Quality of Service (QoS) section defines the settings for Layer 3 DSCP 

packet tagging.  

 

DSCP may also be referred to as Diffserv or Type of Service (ToS) tagging. 

RTP and SIP packets may be tagged with different DSCP values. The 

underlying network must be provisioned to recognize DSCP/ToS tags and 

prioritize the packets accordingly.  

• RTP DSCP – Default value 46 (EF) 

• SIP DSCP – Default value 26 (AF31) 

 

24.1.7.4 Ring Tones 

The Ring Tones section defines the ring tone settings and Call waiting 

tone.  

 

The phone has 8 built-in ring tones and supports distinctive ringing so 

that the user may easily differentiate between ringing internal and 

external calls.  

The default ring tone settings in a newly created profile are based on the 

Time Zone setting for the Default Location of the MX-E system as defined 
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on the Provision → Locations screen, thus for most deployments the 

default settings are appropriate.  

For US locations Internal Calls are assigned a Ring tone, and External 

Calls are assigned a Ring Pause tone.  

For Australia, New Zealand, UK and related countries Internal Calls are 

assigned a Ring Pause tone, and External Calls are assigned a Ring tone.  

For regions where no specific association is defined the default settings 

will be the same as for the US. 

 

24.1.7.5 Miscellaneous 

The Miscellaneous section defines settings related to Early Media support 

and Paging calls.  

 

 

• Early Media: Select to enable Early Media for the phone. Early Media 

is a SIP mechanism which allows for inband audio to be passed 

through to the phone prior to the call reaching a connected state. 

By default this option is enabled. 

• Allow paging to interrupt active calls: This setting is always enabled 

and may not be edited. Any paging call received by the phone will 

interrupt an active call if present. The active call will be placed on 

hold.  

24.1.8 VLAN Tab  

The VLAN tab contains settings related to VLAN tagging and LLDP 

support.  

The phone incorporates a 2 port managed switch with the ability for voice 

and data traffic to use different Virtual LAN’s. VLAN settings may be 
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configured via the profile options or automatically using LLDP (Link Layer 

Discovery Protocol). 

When defining the VLAN settings in the profile care must be taken to 

ensure that once the phone downloads its configuration file it will be able 

to contact the MX-E system. If it cannot due to a mismatch between the 

VLAN settings stored in the phone and the configuration of the network, 

the phone will need to be factory reset via the Menu → Settings → 

Advanced → Reset Factory screen of phone. 

 

 

24.1.8.1 LAN Port 

When VLAN support is enabled for the LAN Port, all phone related packets 

transmitted from the LAN port will be tagged with the defined LAN port 

VLAN ID and Class of Service (CoS) value.  

All phone related packets received from the access network must be 

tagged with the same VLAN ID. Effectively this can be thought of as the 

Voice VLAN. 

24.1.8.2 PC Port 

When VLAN support is enabled for the PC Port, untagged packets that 

enter the PC Port will be tagged with the defined PC port VLAN ID as they 
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egress from the LAN port of the phone. All packets received at the LAN 

port which are tagged with the ID defined for the PC port will be passed 

to the PC port. Effectively this can be thought of as the Data VLAN. If the 

Data VLAN is untagged on the access network then this option should be 

disabled. 

24.1.8.3 LLDP 

As an alternative to explicitly defining the VLAN ID’s for the LAN and PC 

ports, the Link Layer Discovery Protocol (LLDP) may be used if supported 

by the access switch. LLDP allows the VLAN settings to be defined at the 

access switch and automatically pushed to the phone.  

The advantage of using LLDP is that VLAN settings are determined at 

power up and do not rely on parameters stored in the phone, this 

removes the risk of the phone downloading a configuration that is invalid 

for the network it is connected to. 

When LLDP is enabled the phone broadcasts an LLDP request on power 

up and then at the defined Packet Interval. The default period is 120 

seconds.  

24.1.8.4 VLAN Configuration Examples 

The following examples relate to manually defining the VLAN settings via 

the Device Profile.  

• Tagged Voice VLAN, Untagged Data VLAN - For many deployments 

that use VLAN tagging, packets related to the voice VLAN will be 

tagged and those related to the data VLAN will be untagged and 

treated as part of the native VLAN by the access switch. For the 

configuration shown below the Voice VLAN ID is 10 and the Data 

VLAN is untagged.  
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• Tagged Voice VLAN, Tagged Data VLAN – For the case where both 

voice and data packets are tagged as they egress and ingress at the 

LAN port the phone must have VLAN’s enable for both the LAN and 

PC ports. For the configuration shown below the Voice VLAN ID is 

10 and the Data VLAN ID is 15. 

 

24.1.9 Keys Tab 

The Keys tab contains setting related to the 6 programmable keys.  

The key settings defined in a device profile are applied to all phones 

assigned the profile. Keys settings may be modified on a per phone basis 

by clicking the Key Provisioning button in the Edit Device screen, see 

section 24.1.11.  
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24.1.9.1 Label Template  

The phone includes 3 pre-printed labels to cover common deployment 

scenarios. Select the template from the dropdown which matches the 

label installed on the phone. When one or more of the keys are changed 

from that defined by the selected template, the Label template dropdown 

will display Custom. Any key may be modified as required to suit the 

requirements of the deployment. 

Label #1 – 3 Line keys, Page, Intercom (Factory installed label) 

 

 

Label #2 – 2 Line keys, Page, Park Slots 
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Label #3 – 2 Line keys 

 

 

24.1.9.2 Type 

Select the type of key. Available options are: 

• BLF: Defines a Busy Lamp Field (BLF) key to monitor a User or Call 

Group extension. Value is the extension number to monitor. Line 

determines the SIP registration that the BLF is associated with.  

The LED will flash when the monitored extension is ringing, 

pressing the flashing key will pick-up the ringing call. When the 

monitored User is on a call the LED will be solid red. Pressing the 

key when the LED is off initiates a call to the defined extension 

number.  
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Prefixing the extension number value with ‘+’ will enable Hold 

indication on the key such that when the monitored user places a 

call on hold the LED will flash. Refer to KBS issue 11179 for further 

information about ‘+BLF’. 

System wide maximums for key types that utilize BLF mechanism: 

o Maximum of 500 to 600 per system 

o Maximum of 64 stations monitoring the same extension 

• BLF (Monitor only): This key functions the same as ‘BLF’ with the 

exception of call pick-up. Pressing the key when it is flashing will 

not pick-up the ringing call. 

o This key type is included in the BLF count for the system 

• Intercom: Facilitates an intercom call to a user extension. The 

called phone will automatically answer (if configured to do so in the 

profile) and a two-way conversation is established.  

Usage: Press key, display indicates Dial: Intercom. , enter the target 

extension number followed by # Send. 

• Line: Defines a call appearance key for a specific SIP line 

registration. Value is the SIP line associated with the key, for most 

deployments this will be 1. As an example if 3 keys are configured 

as Line for Line #1, the user will have 3 call appearance keys for SIP 

registration 1. At least one key must be configured as type Line, up 

to 6 keys may be configured as type Line. 

• Login (Call Group): Allows the defined user to log into a defined 

Call Group (Operator/ACD/ICC) by pressing the key. Value must be 

in the format of <group>.<user>, where <group> is the Call Group 

extension number and <user> is the extension number of the user 

to be logged into the Call Group.  

Usage: When the button is pressed the user will be prompted to 

enter their voice mail password (also referred to as PIN), if the 

correct password is entered the call will be terminated and the LED 
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will become solid red. Pressing the key again will log the user out 

of the Call Group and the LED will turn off. 

o This key type is included in the BLF count for the system 

• Mailbox MWI: Monitors the voice mailbox of the configured 

extension number. Value is the extension number of the mailbox 

to be monitored, it may be a User or Call Group extension number. 

The LED is solid red when there is one or more unread voice mail 

messages. For user extensions only the LED will flash when a caller 

is currently leaving a message, pressing the flashing LED will 

retrieve the caller. Pressing the key when either off or solid red will 

access the associated mailbox and prompt for password. 

o This key type is included in the BLF count for the system 

• MX-E Conference: Provides access to MXconference service to start 

or join an MXconference call. MX-E system must have 

MXconference licenses. 

• MX-assist: Provides access to the MXassist automated attendant 

service which provides help to users. To use this feature an 

Automated Attendant with the name ‘MXassist’ must be configured 

on the system.  

• None: Programmable key is disabled. 

• Page: Facilitates a call to a paging group. Care should be taken to 

ensure the number of ZIP 33i and ZIP 5-series phones in a paging 

group does not exceed 16 devices on an MX-E.  

Usage: Press key, display indicates Dial: Page., enter the paging 

group number followed by # Send. After the prompt or tone begin 

your page. 

• Page/Intercom: Dual purpose key that facilitates a page call to a 

paging group or an intercom call to an extension depending upon 

the number entered.  Refer to Page key section above for additional 

details about paging. 

Usage: Press key, display indicates the Page Server extension 
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number (generally *4), for a paging call enter a 2 digit paging 

group extension number followed by # Send, for an intercom call 

enter the target user extension (must be 3 digits or longer) 

followed by # Send. 

• Park Slot (Monitored): Monitors a Park Slot, also referred to as a 

Park ID. In the Value field dropdown select the Park ID to monitor. 

When a call is currently parked at the monitored ID, the related key 

will flash red on all phones configured to monitor the same ID. 

Pressing the flashing key retrieves the parked call. When on a call 

pressing the key will park the call to the associated park ID. 

o This key type is included in the BLF count for the system 

• Prefix: The Prefix key is similar to a speed dial key, when pressed 

the screen will display the Prefix Value, the user may then enter 

additional digits followed by # Send to initiate a call to the 

complete number. 

• Speed dial: When pressed the phone initiates a call to the 

number/URI defined in the Value field. 

 

24.1.9.3 Value 

Where a key requires additional parameters such as an extension number 

this is entered into the Value field. Refer to the Key descriptions above 

for additional information.   

24.1.9.4 Line 

This parameter determines the SIP Line registration that the key is 

associated with. Possible selections are 1, 2 and Auto. For most 

deployments the Line setting will be 1 for keys that allow selection of the 

line number. For keys where the Auto selection is selected the phone will 

automatically select the SIP Line to use based on the call scenario. For key 

types Intercom, Page, Page/Intercom and Prefix the Line setting is always 

Auto. 

 



 

 MX-E Installation Manual (PN:0000507) Revision 11 February 11, 2019 
© 2019 Zultys, Inc. No reproduction or distribution without permission 

Page 181 of 350 

Technical Publications 

24.1.10 Advanced Tab 

The Advanced tab provides a view of the data that will be stored in the 

device specific <MAC>.cfg file when a device is provisioned with this 

Device Profile. In addition the screen provides the ability to add custom 

configuration data for phone options that are not exposed in the Device 

Profile GUI. Custom configuration data must be entered with the correct 

syntax including section headings. Parameters entered in the Custom 

screen will generally over-ride the same parameter defined in the system 

generated configuration data. In the event that custom settings are 

required Zultys Technical Support will advise the correct format for the 

settings. 

 

 

 

24.1.11 Adding a Device 

Once a ZIP 33i Device Profile has been created, one or more phones may be 

provisioned on the MX-E system.  

To add a ZIP 33i Device (phone) in MX-E Administrator:  
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1. Select Configure → Devices or click the Managed Devices icon . 

2. Right click in the Managed Devices screen and select Insert, 

alternatively press the Insert key on keyboard.  

3. In the New Device screen set the Device Type to ZIP 33i and press 

Next. The Add multiple devices option allows for multiple phones 

to be added via a list of MAC addresses. This document only covers 

the Add single device process.  

 

 
 

4. In the New ZIP 33i Device screen, select the Profile, Default 

Location and enter the MAC Address of the phone being 

provisioned. The Device ID by default will be set to the MAC 

address, uncheck Use MAC if an alternative Device ID is to be used. 

The Screen Name will be displayed on the idle screen of the phone, 

if left blank the Device ID will be displayed. 
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5. SIP Proxy Password: If the phone is to be deployed externally a SIP 

Proxy Password must be set, the same password must be manually 

entered into the phone either via the Telephone User Interface (TUI) 

or the phones webpage. Once the phone has downloaded its 

configuration file perform the following steps to store the SIP 

password in the phone: 

a. Via phone user interface: Press Menu, 3-Settings, 2-

Advanced, enter admin password for phone (default is 

‘admin’), 1-Accounts, select line to configure (usually Line 1), 

then press Tick key, arrow down to ‘Password’, type in SIP 

password and press Tick to accept, press Menu until back at 

idle screen.  

b. Via web interface: Obtain the IP address of phone by pressing 

the Tick key while phone is displaying Idle screen. Browse to 

the IP address of phone. Select Account tab, from the 
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Account dropdown select the Account to be edited (usually 

Account 1). In the Password field enter the SIP password. 

Press Confirm at the bottom of the screen to save the setting.  

6. Key provisioning: If the Programmable Key settings defined in the 

Device Profile are to be customized for this device click Key 

provisioning and adjust the key settings as required. 

7. Advanced Options: The Advanced Options screen allows custom 

configuration data to be added to the device specific configuration 

file. Generally there is no requirement to do so. 

8. Press Finish then Apply to save the device configuration 

information to the MX-E system. The <MAC>.cfg file will be 

automatically created and stored on the TFTP server. 

9. Depending on the Provisioning option selected (refer to section 

24.1.6.3) and network configuration, when the phone is connected 

to the network and powered up it will automatically download its 

configuration file and register. 

24.1.12 Fixed function keys 

To facilitate easy access to common functions, the ZIP 33i phone has a range of 

dedicated function keys. A brief explanation of these keys appears below. 

Please refer to the ZIP 33i User’s Guide for detailed information. 

Menu – Access the phone features and settings menu 

DND – Enable / Disable Do Not Disturb. When enabled, any call offered to 

the phone will be rejected with a 486 BUSY response. 

Park – Access the Park/Pickup feature. Pressing the Park key during an 

active call results in the call being parked and the system allocated Park 

ID being displayed on screen. Pressing the Park key when the phone is 

idle or off hook but not on an active call prompts the user to enter a Park 

ID to retrieve a parked call. Press # Send to initiate call after entering ID. 

Directory – Provides access to the local directory stored on the phone. 
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Call Log – Provides access to the call log of the phone. When pressed the 

“All calls” list is displayed, left and right cursor keys switch between all, 

missed, inbound, outbound and forwarded call logs. 

X / End Call – When a call is active pressing this key disconnects the call. 

The key also acts as a delete key when entering information and a cancel 

or back key during menu operations. 

Message – Provides access to the voice mail service of the MX-E system. 

Also acts as Message Waiting Indicator (MWI). Key is illuminated green 

when one or more unread voice mail messages are available for the user. 

The red status LED of the phone will also flash when an unread voice mail 

message is present. 

Headset – Enables headset mode. When illuminated green the headset 

mode is active and calls answered via the line keys or MXIE will utilize the 

headset. In addition pressing the key while an incoming call is ringing will 

answer the call and route the audio to the headset. Optional headset 

must be connected. 

Conference – Facilitates setup of local 3 way conference calls.  

Usage: Press Conference during an active call. The call will be placed on 

hold. Enter the number of the second party and then press # Send. Press 

Conference again when the second party answers. All parties are now 

joined in the conference. Note: To conference two existing calls, place 

one call on hold then press Conference while the other call is active. 

Hold – When a call is active pressing this key places the call on hold. 

Press again to retrieve call. 

Mute – Enable/disable the microphone during an active call.  

Transfer – Facilitates call transfer operations. 

Usage:  

o Blind Transfer: Press Transfer during an active call. The call is 

placed on hold. Enter the number you want to transfer to. Press 

Transfer. 
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o Attended Transfer: Press Transfer during an active call. The call 

is placed on hold. Enter the number you want to transfer to and 

then press # Send. Press Transfer when ready to complete the 

transfer or X key to cancel transfer. 

Redial – Facilitates redialing of recently called numbers.  

Usage: Press Redial to enter the Dialed Calls list, press Up or Down keys 

to select the desired call and then press Redial or # Send. To access other 

areas of the Call History use Left and Right keys.  

Press Redial twice when the phone is idle to call the last dialed number. 

Speaker – Press the Speaker key when a call is ringing to answer in 

handsfree mode.  

24.1.13 Controlling Configurations  

24.1.13.1.1 Configuration methods 

The ZIP 33i phone may be configured via the following methods:  

• As a managed device in MX-E Administrator (The method detailed in this 

document) 

• Web interface of phone 

• Menu of phone 

Provisioning a phone as a managed device on the MX-E system automatically 

generates a configuration file on the MX-E’s TFTP server with the name 

<MAC>.cfg. For example for phone with MAC address 000BEA81B8B8, the 

filename is 000bea81b8b8.cfg. 

Any manual configuration changes performed via the web interface or the menu 

of the phone will take precedence over the configuration options defined in the 

configuration file downloaded from the MX-E TFTP server.  

If a phone has been manually configured via the web interface or phone menu, 

the phone must be Factory Reset to fully restore automatic provisioning. Refer 

to section 24.1.15.1.1.  
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24.1.13.1.2 Phone Initialization 

Upon power-up a new or un-configured phone will initialize as follows: 

• Request IP address and Option 66 (TFTP server address) from DHCP 

server. 

• Request zip33i_common.cfg file from TFTP server.  

• Request <MAC>.cfg file from TFTP server. 

• Request new firmware ROM image file from TFTP server if defined in 

cfg file. 

• Complete power-up and register with MX-E system based on settings 

defined in cfg files. 

The zip33i_common.cfg file referred to above may be used to apply custom 

configuration settings to all ZIP 33i phones connected to an MX-E system. 

Generally there is no requirement to use this file. 

24.1.14 Upgrading Firmware 

24.1.14.1.1 Upgrading firmware via Device Profile 

When a ZIP 33i is provisioned as a managed device via MX-E Administrator, the 

firmware version of the phone is determined by the Firmware filename defined 

in the Device Profile. The corresponding firmware ROM file must be uploaded to 

the TFTP server of the MX-E system. Firmware ROM files are available for 

download the Zultys Knowledge Base System (http://kbs.zultys.com).  

To upgrade/change the firmware version of a ZIP 33i phone perform the 

following steps: 

1. From Configure → Devices screen press the  button.  

2. Copy the <version>.rom file (EG: 60.61.132.8.rom) to the TFTP server. 

Press Close. Note: All ZIP 33i firmware image files have the format 

60.x.x.x.rom (EG: 60.61.132.8.rom). 

3. Open the Device Profile associated with the Device that is to be updated. 

4. In the filename field located on the General tab select the filename of file 

uploaded in step 2. 

 

http://kbs.zultys.com/
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5. Press OK then Apply to save changes to MX-E.  

6. Select the device to be updated from the device list. Multiple devices may 

be selected via standard Windows Shift+Click and Ctrl+Click keyboard 

controls. 

7. Click the  button to send the update request to each phone 

that is currently registered to the MX-E system.  

8. Alternatively power cycle or power up each phone to trigger a firmware 

update. 

9. Once complete the firmware version may be checked via the User Agent 

field of View → Device Status screen.  

 

24.1.14.1.2 Upgrading firmware via Web interface 

For cases where the phone is not provisioned as a managed device or cannot 

access the TFTP server, the firmware may be updated via the phones web 

interface.  

To upgrade the firmware via the web interface of phone perform the following 

steps: 

1. Browse to the IP address of the phone. The IP address may be found by 

pressing the Tick key at the idle screen. 

2. Enter the username ‘admin’ and the administration password, default 

password is ‘admin’. 

3. From the top menu select the Phone tab. 

4. From the left menu select Upgrade. 
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5. Select Browse and browse to the ROM file, then select Open. 

6. Select Upgrade. To proceed with upgrade press OK on the warning 

popup. 

7. Do not disconnect power or exit webpage until the phone has restarted.  

8. Once the upgrade is complete the webpage will be refreshed (assuming 

the IP address of the phone has not changed during restart).  

9. The current firmware version is displayed on the Phone → Upgrade 

webpage and also on the Status webpage. 

Note that if after the upgrade the phone downloads a configuration file that 

defines a different firmware version, the phone will immediately upgrade to the 

version defined in the configuration file.  

Warning: Once the download process for the new firmware starts you must not 

disconnect power or restart the phone. If the process is interrupted, the phone 

will lose all firmware and the emergency recovery process will need to be 

performed. Contact your Authorized Zultys Channel Partner or Zultys Technical 

Support should this situation arise. 

24.1.15 Troubleshooting Tips and Tools 

24.1.15.1.1 Factory resetting phone 

Should an invalid configuration be downloaded to or set on the phone it may be 

necessary to perform a factory reset. Resetting the phone to factory defaults 

removes all configuration settings from the phone including those applied via 

the web interface and menu of the phone. 

Steps to Factory Reset a phone: 

• Press Menu 

• Select 3-Settings 

• Select 2-Advanced  

• Enter Admin password. Default password is ‘admin’ 

• Select 4-Reset Factory 

• Screen will display Reset to Factory?, press Tick key to proceed with 

reset. Screen will display Please wait Reset.. 

• Phone will now perform initialization per section 24.1.13.1.2.   
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24.1.15.1.2 Phone does not use the configuration file on TFTP server 

If the ZIP 33i phone does not use the configuration file, or some settings 

defined in the configuration file do not appear to be used, check the 

following:  

• Make sure you have not previously configured the phone using the 

web interface or the phone interface. Any option manually configured 

from the web interface or the phone interface will take precedence 

over the values contained in the configuration file downloaded from 

the TFTP server. 

• Make sure the MAC address defined in MX-E Administrator matches 

the MAC address of the phone. To check the MAC on the phone press 

the Tick button while the idle screen is displayed, then press the Down 

arrow to display MAC address.  

• Confirm the DHCP Server is providing the IP address of the TFTP server 

in Option 66. If Option 66 is not being used the phone must be 

manually configured with the provisioning server address. 

• Phone was previously configured via the web or phone interface. 

o Reset the phone to factory defaults and configure using a 

configuration file from the MX-E. 

24.1.15.1.3 How to check if configuration file is downloaded 

A simple way to confirm if a phone is downloading its configuration file is to 

change the Screen Name set in the Edit Device screen. Apply the change 

then power cycle the phone. If the screen name displayed on the phone 

changes to the new value defined via MX-E Administrator then the phone is 

correctly downloading the configuration file from the MX-E system. 

24.1.15.1.4 Performing network packet capture on the phone 

The ZIP 33i phone has the ability to perform a packet capture in pcap format 

which is compatible with Wireshark. To facilitate a packet capture perform the 

following steps: 

1. Browse to the IP address of the phone. The IP address may be found by 

pressing the Tick key at the idle screen. 
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2. Enter the username ‘admin’ and the administration password, default 

password is ‘admin’. 

3. From the top menu select the Phone tab. 

4. From the left menu select Upgrade. 

5. In the PCAP Trace section click . 

6. To stop the packet capture click . 

7. To export the captured information click  and save the file to an 

appropriate location. 

8. The file may now be opened in Wireshark or similar packet analysis 

applications. 

24.1.15.1.5 Capturing Syslog information 

The ZIP 33i phone has the ability to generate Syslog information that may assist 

Zultys Technical Support with investigation of issues. This information may be 

stored locally on the phone or output to an external Syslog server. If instructed 

to do so you may enable the Syslog feature by one of the following methods: 

24.1.15.1.6 Capturing Syslog information locally on phone 

1. Browse to the IP address of the phone. The IP address may be found by 

pressing the Tick key at the idle screen. 

2. Enter the username ‘admin’ and the administration password, default 

password is ‘admin’. 

3. From the top menu select the Phone tab. 

4. From the left menu select Configuration. 

5. Set Export System Log option to Local. 

6. Set SystemLogLevel to the value requested by Zultys Technical Support. 

The higher the number the more detailed the information captured. 

7. Press  to accept changes. 

8. To save stored events click  and select a location to save 

file to. 

24.1.15.1.7 Enabling Syslog output to external server via web interface 

This setup requires an external syslog server, it is assumed the system 

administrator has setup a suitable syslog server. 

 

http://www.wireshark.org/
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1. Browse to the IP address of the phone. The IP address may be found by 

pressing the Tick key at the idle screen. 

2. Enter the username ‘admin’ and the administration password, default 

password is ‘admin’. 

3. From the top menu select the Phone tab. 

4. From the left menu select Configuration. 

5. Set Export System Log option to Server. 

6. Enter the IP address of the external syslog server in the Server Name 

field. 

7. Set SystemLogLevel to the value requested by Zultys Technical Support. 

The higher the number the more detailed the information captured. 

8. Press  to accept changes. 

9. The phone will now send Syslog messages to the configured Syslog 

server address. 

24.1.15.1.8 Enabling Syslog output to external server via configuration file 

This setup requires an external syslog server, it is assumed the system 

administrator has setup a suitable syslog server. 

 

1. Create a new Device Profile to be used by the phone under test. Generally 

the easiest way to do this is by creating a duplicate of the current profile. 

2. On the Advanced tab of the Profile select Custom configuration data. 

3. Enter the following custom configuration parameters -  

 

[ cfg:/phone/config/system.ini,reboot=0 ] 

SYSLOG.SyslogdIP = 192.168.1.100 

[ cfg:/phone/config/user.ini,reboot=0 ] 

PhoneSetting.LogLevel = 5 

 

Replace the IP address with the address of your external Syslog server. 

Set the LogLevel to a value between 1 and 6 as advised by Zultys 

Technical Support. 

4. Press OK then Apply to accept the Profile changes. 

5. Assign the Profile to the device under test. 
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6. Select the device in the device list and press Update to trigger the phone 

to download the new configuration file. 

7. The phone will now send Syslog messages to the configured Syslog 

server address. 

Once the required syslog information is captured the phone should be returned 

to the default settings of Local and Level 3. 

24.1.16 Emergency Recovery Mode 

In the event that the phone is unable to initialize following a failed firmware 

upgrade due to power loss or similar, it may be possible to use the Emergency 

Recovery Mode to reload the firmware.  

For assistance with this process please contact your Zultys Authorized Channel 

Partner or Zultys Technical Support. 

25. Adding Devices – ZIP2x2 

25.1 Add the device as a Managed Device 

In the MX-E Administrator, go to Provision → Devices, a table of devices 

already assigned to the system.  On the table right click and choose 

Insert. 
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Choose a device type from the drop down 

 

 

 

And click Next>>. 

 

If no profile is defined it will warn you that you need to create one. 
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To create a profile click Create a profile now. 

25.2 Create a profile 

 

Click on the create profile now button, and assign it a name. 

 

 

 

Once a name is given the profile screen is displayed. 

 

 

 

25.2.1 General Tab 

 



 

 MX-E Installation Manual (PN:0000507) Revision 11 February 11, 2019 
© 2019 Zultys, Inc. No reproduction or distribution without permission 

Page 196 of 350 

Technical Publications 

On the general tab the following fields are given 

• Software Version: This is the software version that the phone is 

running. To upgrade the firmware on a Zip 2xN phone you must 

update this field with the version of choice. 

• Password: This parameter specifies password required to change the 

protected settings. Valid passwords contain four to fifteen numeric (0-

9) digits. Default password is 985897. If you change the password on 

the phone and also specify the password in the configuration file, the 

next time the phone boots up (or is sent an update request) it will take 

the password from the configuration file. The password in the 

configuration file therefore overwrites whatever was in the phone. If 

you do not want to overwrite whatever is in the phone, leave the 

password field blank. The configuration file then does not overwrite 

the password stored in the phone. 

• LCD Contrast: The parameter alters the contrast of the LCD at the top 

of the phone. Valid settings range from 1 to 20; default value is 7. 

• Greeting Message: This is the message that the top row of the LCD 

displays when the phone is idle. This parameter is not available on the 

ZIP2x2L, ZIP2+, and ZIP2P. These phones do not support a greeting 

message. 

• Event Timer: Specifies the duration, in seconds, that some error 

messages and information screens are displayed on the LCD. Valid 

settings range from 2 to 10. Default value is 2. 

• Reject Instant Messages: When set, this parameter programs the 

phone to reject all incoming instant messages. 

• Domain: This parameter specifies the domain in which the phone 

resides. Used for manual configuration when DHCP is not enabled or 

the DHCP server does not return the domain (DHCP option 15). 

• Send Syslog event when device is not registered with the MX-E: Select 

this option to program the MX-E to generate a Syslog event when a 
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device with this profile is not registered with the MX-E. The parameter 

does not affect the operation or configuration of the phone. 

• Allow Location to be specified on the phone: Select this option to 

allow users to specify their MX-E location from the phone. 

• Disable DND: Select this option to disable the DND button on the 

phone. 

• Auto-answer Intercom calls: Select this option to allow users to 

intercom the phone. 

25.2.2 Regional Tab 

 

• Country: Specifies the call progress tones used by the phone, as defined 

by country variation. 

• Time Format: This parameter specifies the format used by the LCD to 

display time. 

• Date Format: This parameter specifies the format used by the LCD to 

display the date. 

• Language: This parameter specifies the language that the phone uses to 

display phone settings on the LCD. 
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• Date and Time: This parameter specifies the display order of the date and 

time on the LCD. 

• Number Format: This parameter specifies the calculator format settings 

for the decimal point and thousands delimiter. 

25.2.3 Audio tab 

 

• Distinctive Ringing: When enabled, this parameter specifies the use of 

different ring tones for internal and external calls. 

• Key Click: This parameter specifies the tone that the phone emits when 

you press a button or a non-numeric key. 

• Hold Reminder Tone: This parameter specifies the tone that the phone 

plays when it has a call on hold. This tone is played once every 30 

seconds. 

• Internal Ring Tone: This parameter specifies the ring tone for calls 

received from phones inside the enterprise. 

• Custom Internal Ring: This parameter specifies the file that provides the 

call waiting tone for internal calls when External Ring Tone is set to 

custom. 
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• External Ring Tone: This parameter specifies the ring tone for calls 

received from phones outside the enterprise. 

• Custom External Ring: This parameter specifies the file that provides the 

call waiting tone for external calls when External Ring Tone is set to 

custom. 

• Internal Call Answer: This parameter programs the phone to 

automatically go off hook for internal calls after one ring. Select Auto 

Answer to route the call through your external speaker. Select Auto 

Answer Hook to route the call through your headset. Select Ring Phone to 

play the internal ring tone until you take the phone off hook or a system 

call handling routine sends the call to an operator or your voice mail. 

• External Call Answer: This parameter programs the phone to 

automatically go off hook for external calls after one ring. Select Auto 

Answer to route the call through the external speaker. Select Auto 

Answer Hook to route the call through the headset. Select Ring Phone to 

play the external ring tone until you take the phone off hook or a system 

call handling routine sends the call to an operator or your voice mail. 

• MXIE Call Answer: This parameter programs the phone to automatically 

go off hook after one ring for outbound calls that you dial from MXIE. 

Select Auto Answer to route the call through your external speaker. Select 

Auto Answer Hook to route the call through your headset. Select Ring 

Phone to play the internal ring tone until you take the phone off hook. 

• Call Disconnect: This parameter programs the phone behavior after the 

other party disconnects a call. Select Busy Tone to program the phone to 

play a busy tone for five seconds after the other party disconnects from a 

phone call. Select Busy Tone Timeout to program the phone to play a 

busy tone for five seconds after the other party disconnects from the call. 

Select Silent to program the phone to disconnect the phone without 

playing any tone. 

• Sound URL: This parameter specifies the http directory location for files 

that define custom ring tones. Valid setting is http://<name of 

directory>. 
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• Codec: This parameter specifies the speech encryption standard (G.711 

or G.729) and companding method used by the configured phones. This 

parameter is not available on the ZIP2x2L, ZIP2+, and ZIP2P. 

• Second Call Tone: This parameter specifies the call waiting tone that is 

played when you are talking on the phone and the phone receives 

another call. This parameter is not available on the ZIP2x2L, ZIP2+, and 

ZIP2P. 

• Custom Second Call Tone: This parameter specifies the file that provides 

the second call tone when Second Ring Tone is set to custom. This 

parameter is not available on the ZIP2x2L, ZIP2+, and ZIP2P. 

• Startup Tone: This parameter specifies the tone that the phone emits 

when the phone is powered. 

• Encryption: This parameter specifies the encryption mode for phones 

configured by the profile. This parameter is not available on the ZIP2x2L, 

ZIP2+, and ZIP2P. 

25.2.4 IP Tab 

 

• DHCP: When this parameter is selected, phone uses DHCP to configure 

network settings: IP address, subnet mask, domain name, default 

gateway, DNS servers, NTP server address, and TFTP server address. 
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• Subnet Mask: This parameter is used for manually configuring the phone 

when DHCP is not enabled.  

• Default Gateway: This parameter is the IP address of the gateway that is 

used for manual configuration when DHCP is not selected or DHCP does 

not provide the default gateway (DHCP option 3). 

• Primary DNS: This parameter is the IP address of the primary DNS Server. 

Used for manual configuration when DHCP is not selected or DHCP does 

not return DNS Server (DHCP option 6). 

• Secondary DNS: This parameter is the IP address of the secondary DNS 

Server that is used for manual configuration when DHCP is not selected 

or DHCP does not return a valid address. 

• NTP Server: This parameter is the IP address of the NTP server used for 

manual configuration when DHCP is not enabled or DHCP does not return 

NTP server (DHCP option 42). 

• TFTP Server: This parameter specifies the source of the TFTP Server 

Address. Select Obtain from DHCP to automatically receive the address 

from the DHCP server; the DHCP option must be selected to use this 

option. To specify a fixed TFTP address, select the second radio button 

and enter an IP address in the data entry box. 

• STUN Server: This parameter specifies the IP address of the STUN server. 

This parameter is not available on the ZIP 2x2L, ZIP 2+, and ZIP 2P. 

• STUN Port: This parameter specifies the port number of the STUN server. 

Valid settings range from 1025 to 65535. This parameter is not available 

on the ZIP 2x2L, ZIP 2+, and ZIP 2P. 

• DSCP: This parameter is the Layer 3 QoS setting. This value is placed in 

the ToS byte of the IP header of all voice packets sent from the phone’s 

microprocessor if VLANs are enabled. 



 

 MX-E Installation Manual (PN:0000507) Revision 11 February 11, 2019 
© 2019 Zultys, Inc. No reproduction or distribution without permission 

Page 202 of 350 

Technical Publications 

25.2.5 SIP Tab 

 

o Registration Expires: This parameter specifies the time period, in 

seconds, after which a REGISTRATION expires. 

o Subscription Expires: This parameter specifies the time period, in 

seconds, after which a SUBSCRIPTION expires. 

o Proxy Source: This parameter specifies the source for the Proxy Address. 

▪ External Address: Proxy address set to IP Address (main) in IP 

Address panel of System Settings window. 

▪ Specified: Proxy address is entered in data entry box. 

▪ Domain: Proxy address set to Default Domain in Company panel of 

System Settings window. 

o Proxy Address: This parameter specifies the IP address of the SIP proxy 

server that will be used by the phone. 

o Proxy Port: This parameter is the port of the SIP proxy that is used by the 

phone. Valid settings range from 1025 to 65535. Default value is 5060. 

o Register with Backup Proxy: When this checkbox is selected, the phone 

registers with backup proxy at startup. 
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o Backup Proxy: This parameter is the backup SIP server proxy address 

value. If primary proxy server fails to operate, the phone attempts to 

switch to the backup proxy. 

o Backup Proxy Port: This parameter is the backup SIP server proxy port 

value. Valid settings range from 1025 to 65535. 

o Backup Registration Expires: This parameter specifies the time period, in 

seconds, after which a REGISTRATION with the backup proxy server 

expires. 

o Registrar Source: This parameter specifies the source for the Registrar 

Address. 

▪ External Address: Registrar address set to IP Address (main) in IP 

Address panel of System Settings window. 

▪ Specified: Registrar address is entered in data entry box. 

▪ Domain: Registrar address set to Default Domain in Company panel 

of System Settings window. 

o Registrar Address: This parameter is the SIP registrar server address. 

When this value is set, phone attempts to register with this server instead 

of proxy. 

o Registrar Port: This parameter is the SIP Registrar server port. 

o RTP Starting Port: This parameter specifies the starting port number for 

RTP/RTCP transmissions. Valid settings range from 1026 to 64528. The 

starting port must always be an even number and should not be set to 

same value as phone SIP port or the proxy port. 

o Invite Retransmissions: This parameter specifies the number of 

unsuccessful INVITE retransmissions before phone switches to backup 

proxy. Valid settings range from 1 to 6. 

o Non-invite Retransmissions: This parameter specifies the number of 

unsuccessful retransmissions (other than INVITE) before the phone 

switches to backup proxy. Valid settings range from 1 to 10. 
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o Accept INVITE with URL not matching IP Address: This parameter instructs 

the phone to accept INVITE requests that specify a destination other than 

that of the phone. 

o Allow Paging to Interrupt Active Calls: This parameter instructs the phone 

to play an incoming page message even during an active call. 

o Use DNS Srv: This parameter configures the phone to resolve the SIP 

Proxy IP address through DNS SRV records. 

25.2.6 VLAN Tab 

 

• VLAN Support: Selecting this checkbox enables VLAN support within the 

ZIP2x2. 

• Class of Service (CoS): This parameter configures the Class of Service 

(CoS) at layer 2 for the phone port. Valid if phone port is defined as a 

tagged member of VLAN A. Values range from 0 to 7. 

• VLAN Table: This table specifies the VLAN ID and inclusion status of the 

two phone circuits (one circuit in the ZIP 2x1, ZIP 2P, and ZIP w+) for 

VLAN A through VLAN H.  

• VLAN ID column: Enter the VLAN ID for the specified VLAN in this data 

entry box. 
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• VLAN Tagging columns: Enter the inclusion status of the specified circuit 

for the VLAN in this data entry box. 

25.2.7 NAT Specific Notes 

When using the ZIP2xN phone as a NAT phone you are required to use a 

SIP Proxy Password, and this must be set up in the Profile and manually 

set in the phone as it is not part of the configuration file for security 

reasons. 

 

25.2.7.1 Setting SIP Proxy Password in the MX-E 

In the device manager, edit the device and enter in a SIP Proxy Password 

 

 

25.2.7.2 Setting the SIP Proxy Password in the ZIP2xN 

From the web interface of the ZIP2xN, click on Protected Settings in the 

navigation menu then choose SIP Communications and enter the 

password in the Proxy Password Field. This will require a reboot of the 

ZIP2xN. 
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26. Adding Users 

The process of adding users requires three steps:  Adding the users, adding 

their devices, and matching the user with their phone (Assignment).  Along the 

way, there are two methods of adding users: one at a time, or importing a list 

of users. 

The process of adding users requires three steps:   

• Adding the users and their profiles 

• Adding their devices and their profiles 

• Assignment (matching the user with their phone) 

• Along the way, there are two methods of adding users:  

– one at a time 

– importing a list of users 

 

26.2 Adding a user to the System: 

User can be added to a system in two ways.  You can add a user one at a time, 

or you can import them from a CSV file. 
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26.2.1 Creating Profiles: 

There are four types of Profiles.  User profiles are used to determine the 

privileges that the group of users assigned to the profile will have.  

Administrator Profiles, which are used to create various levels of Administrators 

that may or may not have access to various function. Paging Group Profiles 

which are used to map various paging zones (configured in the services 

window) to people that will receive the pages.  And Recording Profiles which are 

used to configure the Call recording values of the group.  After the profiles are 

created, users will be assigned to the various profiles. 

26.2.1.1 Modifying the Default Profile 

The MX-E comes with one profile – this profile is called “Default”. 

• From the Configure → Users window, click on the Profile button on the 

bottom of the screen. 

• Click on the Default Profile: 

This allows you to review or modify the “default” settings.  

Note:  Enabling MXIE requires a MXIE license for each member of this Group. 

Several other options require licenses such as CRM Integration, Exchange 

Integration, Desktop Integration and others. You will be notified if you are 

missing or exceed the number of licenses. 
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26.2.1.2 Creating a user profile 

A User Profile is used to enable or disable various functions for users assigned 

to that group.  Among the functions that are controlled by a profile are 

Password, Membership in a Pickup Group, Voicemail, On-Demand Call 

Recording, ability to register unmanaged devices, and if you want your DID 

number sent as your Calling Party Number. 

• From the “Configure” → “Users” window click on the “Profiles” button 

• Right click in the white box and select “New” 

• Enter a Name for this new user profile 

• Set the default password  

• Set any options 

• Then click “OK” and “Apply”. 

 

 

26.2.1.3 Creating an Administrator Profile 

The MX-E allows you to create a wide range of Administrator Profiles.  These 

profiles, once assigned to a user, will allow a user access to specific 

administrative functions while denying them access to other functions.  An 

example of the function would be to create a profile for HR where they could 

add users, devices, assign users to devices, while denying them access critical 

system settings that may cause the system to restart. 
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1. From the “Configure” → “Users” window click on the “Profiles” button 

2. Click on the Administrators Tab 

3. Either right-click and select New or press the Insert key on the keyboard.  

4. Create a new profile name 

5. Assign properties to the newly created profile: 

6. Click on OK 

 

26.2.1.4 Creating Paging Profiles 

Paging profiles allow the user to send and receive pages sent to one or more 

paging zones. Before creating a paging profile a paging group must be created 

in Configure → Phone Services → Paging Groups. 

From the “Configure” → “Users” window click on the “Profiles” button, Click on 

the Paging Tab. Either right-click and select New or press the Insert key on the 

keyboard.  

 

The parameters on the upper right side of the panel configure paging rights for 

the users that are assigned to this profile. Data entry boxes display parameter 

settings for the highlighted profile in the Profile List. 
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• Require Validation: When this parameter is enabled, the MX-E requires 

that users assigned to this profile enter their extension and password 

before being allowed to page. This feature is not supported at this time. 

• Page phones with active calls: When enabled, pages initiated by users 

assigned to this profile are sent to all users in the paging group, 

including those that are on an active call. This feature is not supported at 

this time at a global level, but can be implemented at a device level. 

• Maximum paging announcement: This parameter determines the 

duration of the longest page that can be sent by users assigned to this 

profile. Valid parameter settings range from 0 to 999 seconds; 10 

seconds is the default value.  

 

26.2.1.5 Paging Group Table 

This table determines the paging group membership for users assigned to this 

active profile. 

 

• Paging Group column lists each Paging Group defined in the Configure → 

Phone Services → Page Groups window.  

• Member assigns paging group membership to the users to which this 

profile is applied. Each user can be assigned to more than one paging 

group. 

• Can Page authorizes users assigned to this profile to page the selected 

paging groups. A user does not need to be a member of a paging group 

to have authorization to page the group. 
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26.2.1.6 Creating Call Recording Profiles 

Call Recording profiles allow the user have their calls automatically recorded, or 

manually select which calls are recorded using the “record” button in MXIE 

during an active call. Call Recording Profiles also provide access restriction to 

the recorded calls. 

• Creating an Call Recording Profile: 

o From the Profiles window, select the Call Recording Tab. 

o Right-Click and select new 

o Name the profile  

o Configure the Following Settings: 

▪ Personal Calls 

• Call Recording on demand: all calls will have the option 

to be recorded, if the user click the “record” icon in 

MXIE (Call Recording License is required) 

• Automatic call recording: all calls made from the user’s 

role will be recorded (Call Recording License is 

required) 

▪ Call Recording Access: 



 

 MX-E Installation Manual (PN:0000507) Revision 11 February 11, 2019 
© 2019 Zultys, Inc. No reproduction or distribution without permission 

Page 212 of 350 

Technical Publications 

▪ Manage recordings: These options permit users assigned to 

this profile to remove phone recordings from the call 

recording database. 

• Personal: Select this option to manage calls involving 

system users within their user roles. 

• Group: Select this option to manage calls involving 

ACD groups, Operator groups, hunt groups, and 

Inbound Call centers. 

• Emergency: Select this option to manage all emergency 

calls. 

▪ Play recordings: These options permit users assigned to this 

profile to listen to any phone recording in the call recording 

database. 

• Personal: Select this option for access to calls involving 

system users within their user roles. 

• Group: Select this option for access to calls involving 

ACD groups, Operator groups, hunt groups, and 

Inbound Call centers. 

• Emergency: Select this option for access to emergency 

calls. 
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26.2.2 Adding a Single User 

• In the MX-E Administrator click on “Configure” and select “Users”. 

• When the “Users” window opens right click in it and select “New User” or 

press the Insert key 

• For “ID” use a unique identifier (name or  extension number is 

recommended)  

• For “User Name” Your First Name and Last Name using any format  

example:              First_Name.Last_Name 

• “First Name” is the users First name  

• “Last Name” is the users Last name 

• Use LDAP Authentication: Enables this user to use only LDAP 

authentication, that is the MX-E will not be used for login authentication, 

but an external LDAP server 

• Password: password used when logging into MXIE, MX-E Administrator or 

other CSTA applications (E.G. Zultys Mobile, SalesForce, Outlook 

Communicator) 

• Pin: Numeric only password word when logging into Voicemail from a 

phone, or Call Group login via a button. 

• Extension is the extension number assigned to this user 

• Voice DID: is the DID assigned to this user 

• Fax DID: is the fax DID assigned to this user 

Note: there is a relationship between seeing the DID fields on this 

screen and the settings found on the “Outside” tab of the Dial Plan. 

• ID for MS Exchange: this is the ID assigned by the exchange administrator 

for that user  

Note – this cannot have an @ symbol for MSEC V 1. Version 2.2x of 

MSEC supports the @ symbol 

• Caller ID: is the Caller ID this user will present to the PSTN when making a 

call 

• Home Phone:  OPTIONAL, Enter a 7 to 10 digit home phone 

• Cell Phone – OPTIONAL, Enter a cell phone number 

• Fax Number – OPTIONAL, Enter A fax number 

• Email – OPTIONAL, enter an email address  

• Alternate Email – OPTIONAL, Enter a backup email address 
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• Under “Profiles” Select a User Profile to be assigned to this user 

• Under Admin: Select an Administrator Profile to be assigned to this user 

• Under Paging: Select a Paging Profile to be assigned to this user 

• Under Call Recording Select a Call Recording Profile to be assigned to this 

user 

• Device assignment window also allows you to assign a device to this user 

directly from the user screen. 

• Click on the “OK” and “Apply” buttons to commit these changes – See 

Error! Reference source not found. 

*Note: Voice Mail is automatically set up by the “User Profile” field 

 

 

26.3 Importing a Group of Users from a CSV file: 

Importing a list of users allows you to bring all of the users in a company into 

the system in a single step.  It offers a fast alternative to adding a user one at a 

time.  There are three steps that involved in importing a list of users.  First, you 

must create the list, second, you must map the fields from the list into the MX-

E Database, and finally you must import the users. 
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26.3.1 Import Users 

The Import Directory window is the tool for copying data file records into user 

accounts. Each imported data record either creates a new user account or 

updates an existing account in the User List. After the import operation is 

complete, you can save the results by pressing the Apply button in the User 

List. See Importing User Data for the step by step import procedure.  

The Import Directory window is accessed by pressing the Import button from 

the Users window. 

Import From 

• Data Type: Specifies the input file type. Only CSV files are supported at 

this time. 

• File Type: Selects the source file for the imported data records. Either 

type the file name (including path) in the edit box or click the Browse icon 

(right of the edit box) to select a file from your directory. 

Data Sample 

This table displays a sample of the data from the import file; it allows you to 

verify that the file information is consistent and compatible with User List 

records. Fields within the table are not editable. 

The top line (gray) lists the field names for the data records. The next two lines 

list the first two data records from the import file. 

MX-E User Properties 

This table defines the mapping between user account property fields and data 

record fields. This table comprises two columns: 

• Property: each cell in this column corresponds to a User List property, as 

defined in the Columns (Users) window. See User Account Structure. 

• Source: each cell specifies the data file field that will be mapped to the 

MX-E user property. You can type data directly into these cells (such as a 

default password) or drag and drop fields from the Source Fields table. 
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Source Fields 

This table lists the import file data fields. These names are also listed in the 

grey bar of the Data Sample table. 

To map an import field to an MX-E user property:  

1. Move the mouse cursor to the desired field. 

2. Click and hold the left mouse button.  

3. While holding the button, move the mouse cursor into the cell that is 

adjacent to the desired property. The cursor should appear as an arrow 

originating from a page that points to the cell.  

4. Release the left button to display the source field in the cell.  

Button Bar 

Close button exits the Import Directory window and returns to the Users 

window. Imported data will appear in the User List but will not be saved to the 

database until you press the Apply button in the Users window.. 

Load Map button imports a Property-to-Source map from a file that was 

previously saved with the Save Map button. Pressing Load Map accesses an MS 

file open dialog window, from where you specify the name and location of the 

map file. See Map Files. 

Save Map button stores the Property-to-Source map defined in the User 

Properties table into a data file. Pressing this button opens a MS file open 

dialog window, from where you can specify the storage location of the new map 

file. 

Import Data button initiates the import operation defined in the window. 

26.3.2 Creating a List: 

In Excel create a list with the following information: 
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If you do not have Excel, create a file using a text editor.  Separate each value 

with a comma.  Save the file with a “CSV” Suffix. 

Other values can also be added to the CSV file.  These include User Profile, 

Admin Profile, . . . 

If the User, Administrator, Call Recording or Paging Profile do not exist, you will 

be prompted to allow the MX-E to automatically create these profiles and 

assign to the user, or to simply use the default profile. 

26.3.3 Importing a List of Users: 

1. From Configure menu select Users  

2. The Users window appears. 

 

3. Blank user list indicates that no users are provisioned in the database 

4. Click on the “Import” button 
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Importing records from a data file is a fast, efficient, and accurate method of 

creating and modifying user accounts. The Import Directory window contains all 

necessary resources to import a data file to the User List. 

The following procedure for importing data records into a user account 

describes the steps required to create new user accounts and to modify existing 

accounts. 

Import Procedure 

1. Open the Import Directory Window, by pressing the Import button in the 

Users window. 

 

2. Select the data file type. The MX-E only supports the import of CSV files 

at this time. 

3. Select the data file. Enter the path and file name of the import file in the 

data entry box or press the Browse icon to select a file from your system 

directory. 

4. Verify the file structure of the data file, as displayed in the Data Sample 

table. Table contents for the sample records should be consistent with 

the table headings. 
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5. Define Account Property fields. The source column of the MX-E User 

Properties table defines the mapping of data file field into user accounts 

after the import operation is complete. There are four options for 

entering data into the Source column: 

a. Drag and drop fields from the Source Fields table into the desired 

source column cells in the Users Properties table. You can enter 

multiple field names into any individual source field. 

b. Enter data directly into source column cells. This method is useful 

for entering the same password into all user accounts. Source file 

fields entered in this fashion should be surrounded by brackets, 

such as <Last Name>. 

c. Enter data and source file fields into the MX-E User Properties 

table. This method is useful when creating a user name from a 

user’s first and last name separated by a period. 

d. Press the Load Map button to access a data file that automatically 

fills the source fields with preconfigured field names. This option is 

available if you have previously used the Save Map key to store a 

Property field to Source field map. The Load Map option is valuable 

if you periodically import an updated version of the same file. See 

Map Files for instructions on creating a map file. 
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6. Press Import Data button to open the Import options window. If the 

Source column for the User ID field is blank, the UI will not process the 

request. Otherwise the UI opens the Import Options window. 

7. Choose the Desired Operation (Import Options window) from among the 

following options: 

a. import new users 

b. update existing users 

c. import new users and update existing users  

i. The MX-E interprets a data record as a new user account if it 

fills the ID field with an entry that is not duplicated by the ID 

field of an existing user account. If the import operation is 

set to only process new user accounts, all data records that 

would only update existing accounts are disregarded. 

8. Choose update fields (Import Options window) by placing tick marks in 

the desired checkboxes. This option is valid only if the import operation 

is updating existing users. 

 

9. Press OK button to close Import Options window and initiate the import 

operation. 

a. Observe import results from Import / Update Directory Results. 

Close dialog box. 
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10. Press the Close button to exit the Import Directory window. 

11. Resolve Conflicts in User List. If the Apply button is inactive (all 

gray), the User List contain user accounts that either have errors or have 

conflicts with other accounts. Edit each user account that displays the 

error icon in the extreme left column. 

12. If the import operation was successful, Press Apply (User List) to 

save results. If the import operation improperly edited existing accounts 

or created excessive account errors, Press Cancel to restore the User List 

to its pre-import state. 

 

26.3.4 Changing a User’s information or profile: 

You may change a single user’s information by right clicking a user and 

choosing “Edit User” or select a number of users that need to be modified with 

the same information by selecting all the users you wish to modify, right click 

and choose “Edit Users” from the list of options. 

1. Right click on the User(s) that you want to change 

2. Change the information to match the needs of your users and click OK  

3. Repeat this process for all users. 
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4. Apply your changes by clicking Apply 

27. Assigning Users to Devices 

Once you have configured users and devices, you now assign the devices to 

users. You can assign only managed devices. If you have chosen to not manage 

any devices, you do not need to access this window. 

25.1 Assignment Window 

The Assignment window configures and displays the relationship between 

Managed Devices and User Accounts. Specific tasks that you can perform from 

this window include: 

• assigning managed devices to user accounts 

• detecting assignments between managed device and user accounts 

• displaying unassigned managed devices and user accounts 

Each user account may be assigned to one or more managed device; 

conversely, each managed device may be assigned to multiple users. 
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You access the Assignment window by selecting Configure | Assignment 

from the main menu. 

 

25.2 Users Table 

The Assignment window displays a User’s Table on the left side of the window. 

You can select the parameters that the Users Table displays by pressing the 

Columns button. When the Users Table is in assignment detection mode, the top 

line in the table (listed in boldtype) displays the user that is assigned to the 

highlighted device in the Devices Table. Select the Track Users option located 

above the Devices Table to place the Users Table in assignment detection 

mode. 

Assignment window features that are displayed in the Users table include: 

• The Track Devices checkbox, located above the list of Users, places the 

Devices table in assignment detection mode. When in this mode, the 

name of each device assigned to the highlighted user is displayed at the 

top of the Devices table in bold text. 
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• The Assignment column is located on the left side of the table. Cells in this 

column display a phone icon for each user that is assigned to a managed 

device. 

• The Filter buttons, located below the Users table, determine which users 

are displayed by the table. 

select Show All Users to display all users 

select Show Assigned to display those users that have one or more 

devices assigned to them 

select Show Free to display those users that have no devices 

assigned to them. This option is available only if the Track Devices 

and Track User checkboxes are not selected. 

25.3 Devices Panel 

The Assignment window displays a Devices table on the right side of the 

window. Devices table contents are configured in the Managed Devices Window. 

You can select the parameters that the Devices Table displays by pressing the 

Columns button. 

When the Devices Table is in assignment detection mode, the top line in the 

table (listed in boldtype) displays the device that is assigned to the highlighted 

user in the Users Table. Select the Track Devices option located above the Users 

Table to place the Devices Table in assignment detection mode. 

Assignment window features that are displayed in the Devices table include: 

• The Track Users checkbox places the Users table in assignment detection 

mode. When in this mode, the name of each user to which the highlighted 

device is assigned is displayed at the top of the Users table in bold text. 

• The Assignment column is on the left side of the table. Cells in this 

column display an agent icon for each device that is assigned to a user. 

• The Filter buttons, located below the Devices table, determine which 

devices are displayed by the table. 

select Show All Devices to display all devices 
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select Show Assigned to display those devices that are assigned to 

one or more users 

select Show Free to display those devices that are not assigned to 

any users. This option is available only if the Track Devices and Track 

User checkboxes are not selected. 

25.4 Assigning Devices to Users 

To assign a device to a user, select a user and a device and click on ASSIGN. Icons 

are displayed in the assignment columns of both tables to indicate the new 

assignment. You will normally link most devices with a single user. However, 

there are cases when you want to assign a device to multiple users. Therefore, 

if you select a device that is already assigned to a user, and click on ASSIGN, the 

program opens the window to ask you if you want to: 

 

 

• add this user to the users already linked to this device 

• remove the linkage from the other users and keep this user only linked to 

the device 

Cancelling the assignment request maintains the device assignments in their 

current state. 
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25.5 Disconnecting a User from a Device 

To remove an assignment between a user and a device, select the user and the 

device and click on Free. If the user has no other devices assigned to him or 

her, the program removes the icon from the assignment column of the Users 

Table. If the device is now not assigned to any user, the program shows agent 

icon from the assignment column of the Devices Table. 

When you delete a user or a device, the MX-E removes the association between 

the user and the device. 

28. Centralized MXIE Settings 

System administrators have the ability to push MXIE settings to all users on the 

MX-E system without the need to configure MXIE individually for each user. 

MXIE settings are assigned per user profile.  

In MX-E Administrator navigate to Configure -> Users and select the Profiles 

button. 

In the Profiles window, select a profile to edit from the list in the left-hand 

column and open the Client Settings tab. 
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By default, the Configure on Client Side checkbox is enabled. This setting 

means that all MXIE configurations need to be done individually from user’s 

MXIE client.  

 

If the Configure on Client Side checkbox is disabled, all of the settings in this 

tab will be enforced for all users that are assigned to this profile.  
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Note that all settings in this tab, excluding the MXIE layout and setting file, 

apply to other clients besides MXIE, for example Zultys Outlook Communicator 

and Zultys Salesforce Communicator. 

You may specify a MXIE layout configuration file or a general preference 

‘Settings’ configuration file for all users with this profile. See Section 28.1. If 

either of these two fields is left blank, the Users will need to configure them 

individually from their MXIE client. Previously saved ini files may be deleted by 

clicking the red X. 

 

Select whether to manage multiple incoming calls via the user’s bound phone 

or MXIE. The user will not be able to change this configuration from MXIE.  

 

Select whether other users can bind to a device that is assigned to a user with 

this User Profile. The user will not be able to change this configuration from 

MXIE.  

 

Select whether the user’s Caller ID is used when passing a received call to an 

external phone bound to MXIE. The user will not be able to change this 

configuration from MXIE.  
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For users that are members of Call Groups, you can choose how changes to 

their User presence affect their Agent Status.  

 

To choose how changes to Agent Status affect the User Presence and wrap up 

time, see Section 28.2. 

Where an MXmeeting appliance is deployed, enter the address of the appliance 

under MX-E Meeting server. This setting is available regardless of whether 

Configure on client side option is enabled or disabled.  

 

Click OK to close the Profile window then click the Apply button in the User 

window to push the changes to all users.  

 

Changes will take effect immediately. Users do not need to restart MXIE. 

28.1 Exporting MXIE Layout and Preferences 

The MXIE Screen Layout and Preference Settings may be defined centrally on per 

User Profile basis. This is achieved by exporting the Layout and/or Preference 

Settings from a suitably configured MXIE instance running in Admin Mode and 

then selecting the relevant ini file from within the User Profile in MX-E 

Administrator. 
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28.1.1 MXIE Admin Mode 

To create a configuration file, MXIE must be launched in Admin Mode. 

28.1.1.1 Opening MXIE Admin Mode on Microsoft Windows 

1. Select Start -> All Programs -> Zultys MX-E, then right-click on MXIE and 

select Copy. 

2. Paste the copied shortcut to a desired location and rename it, for 

example: “MXIE – Admin”. 

3. Right-click the new shortcut and select Properties, select the Shortcut 

tab. 

 

4. Type the admin command line parameter at the end of the target field.  

"C:\Program Files\Zultys\MXIE\Bin\MXIE.exe" admin 

5. Click OK to save changes and launch the shortcut. 

28.1.1.2 Opening MXIE Admin Mode on Apple Mac OSX 

1. Enter the desired parameters from the OSX command line. To launch 

MXIE from a terminal application, open the terminal, and enter in the 

following  

$ cd /Applications/Zultys/MXIE.app/Contents/MacOS 

$ ./MXie admin 

28.1.1.3 Opening MXIE Admin Mode on Linux 

1. Select Start Menu -> K Menu -> Copy -> Add to Desktop. 
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2. Right-click and select Link -> Properties. A screen similar to the 

screenshot below will appear. 

 

3. Enter the following in the Command field:  

‘/usr/local/zultys/bin/MXie’ admin 

4. Click OK to save changes and launch the shortcut. 

28.1.1.4 Exporting Layout or Preference Settings File 

Launch MXIE using the Admin Mode shortcut created above. 

1. Type the credentials for the user under which you wish to export settings 

and login. 

2. MXIE opens. The Admin option will be available. 

 

3. Customize the User Preferences and MXIE layout for this user as 

necessary.  

4. When finished, open the Admin menu option and select Export Layout or 

Export Preferences. 
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5. Type a name for a new file or select an existing file to overwrite then click 

OK. 

 

6. A popup will notify you that a new file was successfully saved on the MX-

E. 

 

28.1.1.5 Configuring Centralized MXIE layout 

After you have created a configuration file for MXIE layout in Admin Mode of 

MXIE, you can use this file to duplicate the same layout for all users with a 

specific profile. 

In the Client Settings tab of the User Profile, select a Layout File from the drop-

down list. 
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You can enable the Lock Layout checkbox to prevent users from customizing 

their MXIE screen layout. 

Click OK to close the Profile window then click the Apply button in the User 

window to push the changes to all users.  

 

Changes will take effect immediately. Users do not need to restart MXIE. 

26.1.1.6 Configuring Centralized MXIE Preferences 

After you have created a configuration file for MXIE Preferences in Admin Mode 

of MXIE, you can use this file to duplicate the same preferences for all users 

with a specific profile. 

In the User Clients tab of the User Profile, select a Setting file from the drop-

down list. 

 

You can enable the Lock Settings checkbox to prevent users from customizing 

their MXIE preferences. 

Click OK to close the Profile window then click the Apply button in the User 

window to push the changes to all users.  
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Changes will take effect immediately. Users do not need to restart MXIE. 

Note that the following are not included in the configuration file for MXIE 

Preferences. 

Setting Comment 

Audio Drivers Must be configured individually for 

each user in MXIE. 

Softphone -> Audio Parameters Must be configured individually for 

each user in MXIE. 

Call Groups and Operators Agent’s status settings and wrap up 

times are configured in the User 

Profile or Call Groups window in MX-E 

Administrator. See Sections 28 and 

28.2. 

Popup notification and Call 

Management settings are included in 

the centralized MXIE Preference .ini 

file. 

Supervisor Must be configured individually for 

each user in MXIE. 

Device Access Policy Configured in the User Profile in MX-E 

Administrator, see Section 28. 
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Setting Comment 

MXmeeting Configured in the User Profile in MX-E 

Administrator, see Section 28. 

Call Handling Configured in the User Profile in MX-E 

Administrator, see Section 28.3. 

28.2 Centralized Agent Settings 

To set how changes to Agent Status affect the User Status and wrap up time 

and other group-specific configurations, navigate to Configure -> Operator 

and Call Groups. Select a Call Group to edit from the list in the left-hand 

column and open the Member Settings tab. 

 

By default, the Configure on client side checkbox is enabled. This setting means 

that wrap up time and When Active on a Call as Agent or Operator, become 
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busy as User option need to be configured individually from each user’s MXIE 

client.  

From this tab, you can choose whether agents can accept personal calls while 

on an active agent call, as well as whether they can accept agent calls while on 

an active personal call. With Release 9.0, this setting is now available for all 

types of Call Groups.  

Settings for how changes to User’s status affect their Agent Status are located 

in the User Profile. See Section 28. 

When Force all member to member transfers via queue option is enabled, all 

calls transferred between users who are members of the same Call Group will 

be considered Agent Transfers. These transferred calls will be placed into Call 

Group’s queue with highest priority for a particular Agent. If this Agent fails to 

answer the call in a timely fashion, after the time period specified in the Drop 

Agent Assignment setting expires, this call will be sent to the next available 

agent. The same timeout period also applies to parked Call Group calls. 

When finished, click Apply to push the changes to all users. 

28.3 Centralized Call Handling Rules 

To configure centralized Call Handling Rules, in the User Profile navigate to the 

Misc tab.  

 

The Allow personal rules option allows users to configure their own Call 

Handling Rules in addition to the ones configured for their User Profile. If this 

option is enabled, you can choose whether centralized or personal Call 

Handling Rules will take precedence with Apply personal rules first option, 

effectively this option determines whether personal rules appear before or after 

rules defined in the Profile.  
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To create new Call Handling Rules or edit existing ones, click the Edit Rules 

button. 

 

When finished, click OK to save the new Call Handling Rules then click the Apply 

button in the User window to push the changes to all users.  

 

Changes will take effect immediately. Users do not need to restart MXIE. 
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29. Adding Operators, Hunt Groups, ACD and 

Inbound call Centers 
Overview:  Groups provide a special function for users of the MX-E.  They allow one phone 
number (Either extension and / or DID) to be assigned to multiple users.  Each group can 
support up to four tiers of skills based routing, which allows the calls to be routed to the highest 
priority agent in the group.  In cases where there are multiple agents of the same priority, 
incoming calls can be setup to be routed between agents using one of three patterns: Ring All, 
Longest Idle, or Least Busy.  In most cases, the agent would have to be logged into the group 
using MXIE for calls to be routed to the agent.  The exception to this is the Hunt Group which is 
always logged in and calls will be routed to the agent’s phone even if they are not logged into 
the system. 

29.1 Adding Operators, Hunt Groups, ACD and Inbound Call Center 

Groups 

• Click on Configure | Operators and Call Groups  

• Right click in the left panel and select “Add” or press the Insert key on 

your computer. 

29.2 Adding a Call Group: 

• Select Call Group Type 

• Enter a name 

• Assign the group a valid extension number 

• Assign the group a valid DID (optional) 

• Other configurable parameters: 

o Voice and FAX 

▪ Fax DID 

▪ Fax Group 

▪ Language 

▪ Call Distribution 

• Least Busy - The agent who was on the phone for 

shortest time (time from all calls summed together) 

gets the next call 

• Ring All – rings all agents of the same priority 

• Longest Idle - implements the “longest idle” algorithm 

or the agent who was not on a call for the longest time 

will get the next call 
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▪ Music on Hold 

▪ Can Return Calls from Voice Mail 

▪ Prompt caller for Callback Number 

o CAD Templates 

▪ Inbound 

▪ Outbound 

o Voice mails / Fax messages / on demand settings 

▪ Distribute messages to user mailbox of each member 

▪ Do not save messages to the group mailbox 

 

29.2.1 Creating a Call Group: 

1. Double click on the “Type” field and select Call Group Type 

1. Operator 

2. ACD 

3. Hunt 

4. ICC (Inbound Call Center) 

2. Double click on the “Name” field and enter name 

3. Double click on the “Extension” field and enter a valid extension 

4. Set “Call Distribution”, “Call Return from VM” and “Prompt for callback 

number” shown below 
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Figure 1: Configuring the General Tab for Operator Groups 

29.2.2 Adding Members to a Call Group: 

5. From the Configuration Pull-down menu, select Operators and Call 

Groups 

6. From the Call Group Configuration Screen, Click on the Call Group, then 

click on the Members Tab 

7. Select users from the “Not a Member” list and Click on Add 

o If the MX-E is part of a MXnetwork there is an option to filter to 

particular nodes 

8. Repeat this process to add other users to the “Members List” as shown 

below 

9. Setting Priority to 3 – this means that the user will receive fewer calls then 

Priority 1 

10. Setting Priority to 1 – this means that calls will always be routed to 

this user first.  

11. Select which users to have access to the group’s voicemail by 

placing a checkmark in the Access mailbox. See below 

 

 

Figure 2: Adding members to a Call Group 
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29.2.3 Configuring Member Settings for a Call Group: 

Configure if the Agent is allowed to changes these settings from their MXIE 

client or if they are set via the MX-E and are not allowed to be modified by the 

Agent in MXIE. 

 

29.2.4 Configuring Call Handling for a Call Group: 

Overview:  Call Handling options allow you to configure how you want calls handled when an 
agent is not available to take a call. 

• From the Configuration Pull-down menu, select Operators and Call 

Groups 

• From the Call Group Configuration Screen, Click on the Call Group, then 

click on the Call Handling Tab 

• Configure the following options: (See Below) 

o Forward All Calls:  If enabled, all calls can either be sent to another 

extension or to the group voicemail box. 

o No Answer Call Handling:  These options describe what action 

should be taken if a call is not answered by a specific agent within 

a configurable amount of time.  Normally, the default action, 

Forward to Next Member, is the preferred action. 

o Not available call handling describes what to do when an agent is 

not available to answer the call.  The default action, Place call in 

queue, allows the caller to be placed in queue and the call would be 

routed to the first agent that becomes available. 

o The Group RNA (Ring No Answer) handling option defines what 

actions should be taken if everyone in the group is busy.  Here, the 

default action, Place call in queue, is the preferred action. 

o The All Agents logged out option allows you configure the action 

for when all agents are logged out of the group.   

o The last option, Queue timeout allows you to configure what to do 

if the call is not answered within a configurable amount of time.   
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Figure 3:  Configuring Call handling options for a Call Group 

 

29.2.5 Configuring Number Associations  

Overview:  Number Associations allow one group to receive calls made to a variety of phone 
numbers.  Each sub-group can be configured for a Main DID, an Extension, and a Description of 
the group.  When a call comes into the sub-group the call rings in on the main group’s MXIE 
interface with the addition of a description of the called number.  

• From the Configuration Pull-down menu, select Operators and Call 

Groups 

• From the Call Group Configuration Screen, Click on the Call Group, then 

click on the Number Associations Tab 

• Configure the following options: 

o Outgoing calling party number:  Defines the caller ID for 

outbound calls made from the group. 

▪ Main DID of the group – then number of the main group 
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▪ Main company number – the main number configured 

under Provision | System Settings | Company Information 

screen 

▪ Specify – Some other number 

o Inbound DIDs:  Defines the Main DID, Extension, Description, 

and Music On Hold Play List of the sub-group(s) 

 

Figure 4:  Adding Number Associations 

29.2.6 Call Group Queue Announcements: 

When a caller is placed in queue, the Queue Announcements are used to 

configure which messages the caller will hear while they are in queue.  The first 

section deals with what the caller will hear when they enter the queue and the 

second section defines which messages will be played and how often they will 

be played while the caller is in queue.   

• Play ring back tone: Plays a ring back signal once when the caller is 

connected to the queue. 

• Custom Phrase on entry – allows you to play a greeting message (Only 

Available for Inbound Call Center) 

o Three choices: 

▪ Local Files – any 8KHz, 8 Bit, Mono CCITT U-Law “wav” file on 

your local system 

▪ System Prompts – Select from a list of system provided 

prompts 

▪ Text to speech – allows you to create a script and convert it 

from text to speech. 
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• Play only when no agent is available – If selected, greeting messages are 

only played when no agent is available. 

• Position in Queue – informs the caller how many people are ahead of 

them in the queue 

• Expected Wait Time – describes how long they should expect to be in 

queue  

•  Note:  This value is reset based on the “Real-Time Group and Agent 

statistics reset configuration” found at the bottom of the “General” Tab of 

the Inbound Call Center configuration window. 

 

 

29.2.6.1 While in the Queue: 

This section describes how the call will be treated while the caller is in the 

queue.  Which messages will be played, will they repeat, and how often will they 

be played.  You can play up to five messages and decide if they are to repeat. 

• Click on both Enable and Repeat for the first outgoing message: 

o Select Position in Queue from the pull-down menu 

o Set the repeat time to 10 seconds – this will play this message 10 

seconds after the last message. 

• Click on both Enable and Repeat for the second outgoing message: 

o Select Expected Wait Time from the pull-down menu 

o Set the repeat time to 10 seconds – this will play this message 10 

seconds after the last message. 

• Click on both Enable and Repeat for the third outgoing message: 
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o Select the system prompt “Hold_For_Agent.wav” by clicking on the 

files button  and select system prompts 

o Select a repeat period of 5 seconds.  This message will play 5 

seconds after the previous greeting. 

• Click on both Enable and Repeat for the fourth outgoing message: 

o Select the system prompt “Your_Call_Is_Important.wav” by clicking 

on the files button  and select system prompts 

o Select a repeat period of 5 seconds.  This message will play 5 

seconds after the previous greeting. 

• Click on both Enable and Repeat for the fifth outgoing message: 

o Select the system prompt “Continue_To_Hold.wav” by clicking on 

the files button  and select system prompts 

o Select a repeat period of 5 seconds for this file. This message will 

play 5 seconds after the previous message. 

Note:  If the caller is still in queue, the caller will next hear the first message.  In 

our case, that is the position in queue message and it will play 10 seconds after 

the Continue_To_Hold message. 

 

29.2.6.2 On Leaving Queue: 
Overview: The last section of the while in Queue Announcements field describes how the 
system will respond when the call is answered. 

• Custom Phrase – Allows you to select a wave file to be played when the 

call is answered. 

o Select the System Prompt “transfer_to.wav” 

• Announce Agent’s Directory Name – Enable this feature 
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29.2.6.3 Enable Music on Hold – will play music while the caller is on hold.   

• Enable this feature if required. 

 

 

29.2.6.4 Configuring Inbound Call Center Queue Overflow Routing: 
Overview:  Queue Overflow Routing allows the system to set some general rules when too 
many callers hit the ICC group at the same time.  Among the configurable values are: Average 
Time, Queue Length, and Caller has been on hold to long.  In each case, the choices are the 
same:  Forward to another number, Forward to Group Voice Mail, or Play Busy Tone and 
Disconnect. This option is for ICC call groups only. 
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29.2.6.5 Configuring Quit Queue Options: 
Overview: This section is used to configure the MX-E to respond to specific input from the caller 
while they are in queue.  The specific inputs that can be used to exit the queue are pound / hash 
(#) and any number from zero to nine (0, 1, 2…9) and the actions that can be taken are either 
Forward to Group Voice Mail or Forward To a specific extension. Up to 3 different options may 
be configured. 

• When Caller Presses # -- choose forward to voicemail or to another 

extension/phone number 

• When Caller Presses 0 -- choose forward to voicemail or to another 

extension/phone number 

• When finished, click Apply to save your changes.   

• See below for details 

 

 

Figure 5: Configuring Queue Configuration 

29.2.7 Configuring Call Recording for a Call Center: 

• From the Call Group menu, click on the call recording Tab 

• From the Preferences menu: 

o Play beep at start – plays a beep at the start of recordings 

o Play beep every XX seconds – configures the frequency of the call 

recording beep. 
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o Ask the caller’s permission before recording – prompts the caller 

for permission to record 

o Enable automatic call recording – automatically records all calls 

• Agent Options:  These options allow the administrator to configure 

Record on Demand and Access to Automatic recordings options.  See 

below for details. 

 

 

Figure 6:  Configuring call recording options on a Call Group 

29.2.8 MXnetwork options 

MXnetwork tab allows the configuration of MXnetwork features when the MX-E 

is part of an MXnetwork. 

Visibility 

• Local: the Call Group is only visible to agents logged into this node, only 

agents logged into this node are able to be a member of the call group 

• Visible to other MX-E nodes: The call group is visible on all nodes of the 

MXnetwork, and agents may login to this call group while logged into 

their home node. 

Redundancy 

This feature requires MXnetwork and MXnetwork failover licensing 
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• Failover MX-E: Define the MX-E the call group functionality will failover to 

in the event this MX-E fails. 

• Automatic failover delay: delay time before the call group fails over. 
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30. Configuring Dial Plan: 

The Dial Plan is used to decide how calls are routed by the MX-E.  There are 

several tabs that are used to configure the routing of calls, how calls will be 

distributed, and if any restrictions have been configured.  

30.2 Configuring Call Routing: 

The Call Routing screen is used to describe for a specific dialed number, how 

the call will be routed by the MX-E.  This screen has four significant fields: 

Pattern, Interface, Transformation, and Restriction.  As you configure the Call 

Routing, you will add a line that will be used to define a specific pattern.  Then 

you will select the Destination – or which interface the call will be routed to. 

Next, you will configure the Transformation field to describe how a dialed 

number will be modified before it will be sent over interface.  Lastly, you will be 

asked if the calls on a specific interface may be restricted.  As you build your 

dial plan, you will add multiple patterns for the dialed number.  Each dialed 

number will be compared to the first pattern.  If it doesn’t match the first 

pattern it will be compared to the second number.  The call will continue this 

process until it finds a pattern that matches the dialed number.  As such, the 

specific order of the individual patterns is very important.  Therefore, items 

should be organized from most specific (first) to least specific (last). 

30.2.1 Source Options 

• Internal: Covers any call originated on this MX-E, another MX-E node in 

MXnetwork, internal SIP servers, Tie Lines  

• This MX-E: Covers calls that originate on this MX-E 

• External: This covers all external trunks (PSTN / ISDN / External SIP server 

/ ITSP) 

• Location XXX: Calls from the location specified 

• MX-E Node XXX: Calls from the MX-E Node specified 

• FXO XXX: The call originated from the FXO Group 

• PCM XXX: The call originated from the PCM Group 

• ITSP XXX: The call originated from the ITSP Service provider 
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• SIP XXX: The call originated from the SIP provider 

• Location XXX: The call originated from the Location Specified 

• AA xxx: The call originated from the Auto Attendant Specified 

30.2.2 Destination Options 

• Blocked: The call is rejected with no option to bypass 

• Extensions: Covers User extensions and System Services including those 

shared across MXnetwork 

• FXO XXX: The call is routed out the FXO Group 

• PCM XXX: The call is routed out the PCM Group 

• ITSP XXX: The call is routed out the ITSP Service provider 

• SIP XXX: The call is routed out the SIP provider 

• Location XXX: The call is routed out the Location Specified 

• This MX-E DID's: Available only when Source = External. When selected 

the Transformation will be checked against DID numbers provisioned on 

this MX-E. 

• AA xxx: The call is routed to the Auto Attendant Specified 

• MX-E Node XXX: Calls is routed to the MX-E Node specified  

• Transform and Continue: The transformation is applied to the dialed 

number, and the call continues to move down the dial plan looking for a 

new match 

Note: Trunk Groups are automatically added to the destination drop down 

after they are created and applied. Please create all trunk groups before 

modifying the Dial Plan. 

30.2.3 Pattern vs Route 

• Pattern: This is what the caller dials and is matched against in the dial 

plan to be routed. 

• Route: This is how the call is routed once a match is found. You can have 

multiple routes for a single pattern. 

30.2.4 Call Routing Pattern Variables: 

• In your MX-E Administrator click on “Configure” and then select “Dial 

Plan” 

• Click on the “Routing” tab 
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• Source: Can limit application of rule to calls made from a specific 

location, SIP servers etc. Normally set to “Internal” 

• Pattern Variables: 

o X or x – Any digit. 

o + (plus sign) used for international dialing 

o  [ or ] – Square brackets.  Surround a range of numbers. 

o -  – A dash – used to separate a range of numbers. 

• 5-6 – when used with square brackets EG [5-6], indicate a 

range of numbers. 

o 0,1,2,3,4,5,6,7,8,9,0 – Specific Digits. 

o @ – A wild card – meaning “or more”.  For example: XXXXXXX@ 

means seven or more digits. 

• Destination:  A pull-down menu that is used to select the physical or 

logical Interface that would be used to carry the call. 

• Transformation Patterns: 

o X or x – Any digit. The corresponding digit in “Pattern” field is 

sent as is 

o 0,1,2,3,4,5,6,7,8,9,0 – Specific Digits – used to insert digits in 

the transformation field 

o D or d – used to delete digits in the Transformation field 

o + (plus sign) used for international dialing 

o * or # -- used to insert digits in the transformation field 

• Restricted:  Indicates if a specific pattern may be restricted. Once a 

check mark is placed in the restricted field it will show up in the user 

profile → call restriction tab. 

30.2.5 Configuring Basic Call Routing: 

Dial plan entries are added by right clicking and choosing “New Pattern” from 

the dropdown. 

The Routing table specifies rules for routing calls that are dialed by users of 

your MX-E system and of other MX-E systems located within your MXnetwork. 

Each row lists one dialing rule or an alternate route for an existing dialing rule. 

Rules are listed in order of precedence; if a phone number matches the pattern 
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of two different rules, the dialing plan will use the rule with the lowest 

precedence number.  

30.2.5.1 Field Definitions 

Each dialing rule comprises the following parameters, as listed in the table:  

·Rule Status (first blank column heading): An icon in this column indicates that 

the rule has a configuration problem:  

• There are two symbols that you may see while viewing the dial plan. 

o The  denotes a serious problem with the dial plan and you will 

not be able to click apply until the problem is resolved.  The 

simplest way to resolve problems is the click on the line where you 

see the symbol and the system will tell you what the problem is.  

The most common problem that you will find is an inconsistency 

between the pattern and the transformation. 

o The  is a cautionary statement – it is used draw your attention to 

the line and you must decide if there is a problem.  The most 

common problem that you will find is if one pattern is completely 

hidden by another one.  This occurs when items in the dial plan are 

not arranged from specific to general.  You can also see a caution 

saying that one pattern is partially overlapped by another.   Most 

times this is not a problem. 

• ·Precedence (second blank column heading): Dialing rules are evaluated 

based on precedence. Dialed numbers are evaluated first against the rule 

with the smallest precedence number, then against rules with 

successively higher precedence numbers until a match is found between 

the dialed number and a rule. 

When a rule has multiple destinations and transformations, MX-E attempts to 

place the call through the route defined by the destination that appears on the 

row that defines the rule. If it is unable to access that route, it will attempt to 

use the destination-transformation on the next row. 
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To change the precedence of a dialing rule or alternate destination-

transformation, use the Up and Down buttons located at the bottom of the 

panel. 

• Name: This is the alphanumeric name of the rule. The MX-E refers to 

dialing rules in other panels by this name. You can have spaces in the 

name and define rules with duplicate names within a dial plan.  

• Source: This column indicates the users for which the rule is valid: 

• Pattern: This column lists the filter pattern that the MX-E compares to a 

dialed number. If the dialed number matches the pattern, the number is 

transformed and routed as defined by the rule. A dialed number is 

evaluated against the patterns of different rules until the MX-E finds a 

match. If a number does not match any rule pattern, the call is discarded. 

• You cannot specify any entity defined by the Services panel (voice mail 

server, bind server, park server, page server, or any auto attendant) or by 

the Operators and ACD Groups window (ACD groups, Inbound Call Center 

groups, hunt groups, or operator groups). 

• Destination: The destination defines the route that the MX-E uses to 

transmit the call filtered by the dialing pattern. Destination setting 

options include each available transmission option including: 

• Transformation: When a dialed number matches a rule pattern, this field 

defines the transformation algorithm that converts the dialed number 

into the digits required to contact the destination entity. 

• Restricted: Placing a checkmark in this box restricts access to phone 

numbers covered by the dialing rule. Access restrictions can prevent 

specified users from making a call or require an account code before 

completing the call. Call Restrictions describes the process of 

implementing MX-E call restrictions. 

30.2.5.2 Creating a Dialing Rule 

A dialing rule requires the following parameters: Name, Source, Pattern, 

Destination, and Transformation. In addition to the required parameters, you 

can define alternate destinations and transformations for each dialing rule and 

configure selected rules for call restrictions and account codes. 
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Each row table that lists a name, source, and pattern defines a dialing rule. 

Dialing rules that have more than one destination-transformation setting lists 

the additional settings immediately after the row that defines the rule; these 

rows do not list a name, source, or pattern setting.  

 

The routing plan above configures a dial plan with the following attributes:  

• ·The dial plan defines ten dialing rules. 

• ·Dialing rule #4 provides two alternate destination-transformation 

settings in addition to the PCM Voice Group: PRI destination.  

• ·The dial plan warns that rule #7 is completely hidden by rule #2 

(Sunnyvale_Users). 

Rules and alternate routes are created and deleted by right-clicking the mouse 

while the cursor points in the table. Table contents are always sorted by rule 

precedence defined in the second column. You can change the precedence of a 

rule by pressing the Up and Down button at the bottom of the panel or by right 

clicking the mouse and selecting Up or Down. 

30.2.5.3 Dialing Rule Conflicts 

Dialing rule conflicts result when a phone number is specified by more than one 

dial rule. For example in the screenshot in section 30.2.5.2, the number 411 is 
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covered by dial rule #2 (pattern = xxx) and dial rule #7 (pattern = 411). When a 

user enters 411 under this dial rule, the call is routed as configured by rule #2; 

dial rule #7 is never used because of the conflict. 

The MX-E reports three types of conflicts: 

• B is overlapped by A indicates that some of the numbers defined by rule B 

are covered by a portion of the numbers defined by a preceding rule. In 

this case, all numbers covered by both rules will be resolved using the 

preceding rule (or rule A). 

• B is completely hidden by A indicates that all numbers defined by rule B 

are covered by a portion of the numbers defined by a preceding rule. In 

this case, all numbers covered by rule B will be resolved using the 

preceding rule. 

• B is partially hidden by A indicates that a portion of the numbers defined 

by rule B are covered by all of the numbers defined by a preceding rule. 

In this case, all rules covered by both rules will be resolved using the 

preceding rule. 

30.2.5.4 Keyboard Manipulation 

To access the data in the table, type the Tab key until an element in the table is 

selected. Type the Insert or Delete keys to add a new rule or delete an existing 

rule, respectively. Press Enter to edit the data and Enter again when you have 

finished editing the data. Use the arrow keys, Home, End, PgUp, and PgDn to 

move among the cells of the table. Use Control-Up arrow and Control-Down 

arrow to change the sequence of the rules. 

Important: Routing panel changes do not take effect until you press the Apply 

button. If you press the Cancel button before pressing Apply, all pending 

changes to Dial Plan panels are disregarded. Pressing the Apply button saves all 

pending changes to every Dial Plan panel. 
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30.3 Configuring Dial plan: Outside: 

• Use Voice DID for Incoming Calls 

o Enabling this option allows users that have Voice DID numbers to 

receive calls directly from the party calling their DID number 

without operator or auto attendant intervention. Selecting this 

option adds the Voice DID column to the User list. 

o Do not check this box if you are using ISDN subaddressing. 

• Use Fax DID for Incoming Calls 

o Enabling this option allows users that have Fax DID numbers to 

receive Fax transmissions from callers that are external to the MX-

E. Selecting this option adds the Fax DID column to the User list. 

Faxes sent to an MX-E user are stored in voice mail and received 

through MXIE. 

o Do not check this box if you are using ISDN subaddressing. 

• Prefix ISDN Received Calls With 

o This option is typically used for calls received by the MX-E from an 

ISDN circuit (such as a tie line) and routed to another ISDN circuit 

(normally a PSTN line). Select this option to append the specified 

digit to the beginning of the ISDN number. You can choose not to 
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append the digit if the first digit of the received number matches 

the digit. 

• Send calls with Unrecognized DID Numbers 

o This option specifies a method of handling incoming calls with DID 

numbers that are not defined in the MX-E User List. This situation 

may arise where an MX-E is daisy chained between the PSTN and a 

legacy PBX that supports DID. In this case, the MX-E should send 

the call directly to the tie line that connects to the legacy system. 

• Disconnect Calls with unrecognized DIDs to discard calls to DID numbers 

that are not assigned to a user or a group. 

• Send calls with unrecognized DID numbers to route calls to DID numbers 

that are not assigned to a user or group.  

o Default Attendant 

▪ The term Default Attendant refers to a uniform call routing 

method. The Default Attendant routes calls in the following 

manner.  

▪ 1.Calls are sent to the Default Auto Attendant if that entity is 

on duty. 

▪ 2.Calls not handled by the Default Auto Attendant are sent to 

the Default Operator, if that entity is on duty. If the default 

operator is not configured, the call is lost. 

▪ 3.Calls not handled by a configured Default Operator are sent 

to voice mail. 

o Any Trunk defined in the MX-E 

Important: Outside panel changes do not take effect until you press the Apply 

button. If you press the Cancel button before pressing Apply, all pending 

changes to Dial Plan panels are disregarded. Pressing the Apply button saves all 

pending changes to every Dial Plan panel. 
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31. Understanding Call Restrictions on the MX-E: 

Call restrictions indicate whether or not a call over a particular trunk interface 

may be restricted.  Once configured, user profiles are created that can either 

Restrict, Block or allow calls over a particular trunk interface.  There are three 

steps to call restrictions:  First in the “Dial Plan” – “Routing” window, clicking on 

the “Restricted” check-box. The second step requires that you define the 

restriction from the “Call Restriction” tab.  And the third step requires that you 

define which user profiles are affected by the restrictions. 
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31.2 Adding Restrictions to Call Routing  

1. From the Configure pull-down menu, select Dial Plan. 

2. Put a check in the restricted column on any interface that you would like 

to restrict calls on. 

31.3 Defining Call Restrictions: 

1. From the Dial Plan window, Click on the “Call Restriction” tab 

2. There are three areas in the Call Restriction window, two of which offer 

configurable areas: 

o Call Restrictions: 

▪ Multiple Assignment:  If a Phone is assigned to multiple 

people 

• Most Restrictive – Phone permission is set to the higher 

restriction level.  When a user tries to make a call, they 

will be prompted to enter their extension and 

password.  If their account does not allow the call to be 

routed, the user will get an error message. 

• Least Restrictive – Permissions are set to the lowest 

permission level. 

▪ Binding:  If multiple people bind to a specific phone (Via 

MXIE): 
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• Most Restrictive – Phone permission is set to the higher 

restriction level.  When a user tries to make a call, they 

will be prompted to enter their extension and 

password.  If their account does not allow the call to be 

routed, the user will get an error message. 

• Least Restrictive – Permissions are set to the lowest 

permission level. 

o Account Codes: You can require that the user enter a code that 

represents a specific project.  The length of the codes can be 

controlled by the administrator.  Further, you can allow the user to 

enter any account code or specify which account codes are allowed.   

o Prompts: This section is currently not available for any 

configuration options. 

 

31.4 Applying Call Restrictions to User Groups 

31.4.1 Defining User Profile Call Restriction options 

The Policy section of the Call Restriction panel specifies the authentication 

policy that the MX-E enforces for all users to whom the profile is assigned. The 

MX-E defines three authentication policies: Phone, Phone and User, and User. 

Phone: This policy uses the access authorization of the phone to determine 

which calls are sent. When you dial a number that is blocked by the phone’s 
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access authorization, the phone will not make the call regardless of the user’s 

access authorization. This is the most restrictive restriction policy. 

Phone and User: This policy uses the access authorization of the phone and the 

user to determine which calls are sent. When you dial a number that is blocked 

by the phone’s access authorization, the phone will ask you to authenticate the 

call. If your user access authentication permits you to dial that number, the 

phone will complete the call. This allows a user to complete a call from a phone 

that is assigned to another user that does not have sufficient access to 

complete your call. If you place a call from MXIE, your MXIE credentials are 

assumed. 

User: This policy uses the access authorization of the user to determine which 

calls are sent. When you dial a number on a phone with the User policy, it asks 

you to authenticate the call. If your user access authentication permits you to 

dial that number, the phone will complete the call. If you place a call from MXIE, 

your MXIE credentials are assumed. 

31.4.2 Creating a User Profile with Restrictions 

• From the Configure, User menu, select the Profiles button.  

• Create new Profiles by right clicking in the profile name area, and 

selecting “new” 

• Highlight the new user profile and click on the “Call Restriction tab, apply 

the required restriction options 

• Click on OK to return to the User screen 
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31.4.3 Assigning Users to Profiles that are restricted: 

1. Modify user account and assign the proper profile, by either double 

clicking on the account, or right clicking once and selecting edit user. 

You may also assign a user profile to multiple users by selecting multiple 

users and right clicking then selecting edit users 

2. Click on Apply to write your changes to the MX-E.  
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32. Creating an Automated attendant script 

Auto attendants allow calls to be directed to an “IVR”.  Then based on the 

caller’s actions, the call can be routed to a specific user, ACD group, or 

function.  When creating an automated attendant, you need to first plan which 

ACD/ICC/Operator/Hunt Groups and extensions need to be called from within 

the Auto Attendant.  Then decide which functions (i.e.: Dial by name, Transfer 

to an internal number, transfer to attendant, etc.) need to be called.  Next, 

create a diagram that details which numbers or functions will be called, who will 

be at each extension, and what number needs to be dialed.  The first step in 

configuring an Auto Attendant is to create a script.  The script has three 

elements:  the narrative section, the actions, and the properties. After an Auto 

Attendant script is created, it must be scheduled before it will function. 

32.2 Creating an Auto Attendant: 

The Auto Attendant panel configures extensions and DIDs for the MX-E 

automated attendants, to access this panel, select the Auto Attendants tab from 

Configure → Phone Services → Auto Attendants window.  

Each row defines an auto attendant. Each column with a row configures an auto 

attendant parameter: 

• Name: The name is an alphanumeric label that identifies the auto 

attendant. This name is used by other user interface windows, such as 

the Script Selection window. 

• Extensions: This parameter specifies the extension number that contacts 

the auto attendant. 

• DID: This parameter specifies the direct phone number that reaches the 

auto attendant. This column appears only when DID is enabled in the Dial 

Plan: Outside panel. 

To add an auto attendant to your system, right click the mouse while pointing 

in the Auto Attendant table and select New. 

To edit an auto attendant’s extension or DID, highlight the desired Auto 

Attendant in the panel, right click the mouse while pointing in the Auto 

Attendant table and select Edit. 
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Auto Attendant panel changes do not take effect until you press the Apply 

button. If you press the Cancel button before pressing Apply, all pending 

changes to Phone Services panels are disregarded. Pressing the Apply button 

saves all pending changes to every Phone Services panel. 

There can only be one AA with no DID assigned to it. This is the AA that will be 

used when no match is found for incoming DID’s or no DID is presented to the 

MX-E 

 

32.3 Creating the Script: 

From Auto Attendant → Scripts you can create, edit or remove existing auto 

attendants. To edit a script either 2x click on the script or right mouse click and 

choose Edit. To create a new script click on the new button or right mouse click 

and choose New Project 
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Once you choose New Project you will be asked to give it a name. 

 

Click OK, after providing a name for the script. 

32.3.1 The Auto Attendant Screen  

The Auto Attendant Screen is broken into 3 basic parts 

• Prompts or Greetings 

• Actions 

• Dialogs 
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This center section defines if and where the inputs will come from 

• User input via DTMF 

• A Variable 

• Info collected and stored from other dialogs, or data sources 

• No Input at all 

Record the input into the CDR table. 

This is helpful if looking to see how often a particular option is used, or 

running reports on how the scripts are being used 
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32.4 Script Properties: 

1. In the “Script Editor” click on the “Script Properties” icon  

2. Set the “Single Digit Transfer” to 0 
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3. Set the “Attendant Extension” to extension number of the operator group 

then click OK. 

 

32.5 Actions 

Actions in a script do basic functions such as transferring a call or playing a 

message, however scripts may also transfer to other scripts allowing for very 

complex structures to be created.  This allows individual departments to have 

and control their scripts while maintaining call routing between different 

departmental scripts. 

For each of the inputs you can choose one of the following actions 

• Goto 
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• Transfer 

• Transfer to Attendant  

• Transfer to VM 

• Dial by Name 

• Disconnect  

• Web Server Request  

• Assign to Variable  

• Change Language 

• Fax on Demand 

• Repeat Prompt 

• Wait for Input 

32.5.1 Adding User Input Options 

User inputs define the valid responses to a prompt. When a prompt presents a 

set of options to a caller, it provides the numbers which, when pressed, triggers 

specified actions. Valid user inputs include: 

• Digits and symbols: This input is any combination of digits plus the * and 

# symbol. Single symbol input typically branches to other options, 

whereas multiple symbol input usually refers to a user extension. The ‘?’ 

symbol can be used as a wild card, which is useful for branching to 

multiple extensions. 

• No input: This condition is the case where the caller does not respond to 

the prompt within a specified time. 

• No match: This condition is the case where the caller responds to the 

prompt, but the prompt does not match one of the other defined inputs. 

32.5.2 Adding Actions 

Right mouse click in the actions panel and choose add action. This will 

introduce a new line, and then click on the ellipse button to choose an action 

from the list presented. 

• Go to 

o The Go to Action panel is the Action Editor panel that implements a 

Go to Action. The Go to Action panel displays a data entry box that 

specifies the dialog that will receive control of the script. 
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• Transfer 

o The Transfer Action panel is the Action Editor panel that 

implements a Transfer Action. Transfer actions transfer the caller 

to the extension or phone number specified in the Destination 

section. The extension or phone number is may be listed directly, 

derived from a previously executed dialog, or passed as a variable 

from a web script. This action also offers routing and message 

options if the transfer is not successful.  

o Prompt Options 

o In addition to the greeting prompt that is available for all types of 

actions, you can also choose a prompt that will be played if the 

system is unable to transfer the caller. Select the On failure tab and 

press the Add button to select a WAV file.  

o Before transferring 

▪ This field allows you to choose an audio introduction that is 

played before the caller is transferred. The default setting for 

this option is configured in the Script Properties window.  

o Destination 

▪ This field selects the destination to where the caller is 

transferred. 

▪ Extension or phone# routes the caller to the specified user. 

▪ Variable or dialog routes the user on the basis of the value of 

the specified script variable or input passed from a 

previously executed dialog. 

o Call Attached Fields 

▪ This field specifies the name and value of Call Attached 

variables assigned to the call before it is transferred to the 

specified destination. Press the Change button to access the 

Attached Fields panel for selecting these variables. 

o When ACD Queue Priority is selected, the call corresponding field 

determines the initial queue position when the call is routed to its 

destination. 

▪ Call 'Priority Values' of 0 to 5 only impact the priority of a call 

within its queue (unchanged from previous firmware 
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releases). Call 'Priority Values' of 6 to 10 impact the priority 

of a call across all queues that an agent is logged into 

allowing for a customer to configure a VIP queue where the 

waiting calls take precedence over all other call groups even 

when there are calls in other queues that have been waiting 

longer. 

o On Failure 

▪ This field determines the script behavior if the MX-E is 

unable to perform the transfer.  

▪ Go to transfers the caller to the dialog that is specified in the 

accompanying entry box. 

▪ Disconnect terminates the call. 

▪ Transfer to Attendant sends the caller to the extension 

specified in the Script Properties window.  

• Transfer to Attendant 

o The Transfer to Attendant Action panel is the Action Editor panel 

that implements a Transfer to Attendant Action. Transfer to 

Attendant actions transfer the caller to the attendant extension 

designated by the Script Properties panel. 

o Call Attached Fields: This field specifies the name and value of Call 

Attached variables assigned to the call before it is transferred to 

the specified destination. Press the Change button to access the 

Attached Fields panel for selecting these variables. 

• Leave Voicemail 

o The Leave Voicemail Action panel is the Action Editor panel that 

implements a Transfer to VM Action. Transfer to VM actions 

transfer the caller to a specified user’s voice mail recorder. 

o Panel parameters specify the user that will receive the voice 

message. 

o Destination 

▪ This field selects the destination to where the caller is 

transferred. 

▪ Extension or phone# routes the caller to the specified user. 
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▪ Variable or dialog routes the caller based on the value of the 

specified script variable or the  input passed from a 

previously executed dialog. 

o On Failure 

▪ This field determines the script behavior if the MX-E is 

unable to perform the transfer.  

▪ Go to transfers the caller to the dialog that is specified in the 

accompanying entry box. 

▪ Disconnect terminates the call. 

▪ Transfer to Attendant sends the caller to the extension 

specified in the Script Properties window. 

• Dial By Name 

o The Dial by Name Action panel is the Action Editor panel that 

implements a Dial by Name Action. Dial by Name actions transfer 

the call to the user that is requested by the caller.  

o Prompt Options 

▪ In addition to the greeting prompt that is available for all 

types of actions, you can also choose a prompt that will be 

played when the transfer takes place if the user name cannot 

be found or if the system is unable to transfer the caller. 

Select the appropriate tab and press the add button to select 

a WAV file. 

o Name Lookup 

▪ This option determines the method of searching for the user. 

▪ When Search by first name is selected, the auto attendant 

prompts the caller to enter the first three letters of the user’s 

first name. 

▪ When Search by last name is selected, the auto attendant 

prompts the caller to enter the first three letters of the user’s 

last name. 

▪ When Ask caller is selected, the auto attendant asks the caller 

to choose between a first name search and a last name 

search. 

o Number of times a caller can begin new search 
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▪ This option determines the number of unsuccessful searches 

that the system will perform. After performing these 

searches, the system will either go to another dialog, 

disconnect the call, or call the attendant defined on the Script 

Properties window. 

o Before transferring 

▪ This option allows you to choose an audio introduction that 

is played before the caller is transferred. This introduction is 

played after the On Transfer prompt (selected at the top of 

this window). The default setting for this option is configured 

in the Script Properties window.  

▪ Speak the Names of People Found by the Search 

▪ If this option is selected, the auto attendant plays the names 

of users that meet the search criteria and have configured 

their recorded name when setting up their mail box. The 

auto attendant plays these recorded names after a successful 

search and before the On Transfer prompt. 

o On Failure to Transfer 

▪ This field determines the script behavior if the auto attendant 

is unable to perform the transfer. 

▪ Go to transfers the caller to the dialog that is specified in the 

accompanying entry box. 

▪ Disconnect terminates the call. 

▪ Transfer to Attendant sends the caller to the extension 

specified in the Script Properties window. 

▪ Note: If the end users Name/Extension is not recorded their 

extension will not be included. 

• Disconnect 

o The Disconnect Action panel is the Action Editor panel that 

implements a Disconnect Action. Disconnect actions terminates 

calls that are connected to the auto attendant. The only 
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configurable component on the Disconnect Action panel is the 

message prompt selection list at the top of the panel. 

• Web Server Request 

o The Web Server Request Action panel is the Action Editor panel that 

implements a Web Server Request Action. Web Server Request 

actions executes a web script located on a specified web server. 

Parameter values are passed from the web script to the AA script 

for use in the dialog.  

o Web Server Request requires an IVR license 

o Request Panel 

 

▪ The Request panel, specifies the web server that executes the 

web script and the parameter values that the action passes to 

the web script.  

▪ Request panel parameters include: 

• URL: The URL data field lists the name and location of 

the web script. 

• Script Parameter Table: This list identifies the 

parameters passed by the MX-E to the web script. Each 

row corresponds to one web script parameter. Table 

fields include: 

• Script Parameter: This column lists the names of the 

parameters that are passed to the web script. These 

names must match the parameter names defined in the 

web script. 

• Variable: When this field is marked, the value of the 

Variable Name or Value field is a variable. When this 

field is not marked, the value of the Variable Name or 

Value is a constant value that is passed directly to the 

web script. 

• Variable Name or Value: This field specifies the value 

of the parameter passed to the web script. 
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• Fetch Timeout: This field specifies the period that the 

dialog waits for a response from the web script. The 

action transfers to the dialog specified for failure 

conditions if a response from the web script is not 

received. 

• Use Post Method: When this field is selected, the MX-E 

encrypts the variable values that are sent to the web 

server. 

▪ Response Panel 

• Script parameter: This column lists the names of web 

script parameters. The value of these parameters are 

passed from the web script to the AA dialog action. 

These names must match the parameter names 

defined in the web script. 

• Variable name: This column lists the AA action variable 

to which the web script parameter is passed. 

▪ Script Panel 

• The Script panel, displays the parameter values passed 

from the web script to the AA dialog action, provides a 

tool for creating a web script file template, which can 

be edited to create the web script.  

• Script Type: This parameter specifies the scripting 

language used for creating the template. 

• Save generated script as: This parameter specifies the 

name and network location where the MX-E stores the 

template. Press the browse button to view your file 

structure and enter a location through a point and click 

operation with the mouse. 

▪ After Execution Go To parameter specifies the next dialog 

that the script executes if the web script runs successfully 

and all response parameter settings are valid. 

▪ On Failure Go To parameter specifies the next dialog that the 

script executes if the web script does not run successfully or 

if all response parameter settings are not valid. 
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• Assign Variable 

o The Assign to Variable Action panel is the Action Editor panel that 

implements a Assign to Variable Action. Assign by Variable actions 

assign values to Auto Attendant script variables, which are then 

passed to the web script or used in the AA script.  

o Assign Variable requires  an IVR license, and is not part of the basic 

course 

o Assign to Variable specifies the name of the variable, as defined by 

the Variable Definition Table. A drop down menu lists the available 

variable names. 

o Variable specifies the type of value that is assigned to the variable 

by this action. When this field is marked, the value of the Variable 

Name or Value field is a system variable or a value passed by a 

previously executed dialog. When this field is not marked, the value 

of the Variable Name or Value is a constant value that is passed 

directly to the web script. 

o Variable Name or Value specifies the new value of the variable. 

o The Go To field specifies the dialog that receives control of the 

script after the variables settings are changed. 

o The On failure field specifies the dialog that receives control of the 

script if the variable settings cannot be changed. 

• Change Language 

o The Change Language Action panel is the Action Editor panel that 

implements a Change Language Action. Change Language actions 

specify the language spoken by the auto attendant. The set of 

available languages depend on the Language Packs previously 

installed on your system . 

o Change Language action panel parameters include: 

o Language: This field specifies the language that is spoken by the 

auto attendant after this action is executed. 

o then Go to: This field specifies the dialog that receives control of 

the script after the language setting is changed. 

• Fax On Demand 
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o The Fax on Demand Action panel is the Action Editor panel that 

implements a Fax on Demand Action. Fax on Demand sends a 

specified graphics file as a fax transmission to one or more listed 

extensions, phone numbers, or addresses 

o FOD requires an IVR License, and is not part of the basic course 

o Fax File Location 

▪ You can designate any tif file accessible to your MX-E as a 

fax. This section of the panel specifies the location of the tif 

file sent by this action: 

▪ URL routes the caller to the specified user. 

▪ Variable routes the caller based on the value of the specified 

script variable or the input passed from a previously 

executed dialog. 

o Fetch Timeout field specifies the period that the dialog waits for 

the specified destination to make the tif file available. The action 

transfers to the dialog specified for the failure condition if the tif 

file is not available within this period. 

o Send to 

▪ This table lists the recipients of the fax. Each line in the table 

specifies the phone number or address of one recipient. 

Table parameters include: 

▪ Variable specifies the type of value that specifies the phone 

number or IP address. When this field is marked, the 

recipient destination value is a variable. When this field is not 

marked, the recipient destination value is fixed. 

▪ Value specifies the recipient destination. 

o After Execution Go To  

▪ This parameter specifies the next dialog that the script 

executes if the action successfully sends the fax message. 

o On Failure Go To 

▪ This parameter specifies the next dialog that the script is 

unable to send the fax because the tif file did not become 

available before expire of the Fetch Timeout. 

• Repeat Prompt 
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o The Repeat Prompt Action panel is the Action Editor panel that 

implements a Repeat Prompt Action. Repeat Prompt actions repeat 

the dialog prompt and wait for caller input. The only configurable 

component on the Repeat Prompt action panel is the message 

prompt selection list at the top of the panel. 

o Repeat prompt can also be used as “Play a prompt” 

• Wait for Input 

o The Wait for Input Action panel is the Action Editor panel that 

implements a Wait for Input Action. Wait for Input actions wait a 

specified period for further caller input. The only configurable 

component on the Repeat Prompt action panel is the message 

prompt selection list at the top of the panel. 

32.6 Adding the Prompt: 

Either Right click in the “Prompts” area and select “Add”, or click on the Add 

button 

 

Prompts 

• File prompts are specified by selecting a File Prompt Type in the Type 

data entry field and the specific file in the File field. 

o Local files and Text to Speech files can be specified through a drop 

down menu or by pressing the Select button located to the right of 
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the file field. You can also create new Local or Text to Speech files 

by pressing the New button. 

o System prompts are specified by accessing the drop down menu on 

the file field. 

• Internet prompts are specified by entering a URL in the file field. If the 

internet file has been placed into the MX-E internal memory within the 

time specified by the Max Age parameter, that file will be used as the 

prompt; otherwise, the MX-E will download the specified file from the 

internet. 

• Variable prompts are specified by selecting the variable in the data field 

directly below the Variable radio button. After selecting the variable, you 

can determine how the variable contents will be spoken by selecting a 

Format; available formats depend on the selected variable. Examples of 

format include "AS_INTEGER" (variable is spoken as an integer number), 

"AS_DATE" (variable is spoken as a calendar date), or "AS_SPELLING" (each 

letter of the variable text is spoken). If REAL_TIME_TTS is selected, you 

must enter a language in the Language field; this specifies the language 

in which the text will be spoken. 

32.6.1 Creating the Prompt – Option 1: 

32.6.1.1 Using Sound Recorder to create a local file: 

System prompts, Music on Hold and voice mail messages are standard 8 bit wav 

files.  You can use any program you wish to record WAV files for upload to the 

MX-E as long as it can save the file in the following format “CCITT u-Law 8.000 

kHz, 8 Bit”.  The Microsoft Sound Recorder that is included with all versions of 

Windows prior to Windows® Vista® can save files in this format.   

1. Click on the Start Button on your desktop  

2. Select “All programs” then select “Accessories” then Launch “Sound 

Recorder” 

3. Record the message  

4. Then in Sound Recorder click on “File” and select “Save As” 

5. Set the location to your desktop and set the file name to Main 

6. Click on the “Change” button and change the format to CCITT u-Law 

7. Set the attributes field to 8.000 kHz, 8 bit, Mono. 
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8. Click on “OK” then “Save” 

 

Note:  Files saved at too high or too low a volume will have poor playback 

quality. 

32.6.1.2 Selecting a local Wave File:  

1. When the “Prompt” window opens set the “Type” field to Local file. 

2. Click on the “Message Files” icon  in the “Prompt” window. 

3. In the “Message Files” window click on the “Add” button. 
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4. Select the file from your computer and click “Open” 

5. Click “Select” then click “OK” 

32.6.2 Record Message in your voicemail and upload – Option 2: 

1. Leave a message in a voicemail 

2. Download the message via MXIE to your desktop 

32.6.2.1 Selecting a local Wave File:  

1. When the “Prompt” window opens set the “Type” field to Local file. 

2. Click on the “Message Files” icon  in the “Prompt” window 

 

 

3. In the “Message Files” window click on the “Add” button. 

4. Select file from computer and click “Open” 
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5. Click “Select” then click “OK” 

32.6.3 Text to Speech– Option 3: 

1. From the Prompt menu, select Text to Speech 

2. Click on New 

3. Change the name for the output file. 

4. Enter the script that you want to generate 

5. When you are done, click on the Text -> Wav button 

6. Optional – Click on Play to listen to your output file 

7. When you are satisfied, click on OK to return to the previous menu 

     

 
  

32.7 Saving the Script: 

32.7.1 Saving and Uploading the Script: 

1. In the “Script Editor” click on the “Save” icon  
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2. Your script should compile and show you a message indication it compiled 

successfully  

3. Click “OK” then close the “Script Editor” 

 

32.7.2 Saving a script with a new name: 

1. In the “Script Editor” click on the “Save As” icon  

2. Put a check in the Save As function and Change the Name of the script 

to Holidays. 

 

 
 

3. The files will be uploaded using the new filename. 

4. After the script has been renamed, it can be modified to create a new 

script. 
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32.7.3 Saving the Script to the local computer: 

1. In the “Script Editor” click on the “Save As” icon  

2. Put a mark in the Save Locally as button and change the name to Main  

3. Click on Save to save the file to the local computer 

 

 

 

NOTE! When saving a script, insure that the full absolute path is entered. 

 

32.7.4 Uploading a Local File: 

1. From the Auto Attendant Pull Down menu, select Scripts: 

2. Click on the Local Files button. 
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3. Browse to the Location where the files are stored 

4. Select the desired file and click on Open 

5. Save and upload the file:  

– In the “Script Editor” click on the “Save” icon  
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32.8 Scheduling Auto-Attendant: 

The final step is to schedule the auto-attendant and assign scripts based on 

date and time.  Schedules are set within the Auto Attendant →Schedule window.  

All the auto-attendants that have been defined with the Phone Services window 

are listed on the left side of the schedule window.  You can assign scripts by 

highlighting the auto-attendant of choice on the left and adding schedules on 

the right.  Much like the dial plan, the MX-E looks at auto-attendant schedules 

from top to bottom.  You can define different times of the day and days of the 

week, as well as holidays, and assign different scripts for each. 

NOTE: Failure to assign a schedule will result in the call being dropped by the 

MX-E when sent to the auto attendant. 

32.8.1 Scheduling a Script to run on Holidays: 

1. From the “Auto Attendant” menu select “Schedule” 

2. Click on New 

3. Provide a name for the schedule 

4. In the Days Field, Select Holidays 

– Choose a particular holiday, or all holidays 

– Holidays are programed under Configure → Holidays 

5. Select a time for this schedule to run on the holiday 

6. Click on OK 

 

32.8.2 Scheduling a Script to run During Working Hours: 

1. From the “Auto Attendant” menu select “Schedule” 
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2. Click on New 

3. Provide a name for the schedule 

4. In the Days Field, Select Days this schedule should run 

5. In the Time Field, Select the time that this schedule should be enabled 

6. In the Scripts Field, Select correct script you wish to run on the 

programed days and hours 

7. Click on OK 
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32.8.3 Scheduling a Script to run During Non-Working Hours: 

1. From the “Auto Attendant” menu select “Schedule” 

2. Click on New 

3. Provide a name for this schedule 

4. In the Days Field, Select all days of the week (Monday, Tuesday, 

Wednesday, Thursday, Friday, Saturday and Sunday) 

5. In the Time Field, check Active all day  

6. In the Scripts Field, Select correct script you wish to run on the 

programed days and hours 

7. Click on OK 
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32.8.4 Viewing the Finished Schedule: 

 

32.8.4.1 Viewing the Schedule from the Calendar View: (Error! Reference source not f
ound.) 

 

Notice how you can set different scripts to run for the same extension/DID 

according to the time of day, name of the day or even on holidays. Scripts are 

evaluated from the top down. 
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33. Digital Certificates 

33.2 Digital Security Certificates 

Zultys Mobile Communicator™, Outlook Communicator, and SalesForce 

Integration use a Transport Layer Security (TLS) secured connection between the 

mobile device and your MX-E. A digital security certificate is required to enable 

a connection to the MX-E. A security certificate is a digital document assuring 

users that their transmission is encrypted, secure and connected to the right 

server, and it also informs the company that the callers are who they claim to 

be.  

If that certificate has been signed and approved by an independent certification 

authority (CA) then the Zultys mobile client software accepts the two endpoints 

as legitimate and proceeds with the connection. 

Alternatively, the digital security certificate can be self-signed by the company 

and is not validated by a third-party certification authority. In essence, a self-

signed certificate conveys the message, "You can trust me", but forces the user 

to acknowledge and accept that trust whenever connecting to the PBX.* 

* Optionally, you can e-mail to the user a copy of the certificate and have the 

user install it on his/her mobile phone. In so doing, the mobile phone will 

confirm the MX-E server's identity eliminating this step for the user. Please 

refer to your mobile devices product documentation for further details of how 

to store a self-signed certificate. 

Of the two types of certificates, the third-party certificate from a certificate 

authority is preferred. 

Section 33.3 describes how to generate a security key 

Section 33.4 describes how to generate and install a self-signed certificate 

Section 33.5 describes how to generate a request for a certificate from a 

certificate authority 
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Section 33.6 describes how to install a certificate received from a certificate 

authority. 

33.3  Generating a Security Key 

Generating a security Key is a precursor to generating any one of the certificate 

types. 

1. Maintenance -> Security Certificate Management 

 

 
 

2. Generate -> Security Key 

Click on Generate, and select Security Key from the dropdown list 
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3. Click OK to the following popup message 

 

4. Verify Security Key is successfully installed 

Once the Key is generated, the screen will update to reflect this 

information 
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33.4 Generate and Install a Self-Signed Certificate 

1. Maintenance -> Security Certificate Management 
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2. Generate Certificate 

 

3. Generate -> Generate Self-Signed Certificate 
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4. Complete form information 

 

5. Click Generate Certificate 

6. Click OK to the warning popup up message 

 

 
 

7. Click OK to the  confirmation popup message 
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8. Click Close 
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33.5 Generate a Request for a Certificate from a Certificate Authority 

1. Maintenance -> Security Certificate Management 

 

2. Generate a Certificate Request 

 



 

 MX-E Installation Manual (PN:0000507) Revision 11 February 11, 2019 
© 2019 Zultys, Inc. No reproduction or distribution without permission 

Page 299 of 350 

Technical Publications 

3. Complete form 

 
 

4. Click on Generate Request 

5. Click ok to the warning popup 
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6. Save generated Certificate Request 

 

7. Purchase online a certificate from a Certificate Authority. When 

requested, upload the above CSR file. 

8. The certificate authority will download your certificate. 

33.6 Install a Certificate from a Certificate Authority 

1. Maintenance -> Security Certificate Management 

 

 

33.6.1 Upload -> Certificate 

1. Navigate to certificate file location and select 

2. Certificate will display. Check that data shown is correct. 
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3. If required, upload a certificate chain 

33.6.2 Upload -> Certificate Chain 

1. Navigate to  certificate file location and select 

2. Mobile phone connectivity now is enabled. 

34. Security 

While Zultys provides high level security protection for the MX-E system against 

an outside attack, it is still essential to protect the MX-E with a strong 

administrative password and take other preventive measures against 

unauthorized access to the system. This section discusses ways in which the 

channel partner can safeguard an MX-E against unauthorized access for the 

purposes of toll fraud or unauthorized calls. 

34.1 Password Strength 

The following exert from wikipedia.org discusses password strength and 

provides a few useful suggestions for securing the passwords on the MX-E 

system. Original article can be found at 

http://en.wikipedia.org/wiki/Password_strength 

Password strength is a measure of the effectiveness of a password in 

resisting guessing and brute-force attacks. In its usual form, it estimates 

how many trials an attacker who does not have direct access to the 

password would need, on average, to guess it correctly. The strength of a 

password is a function of length, complexity, and unpredictability. 

Using strong passwords lowers overall risk of a security breach, but 

strong passwords do not replace the need for other effective security 

controls. The effectiveness of a password of a given strength is strongly 

determined by the design and implementation of the authentication 

system software, particularly how frequently password guesses can be 

tested by an attacker and how securely information on user passwords is 

stored and transmitted. Risks are also posed by several means of 

breaching computer security which are unrelated to password strength. 

http://en.wikipedia.org/wiki/Password_strength
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As with any security measure, passwords vary in effectiveness (i.e., 

strength); some are weaker than others. For example, the difference in 

weakness between a dictionary word and a word with obfuscation (i.e., 

letters in the password are substituted by, say, numbers— a common 

approach) may cost a password cracking device a few more seconds– this 

adds little strength. The examples below illustrate various ways weak 

passwords might be constructed, all of which are based on simple 

patterns which result in extremely low entropy, allowing them to be 

tested automatically at high speeds: 

• Default passwords (as supplied by the system vendor and meant to 

be changed at installation time): password, default, admin, guest, 

etc. Lists of default passwords are widely available on the internet. 

• Dictionary words: chameleon, RedSox, sandbags, bunnyhop!, 

IntenseCrabtree, etc., including words in non-English dictionaries. 

• Words with numbers appended: password1, deer2000, john1234, 

etc., can be easily tested automatically with little lost time. 

• Words with simple obfuscation: p@ssw0rd, l33th4x0r, g0ldf1sh, 

etc., can be tested automatically with little additional effort. For 

example a domain administrator password compromised in the 

DigiNotar attack was reportedly Pr0d@dm1n. 

• Doubled words: crabcrab, stopstop, treetree, passpass, etc. 

• Common sequences from a keyboard row: qwerty, 12345, asdfgh, 

fred, etc. 

• Numeric sequences based on well-known numbers such as 911 (9-

1-1, 9/11), 314159... (pi), or 27182... (e), etc. 

• Identifiers: jsmith123, 1/1/1970, 555–1234, "your username", etc. 

• Anything personally related to an individual: license plate number, 

Social Security number, current or past telephone number, student 

ID, address, birthday, sports team, relative's or pet's 

names/nicknames/birthdays/initials, etc., can easily be tested 

automatically after a simple investigation of person's details. 

There are many other ways a password can be weak, corresponding to 

the strengths of various attack schemes; the core principle is that a 
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password should have high entropy (usually taken to be equivalent to 

randomness) and not be readily derivable by any "clever" pattern, nor 

should passwords be mixed with information identifying the user. On-

line services often provide a restore password function that a hacker can 

figure out and by doing so bypass a password. Choosing hard to guess 

restore password questions can further secure the password.  

34.2 MX-E Administrator Password 

All MX-E systems ship with the default ‘administrator’ user for the MX-E 

Administrator already programmed on the system. If an unauthorized individual 

gains access to this user’s password, they will gain full control of the system.  

34.2.1 Default Password 

Zultys strongly recommends changing the default administrator password 

immediately after initial deployment of the MX-E system. Try to use a strong 

alpha numeric password that contains both upper and lower case letters. 

34.2.2 Multiple Logins 

Zultys recommends creating a separate login and password for each person 

accessing the MX-E Administrator. This allows you to easily track and identify 

who is logging into MX-E Administrator and making changes. In the event that 

one of the users’ login and password are compromised, you can easily remove 

their administrative privileges. 

34.2.3 Assign proper rights 

Zultys recommends limiting the administrative rights of users who require 

access to MX-E Administrator. Disable the user’s ability to edit all sections of 

MX-E Administrator that do not pertain to their responsibilities. This prevents 

users from “accidently” or “maliciously” making unnecessary changes to the 

system.  

34.3 CDR Password 

Zultys recommends changing the password for the CDR Database. To change 

the password, navigate to File -> CDR Settings and click on the Change MX-E 
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CDR Login tab to change both the login and the password for accessing the 

database. 

 

34.4 User Passwords 

Administrators should stress the importance of a “strong” password to all the 

users on the MX-E system. While an average user may not see the importance 

of securing their login credentials, exploited user passwords constitute the 

majority of security issues facing administrators of the MX-E system. 

34.4.1 MXIE 

The password used to log into MXIE can also be used to log into other MX-E 

Administrator as long as the user in question has administrative privileges. 

MXIE password is also used to log into Zultys Mobile Communicator, Zultys 

Salesforce Communicator, Zultys Outlook Communicator and Zultys Flex 

Communicator.  

Zultys recommends using a strong alpha numeric password that contains both 

upper and lower case letters. It is inadvisable to set a user’s password to be 

identical to their PIN number. 

34.4.2 PIN 

The PIN number is used to check the user’s voicemail box from a phone or log 

into a call group via a phone’s preprogrammed login button. The users PIN 

number with their User ID are used to register softphone. Depending on 



 

 MX-E Installation Manual (PN:0000507) Revision 11 February 11, 2019 
© 2019 Zultys, Inc. No reproduction or distribution without permission 

Page 305 of 350 

Technical Publications 

configuration, a compromised PIN number can be used to access other sensitive 

services. For more details see Section 34.9.  

Zultys recommends using 6 digit-long PIN numbers to increase the security of 

users’ PINs. MXIE user passwords should never be the same as the users PIN 

number. 

34.4.3 Password Policies 

Administrators can set a strict password policy for all users on the MX-E 

system. The policies are configured per user profile.  

In MX-E Administrator, navigate to Configure -> Users and select the Profile. 

Zultys recommends implementing the following password policy for all user 

profiles.  

• Set minimum password length to 6 characters  

o 8 to 10 character-long passwords are preferred 

• Set the password to expire every 90 days 

• Enable the Do Not Allowing Password = Extension option 

• Enable the Do Not Allow Repeating Digits in Password option 

• Disable the Allow Digit Passwords Only option 

 

Password policies should be implemented in ALL profiles. When you create a 

new profile, copy the default profile with the password policies already in place. 

It is important to note that Password Policies only apply to passwords only, not 

PIN numbers.  
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 Password Policies will not have any effect if LDAP integration is enabled. Do not 

configure these settings if you are using LDAP. 

34.4.4 LDAP Integration 

To simplify management of user passwords, including MXIE passwords, Zultys 

recommends implementing LDAP authentication. LDAP integration uses your 

Windows Active Directory, or LDAP server, to authenticate all user logins. In this 

scenario users only need to login once to access all of their secured accounts. 

However, there is a risk that if the LDAP server is unavailable, users will not be 

able to log into MXIE. 

Note that LDAP authentication manages only user passwords and not PIN 

numbers. It is the user’s responsibility to manage and update their PIN numbers 

regularly.  

If LDAP authentication is used, you do not need to set the password policies in 

user profiles as seen in Section 34.4.3. In particular, do not set the password 

for a user to expire in MX-E Administrator. 

34.5 Call Handling Rules, Find Me Follow Me and Call Forwards 

Zultys Technical Support has encountered instances where Call Handling Rules, 

Find Me Follow me, and Call Forwarding functions has been implemented by 

unauthorized individuals to initiate toll fraud or make unauthorized calls. In the 

event there is a possibility of a security breach, Zultys recommends that the 

system administrator first investigates the call handling rules that are currently 

configured on the MX-E system. 

Call Handling Rules, Find Me Follow me, and Call Forwarding functions can be 

implemented on the MX-E side (server side) or on the user’s device (client side), 

both should be investigated separately. 

Upon request, Zultys Technical Support may be able to assist administrators of 

a compromised system by putting together a report on all call handling rules 

configured on the MX-E system. 
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Review both the call handling rules set up on the MX-E system in either MXIE, 

MX-E Administrator or via DTMF Controls and the device-level call handling 

rules set up via the web interface. 

34.5.1 Device Level Forwarding 

Call forwarding can be implemented on the device level. If a remote phone is 

compromised, in most cases the unauthorized individual sets up call forwarding 

from the web interface of the device in question. If you suspect that a device 

has been compromise, you should investigate at the device level. 

34.6 MX-E Security Options 

This section details some suggested Security settings for the MX-E system. 

34.6.1 Disable TFTP for public access 

Zultys highly recommends disabling public access to the TFTP server, unless it 

is required for use with remote devices. 

It is important to remember the MX-E TFTP Directory by design is READ ONLY.  

It is impossible to change this, as a result unauthorized changes to the files in 

the TFTP Directory can be made by simply uploading a new file to the TFTP 

Directory. 

If there are little to no changes required for the remote devices on the system, 

it is recommended to disable TFTP for public access, for more information see 

Section 34.11.3.  

TFTP can be disabled via MX-E Administrator. Navigate to Provision -> Firewall 

and NAT and open the Service Protection tab. To disable public access, click on 

the box in the TFTP row corresponding to the public address of the MX-E. If you 

are using SBC or port forwarding options, this will need to be done on the 

firewall/router that is providing the NAT services. 
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34.6.2 Disable/Limit SIP Access 

You may be able to disable or limit SIP access from the public address of the 

MX-E to strengthen the security of the system. This setting is accessed from the 

Service Protection tab in MX-E Administrator in Provision -> Firewall and NAT. 

Because SIP access is required for some day-to-day operation, only disable it in 

the following situations:  

• If the system has no remote devices and is not using SIP trunks, disable 

SIP on the public IP address. 

• If the system is only using SIP trunks, with no remote devices, place the 

MX-E behind a firewall, and limit SIP access to only the IP addresses used 

by the SIP carrier. 

• If the system is using static IP addresses for remote devices, for example 

if the remote devices are deployed at another office location, then place 

the MX-E behind a firewall, and limit SIP access to only the IP addresses 

used by the office in question. 

34.6.3 Properly Define Networks in SBC 

Make sure that when defining the networks used by the SBC, you define the 

exact network address. 
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For example: if the network used by your MX-E system is 192.168.1.0/24 and 

you have several other networks which have inbound traffic from the internet 

but do not require SIP services from the MX-E. In this example, you should 

define the network in SBC as 192.168.1.0/24. Do not use the default address of 

192.168.0.0/16. 

34.6.3.1 Define Trusted and Untrusted Networks 

For MX-E Release versions 7.0 and later, Zultys recommends defining Trusted 

and Untrusted Networks in SBC settings. If SIP requests (REGISTER, INVITE, or 

SUBSCRIBE) arrive from an untrusted network they will require forced authorization. 

This behavior is not applied to defined ITSP/SIP servers. It is assumed that all 

configured ITSP/SIP servers are always trusted (even if ITSP has an address that 

belongs to an untrusted network). Networks defined as Trusted do not require any 

authentication. Incorrectly defining your trusted networks can lead to the ability 

to override the requirement to authenticate. 

34.6.3.2 Set the option to require authentication from untrusted networks 

By default the option to require authentication of untrusted networks is NOT 

enabled.  Zultys recommends enabling this option in SBC. As indicated below 

SIP servers and ITSPs are excluded from this requirement. 

 

Every time a new network is added to the table in SBC window, it is marked as 

trusted by default. If a network is not listed in SBC, it’s considered untrusted. 
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So, if the MX-E receives a request from an IP address which does not match any 

networks listed in SBC, the request will be either authorized or ignored. 

In the Networks section of the SBC window, select whether requests from 

untrusted networks are ignored or authenticated. 

Authenticate all traffic from untrusted networks: If this option is selected, all 

requests that come from untrusted or unlisted networks will be always 

authorized even if the password for the user or device is not set. 

Block all traffic from untrusted networks: If this option is selected, then the MX-

E system will ignore all requests from untrusted networks. Exceptions to this 

rule are requests from ITSP/SIP Servers and requests from IP addresses to which 

requests were generated during previous SIP sessions (for example: some 

transfer scenarios require additional requests from clients which are not 

necessary to authorize). 

34.6.4 RTP Traffic 

RTP Traffic is not encrypted. Zultys recommends having the devices on a 

separate VLAN from the data traffic in situations when the RTP Security is a 

concern. For remote devices, Zultys recommends using hardware VPN to 

encrypt the tunnel in which the RTP travels. 

34.6.5 SIP Registration / Digest Authentication 

SIP registration with authentication is required. All passwords are encrypted 

using the SIP standards. The HTTP digest authentication scheme is documented 

in RFC2617 and extended in RFC 3310 

34.7 Auto Attendant Options 

Consider disabling the ability to dial a pattern of ??? (3 digit extensions) for 

transfers in “From Root Dialog” settings. This setting could become an issue if 

your dial plan also allows 3 digit dialing to the carrier for “411”.  

Likewise, consider disabling the No Match option transfers in “From Root 

Dialog” settings. 
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34.8 Conference Server and Voice Mixer 

An unauthorized individual may be able to exploit the conference server and 

voice mixer ports and set up unauthorized conferences. One way to prevent 

this is to set the voice mixer and conference ports to be controlled by auto 

attendant during off work hours, since majority of “hacking” cases happen 

during the night. 

Zultys recommends disabling the ability to link toll free calls to the conference 

server for unmanaged/repeating conferences or the voice mixer to minimize 

the risk of unauthorized conferences accruing toll free charges. 

34.8.1 Voice Mixer 

Note that exposed voice mixer ports or extensions could be exploited. Voice 

Mixer ports do not have any security on them, as no password or PIN is 

required to join the conference like the conference bridge.  

34.8.2 Conference Server 

There is also a possibility that a Repeating Conferences can be exploited by 

someone who has knowledge of the PIN or access code to join the conference. 

Be mindful when distributing this information. 

34.9 User Rights 

When setting up user rights, it is recommended to carefully review the rights 

assigned to each user, and make sure that they are given access only to the 

features necessary for their job requirements. If you are providing “Higher Risk” 

permissions to a user, make sure the customer fully understands the risks. 

The following user rights are considered “Higher Risk” and should be limited to 

users who absolutely must have access to them. 

• “Can return calls from voicemail”  

o This is a permission that allows a user to log into their voicemail 

box, and make calls from it. All rights and permissions this user 

has will be used when making the call.  

• Access to the MX-E Administrator to make changes 

• DTMF Controls -> Call Forwarding Control 
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o Allows the user to set up a call handling rule to forward all calls to 

a number of their choosing from Voice Mail. 

• “Can Register Softphone” 

o This is used to enable MXIE Softphone, Zultys Mobile 

Communicator for iPhone/Android with softphone. 

o This feature allows MXIE Username and PIN to be used to register a 

softphone or an unauthorized device. 

• Call restrictions that are “open” 

o The user has little to no call restrictions in place for 900, 

international calls, 411, and operator assisted calls. Be mindful of 

allowing users to make calls that can accrue large phone charges. 

• “Bind to external number” 

o This feature could be exploited. In a situation where MXIE login is 

compromised and bound to a PSTN number, the hacker can make 

unauthorized calls.  

34.10 Dial Plan 

When setting up the dial plan, Zultys recommends that you apply restrictions or 

block numbers that can be “expensive” such as 900/976, international 

numbers, as well as 411. 

• International calls 

o At minimum, apply an MX-E account code that is forced and 

verified. 

o Or block the call completely if international calls are not required. 

• 900 Numbers 

o At minimum, apply an MX-E account code that is forced and 

verified. 

o Or block the call completely if 900 calls are not required. 

• Make sure all options are covered for patterns that you are restricting 

o Options to dial as 9+ number. 

o Options to dial as just 10 digit number. 

o Options to dial as 11 digit number. 
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34.11 Device Security 

Zultys recommends securing devices, to stop or block unauthorized devices 

from registering to the MX-E system. Most importantly when using remote 

devices, make sure they are using “strong” passwords for both the User and 

Administrator access to the device. 

34.11.1 Registering a device as extension number or user name 

Zultys discourages allowing devices to be registered as a user’s MXIE Username 

or as a user’s extension number and MXIE Password. By default this option is 

disabled. 

34.11.2 Require SIP Proxy password for ALL devices 

External devices by design are required to have a SIP Proxy password, but it is 

recommended to also apply this restriction to internal devices as well. To 

enable this option, in MX-E Administrator navigate to Provision -> SIP and RTP 

-> SIP Settings and select “Authenticate Manage Devices” option. This will 

require internal devices to be challenged when registering to provide the SIP 

Proxy Password. Be default this option is disabled, and internal devices are not 

challenged. There are two options for MX-E authentication of Trusted Networks: 

Authenticate Unmanaged Devices: Unmanaged devices can be registered with 

an MX-E only if the registered address is a valid MX-E user ID or a valid MX-E 

extension number. Selecting this option requires that the user provide a correct 

password when registering the device. 
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Authenticate Managed Devices: Selecting this option requires the user to 

provide a correct password when registering the device. 

The above settings have no effect for “untrusted” or “external” requests. 

 

34.11.3 Strong SIP Proxy Password 

While it is possible for an unauthorized individual to user ‘brute force’ hacking 

to compromise a device, to do so they would need break both the device’s MAC 

address and the password. By using a “strong” password it is possible to make 

the “hacker’s” job much harder and therefore discouraging them from 

attempting to compromise the device. 

As a side note, the MX-E has built-in ability to “block” or not respond to this 

type of hacking, which will serve as your first line of defense in the event of a 

‘brute force’ hacking attempt. 

34.11.4 Device Default Passwords 

Devices that are “naked” on the internet—that is directly assigned a public IP 

address—should always have their default administrator and user passwords 

changed. The manufacturer’s default passwords are public knowledge and 

sometimes even “blank” making it easier to hack the device unless the 

password is changed. With a call forward enabled on the device, all they hacker 

has to do is dial the extension number from the auto attendant, and the call is 
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forwarded by the device to the number of the “hackers” choosing, assuming the 

dial plan permits it. 

Some devices allow calls to be placed from the web UI of the device, but on 

some phone models these calls cannot be transferred afterwards. This is 

another reason to change the default user and admin passwords. 

34.11.5 Should a device be compromised 

Should a device become compromised, Zultys recommends resetting the device 

to its factory default, so that it returns to the configuration setup by the MX-E 

Administrator. This will remove all configuration options added by the hacker.  

Zultys also recommends changing the device registration name and all SIP 

proxy passwords. Also change all device user and administrator passwords. 

For a ZIP5 device, you can review the “Local configuration” file from the device 

itself to see what was changed from the MX-E configuration settings. Hackers 

can implement all kinds of different options to control the phones which 

include: 

• XML call setup and control 

• XML Configuration options 

• Call forwarding rules 

• Change in user or administrator passwords 

34.11.6 Devices “Naked” on the internet 

SIP devices should never be fully exposed on the internet (save for testing), 

since they are susceptible to SIP attacks. You can identify a “Naked” device can 

by reviewing the device status in the MX-E Administrator. Navigate to Configure 

-> Devices. If a public address for the device is displayed in the “Contact Field” 

for that device, it may be exposed. Some ALG functions will show the public 

address in the contact field but not expose the device. 

Below is an example of a device “Naked” on the internet 
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35. MX-E Redundancy 

When discussing MX-E Redundancy, it is important to understand the 

terminology used in this manual and in general for MX-E Redundancy. This 

includes: 

• Primary Node: A Primary or Master Node is the node that contains all 

of the data including but not limited to the Database, Dial Plan and 

Licensing. It may also be referred to as Master Node. The Primary 

Node is the first system configured in Redundancy. The Primary Node 

provides the configuration settings, network settings, system IP 

address, user list, managed device list, dial plan, PSTN circuitry, and 

all other parameter settings for the Redundancy. 

Redundant Node: A Redundant Node is the node that is a mirror 

image of the Primary Node. In the event of the Primary Node failing, 

the Redundant Node will assume this position and functionality. It 

may also be referred to as Standby Node. When routed through an 

XRS12 switch, the PCM circuits on the Redundant Node can replace 

the PCM circuits of a failed Primary Node. If the option slot circuits on 

the Redundant Node are configured identically to the Primary Node, 

then the Redundant Node circuits can be utilized a well. 

• Master State: This mode specifies the operational status of the MX-E 

master node. 

• Redundancy State - This mode specifies the operational status of the 

MX-E Redundant/Standby node. 

• Switchover - The Redundant Node has replaced the Primary Node or a 

Redundant Node. 

 

MX-E Redundancy requires that a redundant license, part number 90-15350, is 

installed on the Primary Node. 

All license management, for all nodes is done via the MX Administrator using 

the Main IP Address of the MX-E Redundancy. 
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MX-E Redundancy has several requirements that need to be followed in order to 

be properly set up and function. Not following these recommendations will 

make the system ineligible for support of any kind from Zultys technical 

support. 

• All nodes must be on the same LAN. 

o No VPN connections between nodes. 

o Same subnet. 

o Same location. 

o Same power source. 

o Same switch. 

o It is recommended to have dedicated Switch for the Redundancy. 

• The Primary and Redundant nodes must have an unused and unique IP 

address. 

• The Primary IP address of the MX-E Redundancy cannot be the same as 

the Primary Node or Redundant node IP address. 

• All networking devices must support Gratuitous ARP (GARP). 

• All nodes must be properly licensed. 

• The Primary/Redundant nodes must be in bridging mode (utilize Ethernet 

connector 1 on both nodes) . 

• The Primary/Redundant nodes must be running the same version of MX 

software. 

• FXO circuits must be deployed on the Primary Node only. 
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MX Administration 

There are two (2) main steps to creating the Redundancy, create the new 

redundant Master and then join the Standby system to the Redundancy. 

Master System:  

• MX Administrator\File\MX Redundancy 

• Click Create 

 

 

• Enter the desired system ID (make a note as you will need this 

information for the Standby system) 

• Enter the desired Main IP (must be unique) 

• Enter the Primary node IP (must be unique and cannot be the Main IP 

address) 

• Enter the Redundant Node IP (must be unique) 

• Select if an XRS-12 is used. If so, enter the IP address and MAC address 

of the XRS-12 unit 

• Click Finish 
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• Click yes at the Confirm windows: 

 

 

 

 

 

 



 

 MX-E Installation Manual (PN:0000507) Revision 11 February 11, 2019 
© 2019 Zultys, Inc. No reproduction or distribution without permission 

Page 320 of 350 

Technical Publications 

 

 

• Once the Redundancy has been created and the Primary system is back 

online, access the MX Administrator of the desired MX-E to be the 

Standby system. 

• MX Administrator\File\MX Redundancy 

• Click Join 

 

 

 

• Select Join existing MX Redundancy System 

 

• Enter the Redundancy System ID 

 

• Select the Join as drop down and select Redundant 

 

• Click Next 



 

 MX-E Installation Manual (PN:0000507) Revision 11 February 11, 2019 
© 2019 Zultys, Inc. No reproduction or distribution without permission 

Page 321 of 350 

Technical Publications 

 

 

• Click Yes to confirm. 
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Redundancy Monitor 
The Redundancy Monitor window displays the Primary/Redundant Nodes and 

their status. You can perform controlled switchovers and switchbacks, monitor 

the redundancy status, observe the Redundant configuration, and disband the 

Redundancy from the Monitor. 

To access this window, select File/MX Redundancy from the main menu. 

 

 

Status Parameters 

The top section of the Redundancy Monitor identifies and provides status 

information about it. 

System ID: This parameter indicates the identification number of the 

Redundancy. Member nodes must use this number when joining a redundancy. 

Master State: This mode specifies the operational status of the MX-E master 

node. 
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Redundancy State - This mode specifies the operational status of the MX-E 

Redundant/Standby node. 

 

• Switched Standby – This setting indicates the Redundant Node has 

assumed the role of a Master or Member node. The replaced node 

assumes the standby role. If the Standby Node is operational, it can 

protect against the failure of the Redundant Node. A switchback 

operation must be performed to restore full redundancy protection to the 

redundancy. 

• Redundancy Operational – This setting indicates that the Redundant Node 

is operational, the redundancy is in Normal mode, and the redundancy is 

protected against the failure of the Primary or Redundant Nodes. 

• No Redundancy License – This setting indicates that the current system, 

although configured for redundancy, cannot provide redundancy 

protection because a valid redundancy license does not exist on the 

Primary or Redundant Nodes. 

• Master Selection Required – This setting indicates that, after a Master 

Node switchback, the Primary and Redundant Nodes have each attempted 

to operate as the Master Node. Full redundancy protection is not provided 

in this state. To select one of the nodes as the permanent master, press 

the Master selection button at the bottom of the panel. 

Redundancy Node table 

The Redundancy Node table lists the attributes of each MX-E system. Each row 

represents one MX-E system. The rows are ordered by the role of the system. 

The top row is always the Master Node. In a redundant system, the bottom row 

is always the Standby Node.  

Type: This column identifies the MX-E systems as the Primary or Redundant 

Node. 

Role: This column indicates the function of the MX system. The Master Node is 

always at the top of the list. The Standby Node, if operational, provides 

redundancy protection to the Primary. In Normal mode, the Standby Node is the 
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Redundant Node. In Switchover mode, the Standby Node is the system that was 

replaced. 

MX side Ports: Routing telephony circuits from each node through an XRS12 

Metallic Switch to the PSTN protects the redundancy’s access to these circuits if 

a redundant system fails. This parameter specifies the set of XRS12-MX ports to 

which the MX system’s telephony circuits are connected. 

CO side Ports: This parameter specifies the XRS-CO ports to which the node’s 

telephony circuits are routed. These ports typically connect to the PSTN. 

Normally, the CO side port numbers are identical to the MX side Port numbers 

for Master and Member nodes unless the redundancy is in switch over mode. 

Node IP: This parameter indicates the Main IP address of the redundancy. 

Serial Number: This parameter indicates the IP address of the MX system. 

State: This parameter indicates the operational status of the MX system. The 

following state values are listed in order of functionality: 

• Operational – This status indicates that the MX system is operating 

normally. 

• Initializing – This status indicates that the MX system booted up properly 

and is now initializing. 

• Upgrading – This status indicates that the MX system is upgrading its 

software. 

• Booting – This status indicates that the MX system is booting up. 

• Waiting for node – This status indicates that Redundancy was unable to 

locate the MX system at the provided IP address. 

• Failed – This status indicates that the MX system is not functioning 

properly or was unable to boot up or initialize. 

XRS-12 Switch table 

The Metallic Switch table, when displayed by the Redundancy Monitor, lists the 

XRS12 switches that support the redundancy specified by the monitor. Each 

XRS12 switch must reside on the same subnet as the redundancy. 
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IP Address: This parameter indicates the IP address of the XRS12 switch. 

MAC Address: This parameter indicates the MAC address of the XRS12 switch. 

Status: This parameter indicates the operational status of the XRS12 switch. The 

status variable is set to one of the following values: 

• Operational – This status indicates that the switch is operating normally. 

• Upgrading – This status indicates that the switch is upgrading its 

software. Although PSTN redundancy is disabled until the upgrade is 

completed, PSTN service is not disrupted. 

• Unknown – This status indicates that the redundancy is unable to locate 

the XRS12 switch at the configured address. 

Click Configure button to edit the parameters of the XRS12 switches in the 

redundancy. This is required when replacing a switch or changing the IP 

address. Changing the XRS12 IP addresses will cause the redundancy to reboot 

the XRS12, but the systems within the redundancy do not reboot. 

Editing the Redundancy Monitor 

Operations that can be performed from the Redundancy Monitor include 

editing, disbanding, switchovers, switchbacks, and shutting down the Standby 

node, and selecting a Master Node. To edit the Redundancy configuration, click 

the Configure button and Edit configuration  
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Disbanding the Redundancy 

This operation removes the Redundant relationship between the nodes and 

places each in standalone mode. The Primary Node retains the data as 

configured for the entire redundancy. The Redundant Node retains the data that 

was stored within their MX system prior to the creation of the Redundancy. The 

Redundant Node is cleared of its configuration and data. 

• To disband, press the Disband button from the list of options provided by 

the Configure button.  

 

• Confirm the procedure at the warning message: 

 

Switch Over 

The switch over operation replaces the specified Primary Node with the 

Redundant Node. A switchover is automatically performed if the Primary Node 

fails.  

To perform a controlled switchover, select the Primary Node in the table, right 

click the mouse and select SwitchOver to standby, or select SwitchOver selected 
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node to Standby from the Standby node button. You can only perform a 

switchover if the Redundancy State is Redundancy Operational. 

 

Switch Back 

The switch back operation is performed when the redundancy is in the switched 

over state to re-establish redundancy. The node that was replaced by the 

Redundant Node must be operational in order to perform the switch back. 

To perform a switchback, click the Switch Back link from the Standby node 

button . If the button is inactive, the redundancy is not in Switchover mode or 

the switched MX system is not functional as a redundancy node. 

Shutdown Standby 

The Standby node button allows for shutting down the MX-E system operating 

as the Standby role. When you restart the system, the system attempts to rejoin 

the Redundancy. 

Master System Selection 

If the Primary and Redundant Nodes simultaneously attempt to act as the 

Master Node, Redundancy automatically assigns one mode as the Active Master 

and the other to Passive Standby status. In this state, the Standby Node is not 

mirroring the Master Node, which disables redundancy. The Master Selection 

button is visible only when the Redundancy State is Master Selection Required. 

Click this button to select a permanent Master Node and restore redundancy. 
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1:1 Redundancy 

A single XRS12 switch is required to protect four PCM circuits from the Primary 

Node. If you are using redundant with PCM circuits, Zultys recommends using 

an XRS12. The XRS12 is a physical relay switch used to switch over the PCM 

circuits. There is no GUI or configuration on the XRS12. Configuration for XRS12 

is transferred from the MX system to the device on boot up. When the XRS12 is 

booted, it will get an IP address via DHCP, and use option 66 to download its 

configuration file. DHCP with option 66 is a requirement for installing an 

XRS12. Once the XRS12 has received its configuration file, it will use its static IP 

address. It is required that the MAC address of the XRS12 is programmed in the 

MX and set correctly. 

Redundancy protection for the PCM circuits in your redundancy requires an 

XRS12 switch. The following sections specify the recommended XRS12 

connection configurations. Each XRS12 switch must reside on the same subnet 

as the redundancy. 

Integrating with XRS12 

 XRS12 Ethernet 

The XRS12 is a metallic switch that connects the MX-E PCM circuits from the 

Redundancy to the PSTN. If the primary system fails, the XRS12 replaces the 

PSTN circuits from that Node with the PSTN circuits from the Redundant Node. 

The XRS12 switch is not a mandatory redundant of a redundancy if PSTN circuit 

redundancy is not required. 

The XRS12 comprises 13 input ports and 8 output ports 

• 12 input ports receive T1 signals from the MX250 system 

• 1 input port receives a control signal from the LAN 

• 8 output ports sends T1 signals to the Central Office 
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The PCM circuits from the Primary and Redundant Nodes connect to MX Side 

Ports 1-8. During normal redundancy operation, these input ports connect 

directly to the eight CO Side Ports. PCM circuits from the Redundant Node 

connect to MX Side Ports 9-12 

These ports do not connect to the CO Side Ports unless the Primary Node or one 

of the Redundant Nodes fails. In this case, the XRS12 switches the input ports 

from the Redundant Node to replace the PCM signals from the failed system. 

10/100Base-T 

The XRS12 has one 10/100Base-T Ethernet circuit that connects the XRS12 to 

your LAN. The XRS12 receives switching commands from the MX250 and 

communicates the operational status of the internal switch over the Ethernet 

circuit. The circuit does not supply Power over Ethernet. 

PSTN Circuits 

The XRS12 has 20 RJ45 connectors that transport telephony signals between 

MX-E systems and the PSTN. Each connector supports a PRI transmission. 

• MX Ports: MX 1 through MX 12 connects to a MX250 PCM circuits. 

• CO Ports: CO1 through CO8 connect to a PSTN facility compatible with 

MX port circuits. 

PCM RJ45 Pin Assignments 

The image below shows the pin assignment and placement of the RJ45 

connectors when transmitting PCM data. All connectors have the same PCM pin 

assignment.  
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Pin Description of a PCM RJ45 Connector 

Pin  Signal Name  MX Port 

Source  

CO Port 

Source 

RJ45 Connector Diagram 

1  Received Data, ring  XRS12  Facility 

  

2  Received Data, tip  XRS12  Facility 

3  Not connected      

4  Transmitted Data, 

ring  

MX250  XRS12 

5  Transmitted Data, 

tip  

MX250  XRS12 

6  Not connected      

7  Not connected      

8  Not connected      

 

Use a PCM crossover cable when connecting two XRS12 ports to create a 

feedback loop for PCM transmissions. Verify that pins 3, 6, 7, and 8 on 

each cable end are not connected to any pin on either end of the cable. 

It is not recommended to use a CTA5 cable for the PSTN connections as it 

will create circuit errors. You must use a proper PCM cable. 

The image below displays PCM circuit connections and pinouts typically used 

for terminal and network equipment. Use a straight PSTN cable to connect the 

XRS12 to MX-E systems and to existing terminal systems (such as a PBX). Refer 

to device documentation to confirm pin assignments.  

Wiring PCM Circuits to the Network or Other Equipment 

  

M

X

-E 
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Connecting the XRS12 to an MX-E Redundancy 

Configuring an XRS12 

There is no configuration that is done on the XRS12 itself, all configuration is 

done in the Redundancy configuration wizard on the MX-E. The XRS12 relies on 

DHCP with option 66 referencing the MX-E for the XRS12 to download its 

configuration. The MX-E creates a configuration file on the Primary Node for 

the XRS12 to download. 

XRS12 used in a 1:1 Redundant Redundancy 

The image below displays the connection of two MX-E systems to an XRS12 

switch in a 1:1 Redundancy. PCM cards must be placed in each MX-E and 

connecting cables must be routed as below. Straight cables are required to 

connect the XRS12 to the MX-E systems. 

If an Redundancy node fails, the Redundancy performs a switchover. The 

Redundant Node functions in place of the failed node and the XRS12 switches 

Redundant Node’s PCM circuits to replace circuits from the failed node. Port 

LEDs for failed node ports turn off, while Redundant Node’s LEDs turn green. 

• Primary Node PCM Circuit 1 connects to XRS12 Port 1 

• Primary Node PCM Circuit 2 connects to XRS12 Port 2 

• Redundant Node PCM Circuit 1 Connects to XRS12 Port 9 

• Redundant Node PCM Circuit 2 Connects to XRS12 Port 10 

• Telco PCM Circuit 1 Connects to XRS12 Telco Circuit 1 

• Telco PCM Circuit 2 Connects to XRS12 Telco Circuit 2 
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XRS12 in a 1:1 Redundant Redundancy Configuration 

  

  



 

 MX-E Installation Manual (PN:0000507) Revision 11 February 11, 2019 
© 2019 Zultys, Inc. No reproduction or distribution without permission 

Page 333 of 350 

Technical Publications 

36. Regulatory Approvals 

 

33.1 EMC 

U.S.A.: 

FCC Class A Notice 

This device complies with Part 15 of the FCC Rules. Operation is subject 

to the following two conditions: 

1. This device may not cause harmful interference. 

2. This device must accept any interference received, including 

interference that may cause undesired operation. 

Note: This equipment has been tested and found to comply with the limits 

for a Class A digital device, pursuant to Part 15 of the FCC Rules. These 

limits are designed to provide reasonable protection against harmful 

interference when the equipment is operated in a commercial 

environment. This equipment generates, uses, and can radiate radio 

frequency energy, and if it is not installed and used in accordance with the 

instruction manual, it may cause harmful interference to radio 

communications. Operation of this equipment in a residential area is likely 

to cause harmful interference, in which case the user will be required to 

correct the interference at his own expense. 

Modifications: Any modifications made to this device that are not 

approved by Oracle may void the authority granted to the user by the FCC 

to operate this equipment. 

Canada: 

ICES-003 Class A Notice - Avis NMB-003, Class A 

This Class A digital apparatus complies with Canadian ICES-003. 
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Cet appareil numérique de la classe A est conforme à la norme NMB-003 

du Canada. 

Australia/ New Zealand 

AS/NZS CISPR 22:2009 + A1 :2010 for Information Technology 

Equipment. 

CE 

EN 55024:2010 

EN 300 386 V1.6.1  (20112-04) 

EN 55022:2010/AC :2011 

EN 61000-3-3:2008 

36.2 SAFETY 

UL 60950-1, 2nd Edition, 2011-12-19 (Information Technology 

Equipment - Safety - Part 1) 

CSA C22.2 No. 60950-1-07, 2nd Edition, 2011-12 (Information 

Technology Equipment - Safety - Part 1) 

IEC 60950-1(ed.2) 

IEC 60950-1(ed.2);am1 

CB CERTIFICATE # US-23669-UL 

36.3 TELECOM 

U.S.A. 

FCC 47 CFR, Part 68 

TIA-968-B – August 2009,  

TIA-968-B-1 (Addendum to TIA-968-B), August 2012 

TIA-1096 
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37. SRTP 

The Secure Real-time Transport Protocol (or SRTP) defines a profile of 

RTP (Real-time Transport Protocol), intended to provide encryption, 

message authentication and integrity. SRTP provides an extra layer of 

security for real time voice/fax traffic. 

SRTP in MX Release 13.0.2 allows ZIP3/Polycom, MXIE/ZAC softphone phone to 

phone calls to be encrypted for additional security. In addition, Codec profiles 

that utilize SRTP can be created for external SRTP traffic. 

Administration 

MX Administrator Configure\Devices\Profiles 

• Select a ZIP 3 or Polycom profile 

• Go to the Audio & RTP tab 

• Check the Voice Encryption (SRTP) item 

 

• Click OK then Apply 
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MX Administrator\Provision\Codecs\Codec Profiles 

Secure Codec profiles can be setup in the Codec Profile area. 

You can create secure codec profiles for: 

• G.711 U-law 

• G.711 A-law 

• G.729A  

 

 

Note: Zultys has not performed any certifications with ITSPs or other 

external sources utilizing SRTP codecs. 
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38. Web Based User Portal 

This feature allows a user to access via a web browser a portal to perform 

viewing/administration functions of certain user features. These features are 

address book, call handling rules, and voicemail notification rules. 

MX Administrator 

Provision\System Settings\Web Services 

Check the “Enable Web Services” item and click Apply. 

 

 

• Make sure that Port 443 is accessible! 

• Insure there is a security certificate installed for HTTPS. 

Login to User Portal 

• From a browser, type the domain name or IP address of the MX system in 

the URL bar: 

• You will reach the MX system landing page. 
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• Select the Userportal option on the page 

• Enter the user login information: 

• Username/password 

• Click LOG IN 
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After a successful login with the user name and password, the main user portal 

is presented:  

 

 

 

• To Logout of the portal, click the LOGOUT button. 
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Address Book 

This allows users to view the contacts in the system. The user can view contact 

name, Extension, Mobile phone, and location. 

They can also utilize the search function to search for a particular contact. 

 

Call Handling Rules (CHR) 

This area allows a user to create, modify, or delete their call handling rules 

(CHR). 

 

Create: 

To create a new call handling rule: 

 

Click the icon. 
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Enter the rule name at the top of the screen. You must delete the existing text 

first. 

 

Check the desired Event(s) that apply to the rule. Note that if you select 

Incoming call, that is the only selection allowed. You may combine the Using 

phone and No Answer events. 

As you enter Events, the Rule Description area will update. Depending on the 

selection, additional information may need to be added in this area. Information 

will be highlighted in this area when input is required. 

Check the desired Conditions for the rule. As you enter Conditions, the Rule 

Description area will update. Depending on the selection, additional 
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information may need to be added in this area. Information will be highlighted 

in this area when input is required. 

Check the desired Actions for the rule. As you enter Actions, the Rule 

Description area will update. Depending on the selection, additional 

information may need to be added in this area. Information will be highlighted 

in this area when input is required. 

 

 

 

• Click Save when you are finished creating the rule. 

• The new rule will now appear in the list of Call Handling Rules. 
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You may double-click or select the edit icon to modify the rule. You may delete 

the rule by clicking the delete icon. 

Voicemail Notifications 

This area allows a user to create, modify, or delete their Voicemail Notification 

rules. 

 

• Create: 

• To create a new Voicemail Notification rule: 

 

Click the icon. 
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• Enter the rule name at the top of the screen. You must delete the existing 

text first. 

• Check the desired Notify me conditions that apply to the rule. 

As you enter information, the Rule Description area will update. 

Depending on the selection, additional information may need to be added 

in this area. Information will be highlighted in this area when input is 

required. 

• Check the desired Conditions for the rule. As you enter Conditions, the 

Rule Description area will update. Depending on the selection, additional 

information may need to be added in this area. Information will be 

highlighted in this area when input is required. 
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• Click Save 

The new rule will now appear in the list of Voicemail Notifications rules. 

 

 

You may double-click or select the edit icon to modify the rule. You may delete 

the rule by clicking the delete icon. 
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39. Return Customer Routing 

This feature provides two methods for callers who have previously called an ICC 

group to have special routing treatment applied upon a returning call. 

Last Agent Assigned 

This option will allow a caller reaching the ICC group to be routed to the last 

agent they spoke with. If caller with matching callerID/DID returns within the 

specified timeframe, MX will try to route the caller to the last assigned agent for 

that caller. 

Routing shortcuts 

The MX will analyze callerID information and apply a routing shortcut to a 

programmed destination if the caller has called back within the specified 

timeframe. This applies after the caller has initially reached the group and the 

MX has captured CallerID/DID information. Please note that this will allow a 

returning caller to bypass system routing via dial plan. Destinations can be AA 

scripts, call group extensions, extensions. Please note that this routing decision 

takes place prior to the dial plan processing of the incoming call. 

MX Administration 

MX Administrator\Configure\Operator and Call Groups\ICC type 

Select the Returning customers tab 
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• Enter the desired storage time for the MX to maintain callerID and DID 

numbers. Values are from 1 to 80. 

 

• Select if the MX is to maintain callerID and/or DID numbers 

 

• Select if the MX is to maintain the last agent assigned to the caller. 

 

• Enter any CAD values to be associated with the call. 

 

Conditions 

• If last agent is logged out, returning caller will be routed to the next 

available agent, their call has highest queue priority. 

 

• If last agent is busy, caller will wait for that agent for the length of the 

Drop Agent Assignment in the Member Settings tab. On expiration, caller 

is routed to next available agent and the call has the highest priority. 
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40. Unmanaged Device Password 

This feature provides a mechanism for the MX to generate SIP authentication 

passwords for unmanaged devices. This reduces vulnerability due to the usage 

of weak PINs that are utilized by many users. 

Note: Zultys strongly recommends the regeneration of unmanaged device 

passwords to provide unauthorized access due to weak passwords. 

 

MX Administration 

MX Administrator\Configure\Users 

Single User: 

Select the desired user from the user list. 

Click the Regenerate button for Unmanaged device password. 

 

Click Yes at the Warning dialog: 

 

Make note of the new password. 
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User Profile: 

Select the desired Profile from the user list. 

In the General tab, click the Regenerate Passwords button next to “Can register 

unmanaged devices”. 

 

 

Conditions 

 

• The MX will generate a Syslog event when an unmanaged device utilizing 

a weak password is registered. 

"Unmanaged device registered with weak password:", " DeviceID = 

%s, UserAgent = %s." 

• Examples of weak passwords: 

- using user name, extension or login name is reducing the 

password bit length. 

- Passwords with characters in sequence, 12345. 
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